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Read Me First 
~~ 

Read this page to get the  most out of QuickLink I1 Fax. Place a 
check in  each box as you complete the step. 

COM port selection 
Follow the installation instructions in  Chapter 1 carefully. In  
particular, be sure to  configure QuickLink I1 Fax for the  same 
COM port as your modem. For example, ifyour modem is using 
COM2, set up QuickLink I1 Fax to address COM2. If you will 
be using QuickLink I1 Fax with a standard COM port (COM1 
through COM4), which use interrupt request lines IRQ3 or 
IRQ4, we recommend you take advantage of QuickLink I1 Fax's 
auto-detection feature to  find the COM port automatically. 

Default settings 
QuickLink I1 Fax is designed to let you start sending and 
receiving fax and modem files as soon as it's installed. Before 
you begin, it is recommended tha t  you review the QuickLink I1 
Fax's default settings start ing on pages 6 and 12. QuickLink's 
default settings should be satisfactory for most users. However, 
you may want to customize certain settings for your particular 
requirements. A few seconds of your time will ensure that you 
get the most out of QuickLink I1 Fax. 

"To Mouse, or Not to Mouse" 
There is a copy of QuickLink I1 Fax tha t  is a DOS program on 
this disk, which means tha t  it is not a Windows program and 
will not automatically respond to  your mouse if i t  only works 
within Windows. This also means tha t  your mouse might not 
necessarily respond in QuickLink I1 Fax if you've only used 
your mouse in Windows up  until now. This program is fully 
compatible with your mouse when your DOS mouse drivers are  
loaded into memory. 

Secondly, unless you are  paying attention, your mouse and 
modem may conflict with each other when you plug both into 
your computer. I t  is possible that you may have them both 
using the same COM port or IRQ setting. Please be sure to refer 
to Chapter 1 if you are  unsure about how to configure your 
hardware or load your DOS mouse drivers. 

Thirdly, QuickLink I1 Fax for DOS is completely functional to 
those users who prefer not to  use a mouse or don't have one. If 
you will not be using the  mouse, please be sure to  look over 
Chapter 1 to review the DOS keyboard commands and shortcuts. 
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Introduction 

A modem or fadmodem connects your computer to the telephone 
line so that you can exchange information with a remote modem, 
fadmodem, or fax machine. QuickLink I1 Fax is a communications 
software package that controls the exchange ofinformation between 
your fadmodem and the remote modem, fadmodem, or facsimile 
machine at the other end of the communications line. QuickLink I1 
Fax represents the latest technology in faddata communications 
software design and fully conforms to the standard Windows user 
interface in both the Windows and DOS environments. 

We have developed the Win/DOS version QuickLink I1 Fax with 
the idea that Windows users do not operate in the Windows 
environment exclusively. Therefore we have given our Windows 
package the special capability of communicatingwith our QuickLink 
I1 Fax for DOS package. This enables you to share a variety of f a d  
data information between Windows and DOS, such as Phone Lists, 
Fax Logs, and Scheduled Faxes. No longer do you have to worry 
aboutreceivingafax thatmay come through ifthey have temporarily 
quit Windows to do some work in DOS. This feature also gives the 
user the ability to schedule faxes with the DOS product and have 
them detected and transmitted by the Windows product. Refer to 
Chapter 1 for more information. 

QuickLink I1 Fax allows you to utilize all of the features of your 
modem or fadmodem. QuickLink I1 Fax will operate with all AT 
command set (Hayes) compatible modems as well as most other 
modems that are not compatible with the AT command set. The fax 
mode of QuickLink I1 Fax is designed to be used with either EIA 
Class 1 or 2 compatible send-receive fadmodems. 

Unpacking your components 

QuickLink I1 Fax for Win/DOS comes on either a high density 3%- 
inch diskette (1.44m) or  on a high density %&inch diskette (1.2m). 
If any diskettes are missing or damaged, please contact your place 
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Introduction 

of purchase immediately. If the wrong disk size is provided, contact 
your modem manufacturer or fill out and return the Replacement 
Disk Form in the back of this book t o  Smith Micro Software, Inc. 

~~~ 

Features 

This section briefly describes the myriad of general, fax, and 
telecommunications features that QuickLink I1 Fax provides. 

General features 
A few of the general features that QuickLink I1 Fax provides are: 

Complete Windows and DOS fax system. QuickLink I1 Fax 
sends and receives faxes both within the DOS and Windows 
operating systems and applications, sharing data, logs, and phone 
lists. 

Complete Windows user interface. QuickLink I1 Fax uses 
standard Pull-down menus, dialog boxes and mouse control, so all 
features are only a familiar click away. 

Button Bar. Many of QuickLink I1 Fax’s most used features are 
accessible through a button bar, so these commands are only a 
mouse click away. 

Context sensitive help. You can never get lost when using 
QuickLink I1 Fax. Context-sensitive help is always available within 
the dialog boxes. The term context sensitive means that the help 
topics change for each dialog box. There is also a Help command on 
the main menu, in case you need assistance at any time. With so 
much assistance a t  your fingertips, you’ll be using QuickLink I1 
Fax’s many features in no time! 

Support for COMl through COM4. For even greater flexibility, 
QuickLink I1 Fax supports IRQ2 through IRQ7 (as set in the 
Windows Control Panel for Windows) to ensure that there is no 
conflict with any of the serial devices o r  interface cards installed in 
your PC. If you prefer, you can take advantage of QuickLink I1 
Fax’s automatic COMport detection and selection and let QuickLink 
I1 Fax automatically ascertain the COM port being used. 
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Fax features 
The following section describes some of the fax features that 
QuickLink I1 Fax provides. 

Foreground and background fax capability. In  the foreground, 
you can manually send and receive faxes. Background operation 
lets you send and receive faxes while you use your PC for other 
applications. 

Sending faxes. You can send faxes out of most applications that 
have printing capabilities, which means that faxes can be sent that 
were previously typed in with almost any word processor, database 
manager, spreadsheet, or planner program. Faxes can be sent 
immediately or at scheduled times, when telephone-line charges 
are a t  their lowest or when you are certain that the remote facsimile 
machine or fadmodem will be turned on. You can even broadcast 
your faxes to multiple recipients, when you need to  make sure that 
multiple recipients receive identical faxes. 

WYSIWYG faxing. Faxes sent out use the same fonts, layout and 
graphics as  the original document, creating faxes of true laser- 
quality. As a result, you can create faxes that consist ofhigh-quality 
fonts and graphics, t o  be assured that  the received document will 
appear just  like the original. 

Cover page. QuickLink I1 Fax lets you include a cover page with 
your faxes. Your cover page can include a high-quality graphic that 
have been scanned into your PC or created in your favorite drawing 
and paint programs. 

Printing received faxes. If you prefer a hard copy, QuickLink I1 
Fax can be instructed to send all received faxes to your printer. Any 
Windows supported printer, be it a dot-matrix, HP  LaserJet 
compatible, or PostScript (Windows only) printer can print faxes 
(in the background upon reception within Windows). 

Fax phone list. Aseparate fax phone list is maintained for sending 
faxes to frequently dialed telephone numbers. Numbers can be 
assigned t o  Groups, so that  a fax can be easily sent to  any number 
of fax machines with just a few keystrokes. 

Export fax capabilities. QuickLink I1 Fax lets you export faxes 
into PCX, DCXand TIFFgraphic fileformats, allowingfor importing 
faxes into Paint, Drawing, o r  OCR programs. 
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Telecommunication features 
The following section describes some of the telecommunication 
features that QuickLink I1 Fax provides. 

Background file transfers. Uploads and downloads can take 
place while using other programs within Windows. A large file 
transfer need never keep you from working! 

Transfer protocols. For your convenience, QuickLink I1 Fax 
provides 8 transfer protocols: ASCII, Kermit, Super Kermit, 
Xmodem, Xmodem CRC, Xmodem lK, Ymodem, and Ymodem G. 

Terminal emulators. Five terminal emulators are provided: 
ANSI, TTY, VT52. VT100, and VT102. 

Complete scripting language. This feature lets you write 
miniature programs so that logging onto Host computers can be 
done automatically, with little, if any, keyboard input. 

Easy access to popular online services. QuickLink I1 Fax 
automates the logon sequence for popular services such as 
CompuServe, Dow Jones, and Genie. 

16~550 UART support. With all it’s modem features, QuickLink 
I1 Fax won’t slow you down. To guarantee the fastest throughput 
possible, QuickLink I1 Fax supports the 1 6 ~ 5 5 0  UART, which is 
found on some high speed PC serial cards. If you have a high speed 
modem that operates at 9600 baud or faster and a PC equipped with 
a 1 6 ~ 5 5 0  UART and the Windows 3.1 COMM driver, QuickLink I1 
Fax ensures that you will get the maximum data throughput from 
your high-speed data communication system! 
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Chapter 1 
Installing QuickLink ll Fax 

Chapter 1 describes the requirements needed to  install QuickLink 
I1 Fax, provides step-by-step instructions for installation, and  
walks through running the program for the first time. I t  does so in  
the following order: 

1. 

2. 

3. 

4. 

Installation of the Windows and/or DOS versions of QuickLink 
I1 Fax from within Windows (pg 1). 

Running QuickLink I1 Fax for Windows for the first time (pg 4). 

Running the  DOS version of QuickLink I1 Fax for the first time 
(pg 7). 

Installing QuickLink I1 Fax from DOS (pg 12). 

Minimum Windows system requirements 

To use QuickLink I1 Fax for Windows on your computer, make sure 
you have the following minimum system requirements: 

Microsoft Windows 3.0 or  greater 
IBM-PC AT, PS/2 or  compatible computer (286 or higher) 
1 Megabyte of RAM memory 
a hard  disk with 2 MB free disk space 
MS-DOS or PC-DOS operating system 3.3 or greater 
CGA, EGA, VGA, 8514/A, or Hercules graphics adapter and  
monitor 
EIA Class 1 or 2 standard fadmodem 

Windows installation instructions 

For your convenience, QuickLink I1 Fax comes on either a 3%-inch 
or a 5%-inch diskette; replacement disks or alternative sizes can be 
ordered with the Replacement Disk Form at the end of this book 
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Installing OuickLink II Fax 

(some versions may arrive to  you on 2 disks). All the files on the  
QuickLink I1 Fax Install disk are compressed and  cannot be used 
until  the  Install program has been run. The Install program can be 
run from either the  DOS prompt or with the Windows Run 
command. The following steps will walk you through the Installation 
process. 

1. Turn on your computer. If your computer boots into Windows 
automatically, jump ahead to step 3. If your computer launches 
a menu program or shell, quit  out of it and go to the DOS 
prompt. 

2. Place the QuickLink 11 Fax diskette into the  appropriate drive. 
If you are  installing from the  A drive, type AINSTALL and 
press the Enter key. If you are  installing from the  B: drive, type 
B:INSTALL and press the Enter  key. The Install program will 
ask you what versions of QuickLink you want to install, then 
launch Windows in Standard Mode. Jump ahead to  step 4. 
Alternatively, simply start Windows and go to 3. 

3. To runthe  Install program from the Windows Program Manager, 
pull down the File menu and choose Run. At the Command 
Line field, type in &INSTALL if the QuickLink I1 Fax Install 
disk is in drive A; type BSNSTALL if it is  in the B drive. Press 
the Enter key or click OK. 

4. Since you received the Win/DOS software combination, a dialog 
box will appear promptingyou with which products you wish to 
install. Select the product combination you wish to  install and 
continue. 

5. The main installation dialog box appears on screen with the 
default directory C\QUFAXW as the install directory for 
QuickLink I1 Fax's main program files. The Inbox and  Outbox 
are sub-directories ofthe install directory. To accept the defaults, 
simply press the Enter key OT click the  Install button. 
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Enter the paths for the Home. lnbor and Outbox 
directories. 
We suggest that you stick with the dclaull values 
given below unless you have a specific reason not 
to. 

m{Create Program Manager Group Box and lconsj 

Home diredory for executabler: 

C$OLZFAXw 

Outbox diredory for scheduled faxes: 

CaOLZFA)(W\OUTBOX 

lnbox diredory for received faxes: 

CaOLZFNWUNBOX 1 

I 

6. 

7. 

8. 

9. 

Insert  the QuickLink I1 Fax Install disk #2 when prompted, if 
necessary. 

The Default Printer dialog box appears, asking if you want  
the QuickLink I1 Fax Driver to be your Windows default 
printer driver. Click No if you want to keep your regular 
printer driver as the default. Click Yes or press the ENTER key 
if you want the Fax driver to be the default Windows printer. 
This setting can be changed at any time with the Windows 
Control Panel. 

When the  installation is complete, a QuickLink I1 Fax Program 
Group is created in the Program Manager with the QuickLink 
I1 Fax program icons inside. There is also a n  icon labeled Read 
Me!, which contains important information and any changes 
tha t  have occurred to the  software since this manual was 
printed. We recommend that you read it by double-clicking the 
Read Me! icon. It can be printed from Notepad or Write for 
future reference. Note tha t  no icons a re  created for the DOS 

Remove the QuickLink I1 Fax disk from the floppy drive and 
put  them in a safe place away from heat, dust, and magnetic 
fields. This is also a good time to fill out the registration card 
and mail it in. 
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Starting QuickLink I I  Fax for Windows for the first time 

There are  several ways to  run the QuickLink IIFax main application. 
When in Windows, the most straightforward way is  to  open the 
QuickLink I1 Fax Program Group by double-clickingon it,  and then 
double-clicking on the QuickLink 11 Fax program icon to launch the 
application. I t  can also be launched by pulling down the File menu, 
choos ing  Run, a n d  r u n n i n g  t h e  f i le  
C:\ QL2FAXW\ QL2FAXW.EXE. 

The first time QuickLink I1 Fax is run, the program will ask which 
COM port your modem is connected to in the Modem Setup dialog 
box. You are  given the option to either directly select the appropriate 
COM port (COMI through COM4) or use the Auto Detect feature, 
which is the default. This default choice allows QuickLink 11 Fax to  
test the COM ports on your PC and automatically determine which 
COM port is being used. Since most communications problems 
involve incorrect COM port selections, it is recommended that you 
accept the default selection ofAuto Detect. IfQuickLink I1 Fax does 
not find a COM port, i t  asks you to select a default COM port. 

If your computer has  another serial device, such as a serial mouse 
or a scanner, be sure each serial device has  a different COM port 
and IRQ setting than the fadmodem QuickLink I1 Fax is using. 
Otherwise, the serial devices and QuickLink I1 Fax will not operate 
properly. For more information on COM ports and IRQ settings, 
refer t o  Appendix C. 

Elements of the main screen 

When you s ta r t  QuickLink I1 Fax, the main screen appears. The 
main screen consists of the following elements: 

4 QuickLink II Fax User’s Guide 



Installing OuickLink II Fax 

The Title Bar is the top of the QuickLink I1 Fax window, and 
responds to being dragged and clicked on like other Windows 
programs. The Menu Bar consists of the pull down menus which 
contain all of QuickLink I1 Fax’s commands; they can be accessed 
with the mouse or through Alt-Key combinations. Beneath the 
Menu Bar is the Button Bar, which provides quick access to 
QuickLink I1 Fax’s most frequently used commands. The Terminal 
Window appears below the button bar. When you perform data 
activities, the data will scroll across the terminal window as it is 
sent to or received from the remote modem. Direct communication 
with your fadmodem also takes place within the terminal window 
-AT commands can be typed in directly and the modem responses 
can be read. The Initialization string is just such an AT command 
and the OK beneath it is a modem response. 

The Terminal Status Bar runs along the bottom of the QuickLink 
I1 Fax window and provides you with a display of important 
communications settings and messages about current activities. 
For example, if you hang up following a modem call, the Message 
Disconnecting ... appears. Selecting a menu option makes a brief 
explanation appear here too. Information to the right of this 
message area displays: 

The current terminal emulation (the default is TTY) 
The current line settings (baud rate, data bits, parity bit, stop 
bits) 
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The flow control being used, if any. 
The serial port QuickLink I1 Fax is addressing (This is the COM 
port setting). 
The duration of your data call (the timer is also controlled using 
the Start Timer, Stop Timer, and Reset Timer commands 
in the Edit menu). 

You can also click on the current terminal emulation, line settings, 
flow control, and/or COM port information in the terminal status 
bar to change these parameters. If you desire, you can turn off the 
terminal status bar with the Terminal Options dialog box from 
the Setup menu. 

Using the default configuration 

When QuickLink I1 Fax is started for the first time, certain default 
settings go into effect. These settings allow the majority of users to 
begin fax and data transmissions immediately. The first table 
shows the default settings for fax communications, and the second 
shows the default settings for data communications. If you need to  
change settings, or want to find more information about them, refer 
to the appropriate page numbers. 

Default fax settings 
Parameter 
Maximum transmit baud rate 
Number of redialing attempts 
Seconds between redialing attempts 
Cover page sent with faxes 
Default cover page information 
Default cover page graphic 
High resolution faxes sent 
Paper size of sent faxes 
Print Received faxes on receive 
Fax receiving a t  Windows startup 

Setting 
9600 
3 
30 
Enabled 
Blank 
None 
Disabled 
Letter 
Disabled 
Disabled 

See Page: 
w-35 
w-37 
w-37 
W-36 
w-39 
w-39 
W-36 
W-36 
w-39 
w-39 
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Default data settings 
Parameter 
Baud rate 
Data, panty, stop bits 
Flow control 
Terminal emulation 
Autobaud 
Redial busy data number 
Auto-answer a call 
Answer mode 

Setting 
2400 
8, None, 1 
None 
'M"y 
Enabled 
Enabled 
At first ring 
Auto Detect 

See Page: 
w-57 
w-57 
w-57 
W-61 
W-60 
W-60 
w-59 
w-59 

Where to proceed 

QuickLink I1 Fax for Windows is now successfully installed and 
ready forfaxingdocuments out ofany Windows application, sending 
faxes from within QuickLink I1 Fax itself, and can be set for 
receiving faxes. The next sction gets you started faxing with the 
DOS version of QuickLink I1 Fax. 

Starting QuickLink II Fax for DOS for the first time 

From the DOS prompt (in other words, when not runningwindows), 
QuickLink I1 Fax for DOS can be started by simply typing: -= 
when in the QL2FAXW directory. Since this is the first time 
QuickLink I1 Fax is being run, the program asks you for some 
initial setup information. 

First, QuickLink I1 Fax asks you what type of monitor you are 
using: color, monochrome, or LCD ("Liquid Crystal Display", found 
on most laptops). Enter the type of monitor you have to continue. 

Next, QuickLink I1 Fax asks you what COM port your fadmodem 
is connected to, and volunteers to search your system for it with the 
Auto Detect setting selected by default. Ifyou already know where 
your fadmodem is connected or Auto Detect is unable to  find your 
fax modem, manually select a COM port by moving the dot to the 
correct COM port with the arrow buttons on your keyboard and 
pressing the ENTER key. These settings can be changed later 
within QuickLink I1 Fax if your system configuration changes. If 
you have an external fawlmodem, be sure to have it connected to 
your computer and turned on at this time. 
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Once QuickLink I1 Fax knows your initial settings, it starts as it 
normally will, starting up with the Start-up Screen - displaying 
the version number of the program and the Quick Help display. 
Take note of both and either click OK with your mouse or press the 
ENTERkey to continue. Finally, the QuickLink I1 Fax main screen 
appears. 

Special mouse and modem considerations 
Your modem connects to your computer via a COM port (COM1 
through COM4; your serial ports) -so does your mouse ifyou have 
what is called a “serial mouse”. Your modem and mouse cannot use 
the same COM port. Also, if your faxlmodem is  on COMl or  
COM3, the mouse can only use COMZ or COM4. I f  the fQxl 
modem is on COM2 or COM4, then the mouse can only use 
COMl or COM3. Ifyou do not follow this very important rule, your 
mouse or modem will not work. 

Additionally, in order for your mouse to function in the DOS 
environment, you must have the mouse’s DOS driver installed in 
either your CONFIG.SYS or AUTOEXEC.BAT file, depending on 
the brand of mouse you have. These drivers should have been 
included with your mouse and might have been already installed by 
your dealer. If your mouse works in Windows, but not in DOS or 
QuickLink I1 Fax, consult the documentation that came with your 
mouse or contact your dealer. 

Elements of the main screen 

When you start QuickLink I1 Fax, the main screen appears. The 
main screen consists of the following elements: 

The MenuBarruns  along the top edge ofthe screen, and it consists 
of the pull-down menus which contain all of QuickLink I1 Fax’s 
commands; they can be accessed with the mouse or through Alt- 
Key commands (more on this next section). The right edge of the 
Menu Bar displays the current datacom settings of the fadmodem 
and messages about current activities. Beneath the Menu Bar is 
the Terminal Window. When you perform datacom activities, the 
data will scroll up the Terminal Window as it is sent to or received 
from the remote modem. Direct communication with your fax/ 
modem also takes place within the Terminal Window - AT 
commands can be typed in directly and the modem responses can 
be read. The Initialization String is just such a n  AT command 
and the OK beneath it is a modem response. 
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Getting around within QuickLink II Fax 

QuickLink I1 Fax provides a state of the art"pul1-down menun user 
interface, so users familiar with Windows or a Macintosh will feel 
right at home. If you have never used your mouse much, or don't 
even have one and plan to use the keyboard, then this section is for 
you. 

Needless to say, the program can be operated directly from the 
keyboard or with the use ofa Microsoft or Mouse Systems compatible 
mouse. At the top of the screen is the QuickLink I1 Fax Menu Bar. 
The area below the Menu Bar is the terminal window. The terminal 
window will be used to display all textual information coming from 
the modem as well as displaying all information you send to your 
modem via the keyboard. Different functions, such as accessing the 
help window, will generate dialog boxes that allow you to perform 
specific operations or provide you with special information. These 
dialog boxes temporarily cover portions of the terminal window, 
but the full screen with information intact is displayed when the 
dialog boxes are removed. 

The Menu Bar allows you to easily access the many functions 
provided with QuickLink I1 Fax as well as providing you with the 
current QuickLink I1 Fax program settings. At the right side of the 
Menu Bar you will find the current baud rate, data bit, stop bit and 
parity settings (Refer to Chapter 5 for more information). You will 
also find displayed the current terminal emulation mode. At 
different points in the use of QuickLink I1 Fax you will find 
additional status information displayed in the Menu Bar. 

Accessing the Menu Bar 
From Keyboard You can access the Menu Bar by simply pressing 
and holding down the ALT key and then selecting the key that 
matches the first letter in the menu item, such as "C" for the 
Connect Menu. The only exception to this rule is the Fax Menu 
that use the "x" key since the "E" key is already used for the File 
Menu (These letters are highlighted when the Alt key is pressed). 
When operating from the keyboard, you could also use the left and 
right arrow keys to select the menu item. First depress the ALT key 
to activate the Menu Bar and press the desired arrow key to select 
the menu item. Press either the ENTER key or the down arrow to 
open the selected menu. 
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With Mouse: If you are using a mouse, simply place the mouse 
pointer on the desired menu item and click the left mouse button. 
This action will cause the desired menu to drop into view. 

Selecting menu functions 
After selecting the desired menu item from the Menu Bar, the full 
menu for that  item will drop into view and appear as is shown in the 
example below. 

From Keyboard To select a function on the displayed menu, 
simply press the up or down arrow key to  highlight the desired 
function, and press the ENTER key to select that  function. Note 
also that the a letter of each menu function is highlighted or in the 
case of monochrome screens, underlined. You can select a menu 
function directly by pressing the key that corresponds to the 
highlighted letter. Some menu functions also have ALT key 
equivalents which are displayed to the right of the menu function. 
Pressing the ALT key equivalents have the same effect as selecting 
the menu item from the menu bar and then selecting the desired 
menu function. 

With Mouse: If you have a mouse simply depress the left mouse 
button and drag (click and hold) the mouse pointer up o r  down the 
menu to highlight the desired function - release the mouse button 
when the desired function is highlighted. You may also point the 
mouse cursor directly at the desired function and click the left 
mouse button to select. 

Dialog boxes 

Many menu selections will cause a Dialog Box t o  be displayed. A 
dialogbox is simply an area in the program where QuickLink I1 Fax 
asks you for some information or wants to tell you something. 
Dialog boxes can contain a number of entry fields of a variety of 
types. The example below is of the Terminal Setup Dialog box that 
contains a variety of these entry fields. 

Textual information is entered by using a Text Box. Simple odoff  
selections use check boxes. Option Lists with a limited number of 
possible responses use option pointers (also called “Radio Buttons”) 
for selection. Another method of selecting from a list of possible 
responses is through the use of the scroll box. Lastly, a dialog box 
will also contain selection buttons. A button with a double border 
is a default button which can be selected at any time, with the 
exception of when a scroll box is active, by simply pressing the 
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ENTER key. Pressing the Escape key at any time will cause a 
dialogbox to disappear and has the same effect as selecting a Cancel 
Button. 

To move from area to area within a dialog box, simply press the TAB 
key. To reverse the order of movement between entry fields, press 
Shift-TAB. If you have a mouse, simply point the mouse cursor at 
the desired entry and click the left mouse button to select an entry 
item. 

Text Boxes 
AText Box is used to enter textual information such as the modem 
initialization string on the Modem Setup Dialog Box. When the 
current value contained in a Text Box is highlighted, pressing the 
Backspace key will delete the contents. 

Check Boxes 
Check boxes either turn a n  option on or  off by placing a n  “X” in the 
box. ACheck Box will toggle between on or off by pressing the Space 
Bar when a Check Box field is activehighlighted. When using a 
mouse, simply place the mouse cursor on the Check Box and click 
the left mouse button to toggle the Check Box. 

Option Lists 
Option Lists allow you to choose an item in a list by simply moving 
the Option Pointer to the desired option, such a s  when selecting the 
baud rate in the Line Settings dialog box. Use the up, down, left or 
right arrow, o r  the mouse cursor to move the selection bullet. 

Scroll Boxes 
Scroll Boxes allow you to  select from a large number of possible 
options, such a s  when selecting the Help Screen topic. Pressing the 
up or down arrows or clicking the mouse cursor on an arrow will 
cause the various options in the scroll box to  be highlighted. 
Pressing the ENTER key or clicking the left mouse button will 
select the highlighted item. 

Buttons 
Buttons perform specific tasks. The OK button accepts all dialog 
entries a s  displayed and removes the dialog box. The SAVE button 
permanently saves the current status of the dialog entries, writing 
the information to disk. The CANCEL button removes the dialog 
box and does not use any changes made in the dialog entries. The 
HELP button causes the Help Screen Scroll Box to be displayed 
with the topic highlighted that corresponds to the dialog box for 
which help has been requested. 
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To select a button, press the ENTER key when the button is 
highlighted or place the mouse cursor on the button and click the 
left mouse button. You can also depress the ALT key and press the 
key that corresponds to  the first letter in the button title. 

Help 
Remember, if you need help while using QuickLink I1 Fax, all Help 
Screens are directly available by depressing the ALT and "H" keys 
simultaneously or selecting HELP from the Diamond Menu. 

Using the default configuration 

When QuickLink I1 Fax is started for the first time, certain default 
settings go into effect. These settings allow the majority of users to  
begin fax and data transmissions immediately. The first table 
shows the default settings for fax communications, and the second 
shows the default settings for data communications. Ifyou need to 
change settings, or want to findmore information about them,refer 
to the appropriate page numbers. 

Default fax settings 
Parameter 
Number of redialing attempts 
Seconds between redialing attempts 
Cover page sent with faxes 
Default cover page information 
Default cover page graphic 
High resolution faxes sent 
Paper size of sent faxes 
Fax receiving at Computer startup 

Setting 
3 
30 
Enabled 
Blank 
None 
Disabled 
Letter 
Set by User 

See Page: 
D-95 
D-95 
D-95 
D-98 
D-98 
D-94 
D-95 
13 

Default data settings 
Parameter 
Baud rate 
Data, panty, stop bits 
Flow control 
Terminal emulation 
Autobaud 

Setting See Page: 
2400 (variable) D- 114 
8, None, 1 D-114 
None D-118 
rn D-117 
Enabled D-117 
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Redial busy data number Enabled D-118 
Auto-answer a call At first ring D-116 
Answer mode Auto Detect D-116 

DOS Installation instructions 

If you don’t have Windows or don’t care to use it, you can install the 
DOS version of QuickLink I1 Fax from DOS directly off the 
QuickLink I1 Fax Install disk. All the files on the QuickLink I1 Fax 
Install disks are compressed and cannot be used until the Install 
program has been run. The following steps will walk you through 
the installation process. 

1. 

2. 

3. 

4. 

5. 

Turn on your computer. If your computer boots into Windows 
automatically, pull down the File menu in the Windows 
Program Manager and choose Exit, which exits out ofwindows 
to the DOS prompt. Ifyour computer launches a menu program, 
quit out of it to the DOS prompt. Otherwise, your computer 
should have the C:\> prompt showing. 

Insert the QuickLink I1 Fax Install disk into your floppy drive. 
If you put the disk into the A: drive, type &\DOSINST; if you 
put it into the B: drive, type B:\DOSINST and press the 
ENTER key. 

Answer the Color question about your monitor with either a Y 
or N. Press any key to go past the System Requirements screen. 

The Target Drive screen asks you which hard drive you want 
QuickLink I1 Fax to install on - the default is C. To accept this 
drive, press the ENTER key. 

The follow-up question asks you which directory on your hard 
drive you want QuickLink I1 Fax installed on -the default is 
\QLZFAX. If you want QuickLink I1 Fax to install in another 
directory of your choosing, type in the new directory name and 
press ENTER; otherwise, simply press the ENTER key to 
accept the default directory. Z f  you do not accept the default 
directory or enter a different directory, QuickLink ZZ Far will 
install on the root directory of your hard drive, generally 
regarded as a bad thing to do. Zfyou do not care to think about 
directories or are unclear on the concept, simply accept the 
default setting and just press ENTER. 
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6. 

7. 

8. 

9. 

QuickLink I1 Fax asks for confirmation of your settings. Press 
the ENTER key to  accept. Accepting begins the unpacking of 
the QuickLink I1 Fax files. 

Exchange Install Disks when prompted, if necessary. 

The Installer will suggest that you print the README file a t  
this time. The README file contains updates to the manual 
since the time of printing. This file can be viewed and printed 
at any time. To print it now, press Y, otherwise, press N. 

The Receive Fax Load Option dialog box appears next, 
asking you if you want the module that actually receives faxes 
to  be loaded into memory every time you start your computer. 
Answering Y enables your computer t o  receive faxes 
automatically without you having to actually turn fax receiving 
"on". Answering N means that you must manually load the 
module that receives faxes whenever you turn your computer 
on and/or wish to receive faxes. The trade-off of having the 
module load automatically at boot up is that some conventional 
memory is subsequently occupied at all times, and you may be 
surprised when an  unexpected call comes in and your computer 
automatically answers it. This option can be manually changed 
at any time. Press Y or N to continue. 

10. The FastF'axIVLoad Option dialog box appears next, asking 
you if you want the module that allows you to send a fax out 
from most printing DOS applications to be loaded whenever 
you start your computer. Answering Y enables you to fax out of 
applications directly without having to manually load the 
module. Answering N means that you must manually load this 
feature when you wish to fax out of applications directly. 
FastFax takes a n  additional amount of conventional memory 
above and beyond the Receive Fax module when loaded, so you 
may only want to load FastFax in memory as you use it. b s s  
Y or N to continue. 

11. A Confirmation dialog box double-checks your options. Press Y 
or N to continue. 

12. To work properly and install any additionally selected load 
options,  QuickLink I1 Fax needs to modify your  
AUTOEXEC.BAT file. Unless you have a specific reason to do 
otherwise, press M t o  select the first option. QuickLink I1 Fax 
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then completes the installation, prompts you while quitting the 
installer, and leaves you with the DOS prompt in the QuickLink 
I1 Fax install directory. 

13. Remove the QuickLink I1 Fax disks from the floppy drive and 
put them in a safe place away from heat, dust, and magnetic 
fields. This is a good time to fill out the registration card a t  the 
end of this manual and mail it in. 

Where to proceed 

QuickLink I1 Fax is now successfully installed and ready for faxing 
documents from any Windows application that can print to  a 
LaserJet Series 11, sending faxes from within QuickLink I1 Fax 
itself, and can be set for receiving faxes. The second half of the 
User's Guide gets you started faxing out of the DOS environment. 

Additional WinlDOS Considerations 

This section outlines the special features of QuickLink I1 Fax for 
Windows when i t  is used in conjunction with QuickLink I1 Fax for 
DOS. 

We have developed the QuickLink I1 Fax for Windows package 
with the idea that Windows users do not operate in the Windows 
environment exclusively. Therefore we have given our Windows 
package the special capability ofcommunicatingwith our QuickLink 
I1 Fax for DOS package. This enables a user to share a variety of 
faddata information between Windows and DOS, such as Phone 
Lists, Fax Logs, and Scheduled Faxes. No longer does a user have 
to worry about receiving a fax that may come through if they have 
temporarily quit Windows to do some work in DOS. This feature 
also gives the user the ability to schedule faxes with the DOS 
product and have them detected and transmitted by the Windows 
product. However, in order for this unique feature to  operate 
properly, there are some requirements that must be strictly followed. 
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Software Setup Requirements: 
1. Both of these products must be installed to the same directory 

on your hard drive. The Installer included with the WidDOS 
single disk package will default to installing both products to 
C: \QL2FAXW. 

2. The DOS Send/Receive Fax TSR (RECFAXBAT) must be 
loaded into memory prior to running Windows. 

Files that the Win/DOS Combination can share: 
1. The Send Fax Log (FAXSEND.LOG) 
2. The Receive Fax Log (FAXREC.LOG) 
3. The Data Phone List (PHONE.LST) 
4. The Fax Phone List (FAXPHONE.LST) 
5. The Send Fax Scheduler (SCHEDULE.QL2) 
6. Setup File Information (SMSSETUP.DAT) 

16 QulckLink II Fax User’s Guide 



Chapter 2 
Getting Started -Windows 

Chapter 2 describes how to  begin using QuickLink I1 Fax. I t  
describes how to send a fax from a Windows application, from 
within the QuickLink I1 Fax application, and how to prepare to 
receive a fax. It also describes how QuickLink I1 Fax receives d a w  
modem calls, and the online help facilities a s  well. 

Faxing out from a Windows application 

The most convenient way to send out a fax is to do it directly from 
your Windows programs. The benefits of sending out faxes in this 
manner are that there is no need to interrupt your work to fax out, 
and that all ofyour fonts, graphics, andformattingare incorporated; 
true WYSIWYG faxing! 

The process is simple. When QuickLink I1 Fax is installed, it 
installs a print driver called QuickLink I1 Fax on FAX/MODEM. 
When you print to this print driver, your document is converted 
into a faxable format, the Fax Manager activates, and the fax/ 
modem picks up the phone line, dials, and sends out the fax. 

As an example, minimize any program you are in and double-click 
on the Read Me! icon in  the QuickLink I1 Fax Program Group, 
which will run the Windows Notepad program and load the Read 
Me! file. Alternatively, you could double-click on the Windows 
Notepad icon, located in the Accessories group of the Program 
Manager, and open the file R.EADME.IXT in the QuickLink I1 Fax 
directory. 

To fax this document, simply pull down the File menu and choose 
Print Setup. Click on Specific Printer and choose QuickLink 
I1 Fax. Clicking on the Options button at this point will call the 
Fax Driver Setup dialog box, which sets the fax’s Resolution 
and paper size -click OK to set. Next, pull down the File menu 
and choose Print. 
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After a pause for "printing", the Send Fax Information dialog box 
appears, which is where the telephone number is input and the 
Cover Page set. The left portion of the dialog box allows you to 
input the name and phone number ofthe fax recipient. Click on the 
Phone List button if you want to choose a number from the Fax 
Phone List, or click on Add if you wish to add the current name 
and number to the Fax Phone List. The Manual Send checkbox 
allows for sending a fax to a fax machine which is already on the 
telephone line, such as when an operator must make a connection 
for you. When checked, clicking the Send Fax button will prompt 
you to pick up the phone and dial manually, allowing you to send 
the fax when the line is already off-hook. 

The right side of the dialog box allows you to Schedule the time of 
transmission of the fax; just key in the date and time you want the 
fax sent to send it later - leave it alone if you want to send the fax 
now. Ifyou wish to send a Cover Page, check the Send Cover Page 
check box. This Cover Page will contain the information defined in 
Cover Page Setup dialog box in the QuickLink I1 Fax main 
application. The Cover Page for this fax can be changed or a note 
added to it by clicking on the Modify Cover Page button. Fill out 
this dialog box with the information needed to send out a test fax, 
and click on the Send Fax button when the information is correct. 

When Send Fax is clicked, the document will print to the f a d  
modem, calling up the Fax Manager. The Fax Manager, in turn, 
dials the telephone number, displays the status of the fax, and 
alerts you when the fax is finished. Ifthe FaxManager appears only 
as an  icon at the bottom of the screen, double-click it to maximize 
the Fax Manager dialog box. After it sends, you can close or 
minimize the Fax Manager and continue to work as though you had 
simply printed to your normal printer. 
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Faxing out from QuickLink II Fax 

While faxing directly out of your application is probably the most 
convenient way to fax a document, there are instances when faxing 
out from the QuickLink I1 Fax main application makes sense, such 
as when you want to quickly fax out an  unformatted TEXT file 
(such as yourAUTOEXEC.BATfile to a technician), or pre-converted 
fax files, or previously received faxes. 

For  this example,  start t h e  
QuickLink I1 Fax program - after 
it loads pull down the Fax menu 
and choose Send Fax, or if you 
like, click on the Send Fax button 
on the button bar. This calls up the 
Select Files dialog box, which is 
where files to fax out are selected 
and converted. There are three main 
sections to this dialog box: the 
Director ies  list box in the center, 
the Files Available list box to the 
left. and the Files Selected list 

Fax Receiving 
Manual Fax Receive CtrltM 

r n v & t  Documents :I 
y e w  Fax Documen t... 
Viqy Fax Log 
Vim Fax Saedule ... 

box'to the right. Your goal is to select the directory of the file you 
want to  fax with the Director ies  list box, highlight the file in the 
Fi les  Available list box, click the Add button to bring the file over 
to the Files Selected list box, and click OK when finished. 

- 

There is already a text file called README.TXT in the QuickLink 
I1 Fax directory to illustrate faxing out this way, so select the 
QL2FAXW directory in the Directories list box. The Files Available 
list box will display all the files in this directory; use the scroll bar 
to scroll down until README.'IXT is visible and click on it once to 
select it. When highlighted, click the Add button. The Document  
Type Selection dialog box appears in order to confirm the type of 
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file selected; the README.TXT file is a text file, so ensure that 
Text is chosen and click OK. This finally brings the file to the Files 
Selected list box. You could add up to 255 files to the Files Selected 
list box to fax out in this manner, but for now, just click OK to fax 
this one file. 

The Send F a x  Information dialog box results, and it is virtually 
identical to the Send Fax Information dialog box you used when 
faxing out of Notepad. Fill out the information requested and click 
Send Fax when finished. As before, the file will convert to a faxable 
format, start up the Fax Manager, dial, and send. 

Receiving a fax 

Receiving a fax is an almost totally automatic procedure. To receive 
a fax, simply have the Fax Manager loaded into memory and F a x  
Receivingenabled(thisis the default setting). It can be minimized 
a t  the bottom of the screen, open and maximized, or open behind 
other windows; it merely needs to be available in memory. This can 
be done by simply double-clicking the Fax Manager icon from the 
QuickLink I1 Fax group in the Program Manager, or by choosing 
Load Fax Manager  from the F a x  menu within QuickLink I1 Fax. 
Since it’s default setting enables it t o  receive faxes, it is set up and 
ready to  receive immediately. The Fax Manager can be launched 
automatically when Windows starts up by configuring it to do so in 
the Receive Fax Setup dialog box under the Setup Menu (see 
Chapter 4). 

The Fax Manager normally stays in an Idle state 
while awaiting a call; it  switches over to active while 
actually answering. When a fax gets received, the 
call is automatically logged in the Receive F a x  Log 
and the fax gets saved on the hard disk in the Inbox 
directory in the QuickLink I1 Fax directory. The first 
file gets named FAXO001.REC - the 4 digit number 
increases with each received fax. The received fax 
file can be viewed, printed, and re-sent a t  any time once saved on 
disk; QuickLink I1 Fax can be configured to automatically alert you 
and print the fax as soon as  it arrives and do it all in the background 
as well (See Chapter 4). 

The Fax Manager’s default settings will let answer the incoming 
call to  determine what it is: either fax, data, or voice. If the call is 
a fax, it will be received in the manner just described. If it is a 
modenddata call, the Fax Manager will seamlessly pass the call 

FaxManage, -- Idle 
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into the QuickLink I1 Fax telecommunications mode, even 
automatically launching the QuickLink I1 Fax main application if 
it already isn’t running. If the incoming call isn’t a fax or a modem, 
QuickLink I1 Fax will display a message on screen to inform you a 
voice call has  come through: Pick up the Phone. In short, the Fax 
Manager will always answer the incoming telephone call and 
determine its nature unless otherwise configured. For more detailed 
information about the Fax Manager, refer to  Chap 4. 

Online helD 
~ 

At almost every point in QuickLink I1 Fax, there is a Help button 
just waiting to  be clicked if you are beginning to get lost or don’t 
know what to do next. 

Additionally, there is a Help menu a t  the right end of the menu bar 
for broader concepts and the Help Index. This online help system 
summarizes most of this manual and can even be printed by 
choosing Print Topic from the File menu in the Help Window. 
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Chapter 3 
Viewing and Printing Faxes 

There is little point in receiving faxes unless you can easily look at 
them and print them. Chapter 3 explains how to print and view 
faxes, as well as provides a description of fax files and their usual 
locations. 

QuickLink II fax files 

QuickLink I1 Fax has  a standard naming convention for received 
faxes and the files that  they are saved in. All received fax files have 
the three letter file extension .REC. Also, faxes are numbered 
sequentially and have the word FAX as the first three letters in the 
filename. Therefore, your first received fax will have the file name 
FAX0001.REC. Received faxes also get saved in the same directory 
every time, so there is no need to search your hard disk for fax files. 
The default location is the INBOX subdirectory off the QuickLink 
I1 Fax directory (this would look like C:\QLBFAXW\INBOX), 
though this can be set differently with the Receive Fax Setup 
dialog box under the Setup menu (refer to Chap 4). 

The files created by you to fax out have a virtually identical 
internal format as  receivedfax files, but they have a different three 
letter file extension so you can easily keep track what faxes are 
incoming and which are outgoing. These outgoing fax files are 
.QFX files and these are the files that you create when you convert 
your documents and graphics files to the faxable format by clicking 
the Save to File button in the Send Fax Information dialog box 
when using the print driver. QFX files normally get stored in the 
OUTBOX subdirectory off the QuickLink I1 Fax directory (this 
would look like C:\QLBFAX\OUTBOX), though this can be set 
differently with the Send Fax Setup dialog box under the Setup 
menu (refer to Chap 4). 

I t  cannot be stressed enough that REC files and QFX files are the 
same type of files with different three letter extensions. They are  
printed, viewed, faxed out, and in every other way handled the 
same way by QuickLink I1 Fax. 
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Viewing faxes 

QuickLink I1 Fax has a separate module used solely for viewing 
faxes; the Fax Viewer. The Fax Viewer can be accessed several 
ways: it can be launched by double clicking on the View Fax icon 
in the Windows Program Manager, by clicking on the View Fax 
button on the QuickLink I1 Fax button bar, or  from within the 
QuickLink I1 Fax application by choosing View Fax Document 
from the Fax menu. For this example, launch the Fax Viewer from 
the QuickLink I1 Fax main application with the Fax pull down 
menu. 

ChoosingView Fax Document calls up theview FaxDocument  
single file selection dialog box. I t  is here that specific QFX or REC 
files can be selected to view. To select one, simply select the 
directory where the file is with the Directories list box and double 
click on the file you want to view in the Files list box. Choosing 
O p e n  in the Fax Viewer will call this same dialog box to select a fax 
file to view. There is already a file called README.QFX in the 
QuickLink I1 Fax directory to test the viewer, so select this file to 
view. (This file was created when sending the README.TXT file 
from the QuickLink I1 Fax main application in the previous 
chapter. If you did not follow the tutorial, this file will not exist.) 

The fax viewer 
When a file loads into the Fax Viewer, it loads at full size at the 
upper left corner of the fax. Immediately above the fax is the Viewer 
button bar, which provides easy access to all the viewer functions. 
These functions are also duplicated through the pull down menus 
if you do not want to use the button bar (the button bar can be 
removed by choosing Button Bar in the Edit menu). 
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The first button is the Open File button, which allows you to open 
fax files within the module. The second button is the Print button, 
which will print the currently viewed fax to your active printer 
(Refer to the next section for more information about printing 
faxes). These commands are duplicated in the File menu. 

The next three buttons allow you to change the view of the fax. The 
first is the Full Size button, which displays the fax at its actual 
size. Notice that since this is the view being used now, the button 
looks pressed in. Next to it is the Fit Vertical button, which makes 
the current page fit in the Fax Viewer Window vertically. The Fit 
Horizontal button, located next to the Fit Vertical button, does 
the same thing only horizontally. Depending how the Fax Viewer 
window is sized, these last two options can dramatically change the 
view of the fax. These commands are duplicated in the View menu. 

The next set of three buttons controls the view and movement of the 
fax within the Fax Viewer window. The first and second are the 
Zoom In and Zoom Out buttons, which will increase and decrease 
the magnification of the fax. The Grabber Hand button will 
restore the pointer to the normal hand, which permits you to 
manually drag the fax around the window; the hand performs the 
same function as the scroll bars along the side of the window. 
Simply dragging the hand (clicking and holding the mouse button 
when the pointer looks like a hand) moves the fax. These commands 
are duplicated in the View menu. 

The next set offour buttons is used to change pages in multiple page 
faxes. The first two in the set will display the Previous Page and 
Next Page of a fax document, respectively. The last two will leap 
to the First Page and Last Page in the fax. Note that these 
buttons will be dimmed for single page faxes. These commands are 
also duplicated in the View menu. 

The next buttons control the image. The first is the Flip Horizontal 
button, followed by the Flip Vertical button, which allow you to 
flip the fax image along both axes. These commands are very useful 
if the person sending the fax put the original sheet through their 
fax machine upside-down or backwards. The following button 
Reverses the image - in other words it makes black text on a 
white sheet of paper look like white text on a black sheet of paper 
like a photo negative. These commands are accessible through the 
Image menu. 

When you are through viewing a fax, choosing Exit from the File 
menu will close the Fax Viewer window. Since the fax file itself does 
not get altered in any way by viewing, there is no command to save 
the image. 
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Printing faxes 

Faxes can be printed with any Windows compatible printer, so 
printers successfully configured to print outfilesfiom otherwindows 
programs will successfully print faxes with QuickLink I1 Fax. 

Printing faxes is a very simple 
process. From within the 
QuickLink I1 Fax m a i n  
application or the Fax Viewer, 
pull down the File menu and 
choose Print. Choose Fax or 
Text Fi le in  theresultingPrint 
Document dialog box and click 
Print. Choose the fax file you 
want to print from the Print 
File dialog box by selecting the directory in the Director ies  list 
box and double clicking on the file in the Files list box (this step is 
skipped when printing from the fax viewer, which prints the 
currently viewed fax). 

The final steps to printing a fax are completed in the Print dialog 
box. I t  is here that you can select the printer you wish t o  print t o  by 
clicking the Setup button, setting the Print Quality with the pull 
down menu, and selecting the range of pages t o  print with Page 
Range.  The Image Scale will print full size 8 1/2" by 11" faxes a t  
their original size; long faxes can be automatically scaled to fit on 
a single sheet of paper by choosing Scale to fit page length. 

Advanced faxing 

If you have the need to manipulate your faxes and fax files further, 
refer to the next chapter for an explanation of advanced fax 
functions. 
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Chapter 4 
Advanced Fax Functions 

You now know everything you need to  make QuickLink I1 Fax send 
and receive faxes, print and view them, and all the basic skills to 
keep you happily faxing. But there is so much more QuickLink I1 
Fax can do to meet your special faxing needs. These special 
functions are covered in Chapter 4, and include: 

How to use the Fax Phone List 
Keeping track of your faxes by using the Fax Logs 
How to convert faxes into graphic files and vice versa 
How to schedule faxes to send a t  a later time 
How to view the outgoing fax schedule 
How to send a fax to someone who is already on the line 
How to send the same fax to hundreds of fax machines 
How to use the Fax Manager, and what is does 
How to change QuickLink I1 Fax’s default fax settings 

The fax phone list 

The Fax Phone list provides access to your personalized 
fax phonebook for frequently dialed fax machines. It 
can be accessed by choosing Fax Phone List from the 
Fax menu and from the Send Fax Information dialog 
box, as well as  directly from the button bar with the Fax List 
button. 

Building and editing the list 
The Fax Phone List dialog box is comprised of the entry list box 
and its function buttons. To add a number to the Fax Phone List, 
click the Add button. The Fax Phone List Add dialog box will 
appear, providing text boxes for the Name, the Fax phone 
number, and the Group identifier, if desired. If a fax is normally 
sent to someone specifically within a company, a fax can be made 
to their attention by entering their name in the Attention field. 
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Select an entry lrom the phone Cxl. 

u r s n t  Fax Phons Lixt: FAXPHONE.LST 

The Group identifier allows you to define a collection of fax 
numbers that may be dialed by selecting one member of the group. 
For example, you could easily send the same fax to all your 
customers by giving each person who is on your list who is a 
customer the same Group character, and then simply sending a fax 
to the group. Each person would receive the fax. AGroup identifier 
may be any character on your keyboard. Using a Group identifier 
is optional. After entering the information required, click the OK 
button to add the entry to the directory. 

The Edit button is used to  
modify an entry listing. To 
select an entry to  edit, select 
the desired name and number 
by clickingonit and clickEdit. 
The Delete button will remove 
the selected entry -the Info 
button displays the entire 
entry. 

Choosing fax destinations 
Once the Fax Phone List has the telephone numbers of your 
intended fax recipients, choosing entries to fax to is done with the 
Mark and Mark Group buttons. The Mark button is used to select 
those fax numbers to which you wish to send a fax -you may send 
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a fax to as many different numbers as you have entries in the Fax 
Phone List. Highlighting the entry you wish to send the fax to and 
clicking Mark will mark it. Entries must be marked before faxes 
can be sent to them; a marked entry has an  icon placed next to it to  
show its marked status. Mark Group instructs QuickLink I1 Fax 
to select the entire group of fax numbers based on the Group of the 
highlighted entry. Marking instructs QuickLink I1 Fax to  send a 
fax document or several documents to the Marked fax numbers 
when the OK button is clicked. The Cancel button will remove the 
Fax Phone List from your screen without dialing a remote fax 
telephone number or recording any updates made to the fax phone 
list. 

If you are choosing Fax Phone List from the main application and 
a fax document has not yet been specified, the Select Files dialog 
box appears next to select a document to fax. It functions exactly as  
if choosing Send Fax. 

Fax logs 

By choosing View FaxLog from the Faxmenu, 
you can view a log of faxes that have been sent 
and received with the Send Log and the Receive 
Log. Both logs provide the status of the 200 most 
recent fax transmissions, and can be printed by choosing Print 
from the File menu. These logs are also accessible with the Send 
Log and Rec. Log buttons on the button bar. 

Receive fax log 

The Receive Fax log provides a line of information for each fax 
transmission received. Thelog displays theDate,Time, Document 
file name, the number of Pages received, and the Status of the 
received fax. A specific entry can be removed with the Remove 
button; the entire log can be cleared by clicking Remove All. 
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By clicking the Info button, additional information will be displayed 
for the selected fax, including the Remote ID of the sending fax, 
the Resolution, and the specific Error of a failed fax receive, if 
any. A fax can be viewed directly from the log by simply double- 
clicking it from the list box. 

Send fax loa 
Each entry in the Send Fax log represents a transmitted fax from 
either the main application or the print driver. Each entry includes 
the Date and Time ofthe transmission, the Name of the fax called, 
the Phone Number, and the Status of the sent fax. A specific 
entry can be removed with the Remove button; the entire log can 
be cleared by clicking Remove All. 

By clicking the Info button, additional information will be displayed 
for the selected fax, including the Resolution of the sent fax, the 
Duration of the call, and the specific Error of a failed fax send, if 
any. 

Converting fax files graphically 

All faxes that get received 
are graphics, as  opposed 
to text files. As such. vou Export from Fax ... 
can modify a fax*by 
convertingit into a common graphic file so that i t  can be edited with 
a Paint program, such as Windows Paint. Faxes that get sent out 
are graphics too (your text documents are converted into a "picturen 
of the text, so to speak), so you can convert graphic files to fax easily. 
Graphics conversions of faxes can be completed with the Convert 
Documentscommand,locatedunder the Faxmenu, which presents 
the sub-menu Export from Fax and Import to Fax. 

Exporting a fax into a graphic file 
The Export command allows you to convert a fax file (QFX or REC 
file formats) into a Paintbrush file (.PCX or .DCX) or one of two 
TIFF (.TIF) formats: compressed or uncompressed. These formats 
can be imported into most Windows and paint applications; in 
general, simple Paint programs tend to use PCXfiles, while higher 
end graphics programs work better with TIFF files. 
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To convert a fax file, choose Export, which calls up the Export 
File dialog box. With it, select the appropriate directory in the 
Directories list box and select the fax file you want to  convert in 
the Files list box, clicking OK when highlighted. 

Selecting a file calls up the Export Fax File dialog box, which 
controls the aspects of the graphic file the fax is being converted 
into. The filename of the fax can be changed in the Exported 
Filename field. The file format (and the three letter file extension 
for the new file) is controlled with the Exporting To radio buttons; 
simply pick a file format by clicking on it. Converting specific pages 
of multipage faxes can be controlled by entering a specific range of 
pages in the Page Range area, and the resolution can be manually 
changed by checking the High Resolution checkbox. 

Clicking OK will start the conversion, and apercent bar will inform 
you of the status of the conversion. The resulting graphic file will 
be located in the same directory as the fax file from which it was 
created. 

Importing a graphic into a fax 
Ordinarily, graphics can be faxed out by simply printing to the fax/ 
modem with the QuickLink I1 Fax print driver from the Windows 
application that created the graphic itself, but graphics can also be 
converted directly into a fax file from within QuickLink I1 Fax by 
choosing Import to Fax. 

Since several graphic files can be converted at once, the multiple 
files dialog box Convert  Documents - Import to Fax is used. 
Up to 255 files can be converted at once with this dialog box; fdes 
are selected just like sending a fax. The graphic formats supported 
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include PC Paintbrush (.PCX), multiple page Paintbrush (.DCX), 
TIFF(.TIF), Windows Bitmap (.BMP), or MacPaint (.MAC). Graphic 
files convert into .&Fxfax files. Files get saved in their original locations. 

After selecting the files to send and clicking OK, the document 
conversion window will appear during the conversion process to 
provide status information on the conversion. 

Fax scheduling 

When faxing out, there may be occasions when you do not want to 
fax the document out immediately, perhaps because you know the 
recipient’s fax machine is only on at a certain time of the day, or 
because you want to fax during the night when telephone rates are 
lowest. If this is the case, you can schedule the fax to send later. 

Scheduling a fax is very simple. Regardless of how you send out a 
fax, you can schedule an outgoing fax from the Send Fax 
Information dialog box. Within it, in the Schedule section, you 
can set the Time and Date when you want the fax to send. The 
document will immediately convert into a QFX file located in the 
OUTBOX folder, ready to be faxed out at the scheduled time. The 
date and time on the cover page will be added as the document is 
actually sent, reflecting the send time, not the convert time. Ifyour 
computer is not powered on and running Windows at the scheduled 
time, it will begin the transfer as soon as the Fax Manager is 
launched. 
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Sending a fax manually 

One of the nicer features of a true fax machine is its ability to send 
a fax to someone who is already on the phone with you. A fax 
machine owner could just reach down and press the Send button to 
start sending a fax over the line. Traditionally, fax modems have 
had a problem with this, but QuickLink I1 Fax allows you to  do the 
equivalent. 

To send a fax manually, send a fax as you ordinarily would, right 
up to the point where a phone number would be entered in the Send 
Fax Information dialog box. Instead ofkeyingin a number, check 
the Manual Send checkbox and click the Send Fax button. Then, 
QuickLink I1 Fax will create a cover page and convert the file (if 
necessary), and prompt you to dial. 

Manual receiving works through the Fax Manager; for more 
information, refer to the Fax Manager section in this chapter. 

Viewing the fax schedule 

The View Fax Schedule command, accessed from the Fax menu, 
allows you to see what fax transmissions are scheduled to be sent 
and at what date and time. Provided information includes Date, 
Time, Destination, Phone Number, and the number of 
Locations the document will be sent to. Unless you are broadcasting 
to a group (Refer to next section), this will read 1. 

To remove a selected scheduled transmission, select the desired 
entry from the list and click the Remove button. To totally clear 
the schedule of faxes, click Remove All. 
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Sending the same fax to several destinations 

The ability to send out the same fax to several destinations is called 
broadcasting, and is fully supported by QuickLink I1 Fax. The 
easiest way to broadcast a fax is to simply select more than one 
destination from the Fax Phone List by highlighting it and clicking 
the Mark button, which will put a small icon next to it to indicate 
that it is on the broadcast list. You may mark as many destinations 
in the Fax Phone List as you want - clicking OK will lock the 
destinations in. Destinations can be unmarked by highlighting the 
destination and clicking Un-Mark. A fax can be sent to a whole 
Group quickly by selecting a member of a Group and clicking on 
Mark Group. Clicking Un-Mark Group will unmark them all. 
Groupbroadcastingisthemainreasontousethe Groupfieldinthephonelist. 

When combined with scheduling, it is easy to send literally 
hundreds offaxes at night; just enter a Date and Time in the Send 
Fax Information dialog box. 

The Fax Manager 

The Fax Manager is in charge of monitoring the modem and COM 
port for sending faxes, answering incoming calls, and identifying 
calls a s  either fax, voice, or data. When running, the Fax Manager 
is either a minimized icon at the bottom ofthe desktop, or maximized 
and displaying its status. I t  can be loaded by double-clicking the 
Fax Manager icon in the Windows Program Manager or by choosing 
Load Fax Manager from the QuickLink I1 Fax menu. 

Fax Manager options 
Clicking once on the minimized Fax 
Manager icon or clicking on the Control rr, 
box on the upper left corner of the 

pull down the Fax Manager Control 
menu. I t  is from this menu that the Fax 

Fax Receiving is a toggled option, 
which means that the Fax Manager’s 

Minimize 

maximized Fax Manager window will s m e  AlltF4 

Manual Fax Receive CtrltM 

Show ModcmMonitor 

JEaxReceiving 

Manager can be configured. 
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ability to receive faxes is enabled when this option has a checkmark 
next to it. This option is toggled by choosing it from the Control 
menu. When Fax Receiving is not checked, the Fax Manager has  
released the COM port and modem, so other modem programs can 
have access to your hardware. If you have an auto-dialer, for 
example, and it is not working while the Fax Manager is loaded, 
disable Fax Receiving. Clicking on the minimized Fax Manager 
with the right mouse button also toggles Fax Receiving. When 
disabled, the small phone on the icon will disappear. This command 
can also be set from the Fax menu within the QuickLink I1 Fax 
main application. 

Choosing Manual FaxReceive forces the FaxManager to pick up 
the phone line and start broadcasting ureceive fax” tones, which 
will initiate a fax receive. This feature is useful for occasions where 
you are already speaking to someone on the telephone and they 
press the send button on their fax machine to send a fax. Many fax- 
hack services will not work until the Manual Fax Receive command 
is used. This command can also be invoked from the Fax menu 
within the QuickLink I1 Fax main application. Not all modems 
support this option fully. 

The bottom option on the menu toggles between Show 
ModemMonitor and Show Percent Bar. The percent bar is a 
status rectangle thatfills as faxes are transmitted. While maximized, 
you can toggle between the two options by clicking on the status 
rectangle or  ModemMonitor with your cursor. For more information 
on the ModemMonitor, refer to Chap 5. 

Fax setup options 

The commands and options that customize your faxing features 
and abilities that  are accessible under the Setup menu are covered 
in this section. 

Send fax setup 
The Send Fax Setup dialog box allows you to  define standard 
information t o  be used during fax transmissions. The Send Fax 
Setup dialog box contains two sections; Conversion options and 
Control Options. 

File Conversion Options 
The File Conversion options define how a fax document will appear 
when it is transmitted to  a remote fax when the file is converted 
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within QuickLink 11 Fax - most of these settings do not apply 
when converting faxes using the Print Driver. The first check box 
tells QuickLink I1 Fax to Center the Text or Graphic on the fax 
page vertically when converting. The second option is to allow you 
to change between Normal resolution and FineMigh 
resolution fax modes. Normal is the default resolution when this 
option is not selected. With normal resolution, QuickLink I1 Fax 
doubles the scaling on the vertical axis to allow for the differing 
resolution between the computer graphics standards and fax 
standards. This scaling is not needed for finehigh resolution. At 
document conversion time, QuickLink I1 Fax will look to see which 
resolution has been selected and perform any scaling necessary. 

The next check box in this section, Full Page TextIGraphics, 
instructs QuickLink I1 Fax to force the page length specified in 
page layout, even ifthis results in blank space on a page. Otherwise, 
it will be the length of the text you are sending. 

The Page Layout settings allow you to specify the page size and 
margin and tab settings when converting text files in the QuickLink 
I1 Fax main application. These options are used at fax conversion 
time. 

Control Options 
The second section of the Send Fax Setup dialog box provides fax 
transmission control options. "he first check box, Include Cover 
Page, provides you with the option to include a cover page with 
each fax transmission. Failure to select this option means that you 
cannot send a cover page; therefore, the default is On. 
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The Dedicate CPU during send checkbox tells QuickLink I1 Fax 
to force the sending of fax transmissions to the foreground and in  
doing so dedicate your computer until the completion of the 
transmission. Any applications running in the foreground at the 
time a fax transmission occurs would be temporarily halted until 
the completion of the send. The default for this option is off. You 
may find that it is necessary to turn this option on if you are 
running disk access intensive applications in the foreground. 

The Delete Fax Files after send checkbox instructs QuickLink 
I1 Fax to delete the .QFXfile after successful transmission. This can 
save a good deal of disk space. 

The next two selections deal with Fax Manager. Remove Fax 
Manager after send tells QuickLink I1 Fax t o  remove the Fax 
Manager from memory after sending a fax document. The second 
option instructs Fax Manager to run maximized. 

RTS/CTS flow control on fax send lets your fadmodem use its 
built in flow control during a fax transmission. If your fax modem 
does not support this type offlow control and you are unable to send 
faxes, uncheck this option. The default is on. 

The number of Redial attempts field allows you to specify how 
many times to redial a busy fax machine before logging it a s  busy 
in the Send Fax Log. The Redial Delay field specifies the number 
of seconds to wait before attempting to redial a busy fax machine. 
The Maximum fax baud rate menu instructs QuickLink I1 Fax 
what the maximum speed to use when sending a fax. 

The Out Box button allows you to specify the directory into which 
QuickLink I1 Fax stores fax documents for sending during a 
schedule. The default directory is called \OUTBOX in the 
\rQL2FAXW directory. 

Clicking OK saves these settings and closes the dialog box, Cancel 
will close the dialog box and ignore the new settings. 

Receive fax setup 
s 

The Receive Fax Setup dialog box allows you to  define standard 
information to be used during the receiving of fax transmissions. 

The Fax ID string field allows you to specify your Fax ID. This 
string is limited t o  19 characters in length. The Fax ID is an 
identifier t o  the remote fax machine or fadmodem, and often 
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appears in the sending fax machine’s status window. Common ID’S 
include telephone numbers, names, and business names. Note that 
some older fax machines must sense a Fax ID in all uppercase 
letters. See the Troubleshooting Appendix for more information. 

Fax Manager  load options 
This section of Receive Fax Setup provides special control over the 
loading and unloading of the Fax Manager. The first option 
specifies that Fax Manager  be loaded at Windows startup 
time. The second option Enables the Fax Manager to receive 
faxes. The final option instructs Fax Manager to run maximized. 
If the Fax Manager is not loaded and enabled you cannot receive an  
incoming fax. 

Receive Options 
These options tell the Fax Manager what actions to  take when a fax 
is received. Checking Beep on receive will cause a beep to sound 
when a fax is received. The second option will Display a message 
box when a fax is received. The Dedicate CPU on receive check 
box tells the Fax Manager to force the receivingof fax transmissions 
to the foreground and in doing so dedicate your computer until the 
completion of the transmission. Any applications running in the 
foreground a t  the time an  incoming fax transmission occurs would 
be temporarily halted until the completion of the receive. The 
default for this option is off. The Spawn  QuickLink I1 Fax option 
instructs Fax Manager to automatically start QuickLink I1 Fax if 
it is not already running when a data call is detected. 
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"he final option instructs Fax Manager to Automatically print 
a received fax to the printer selected after the receipt of a n  
incoming fax. Clicking the Select button allows you to choose a 
printer. 

The In Box button allows you to change where your incoming fax 
messages will be saved. This setting defaults to the \INBOX sub- 
directory under the \QLBFAXW directory. 

The OK button will accept the entries and remove the dialog box 
from the screen. The Cancel button will disregard any changes 
and remove the dialog box. The Help button will cause the Help 
Window to  be displayed. 

Cover page setup 

The Cover Page Setup dialog box provides you with text boxes to be 
used for entering information about you and your company for the 
fax page headers and fax cover page. 

Each fax page sent with QuickLink I1 Fax (excluding the cover 
page) will include a page header with the Company name, date, 
time and page # of the fax, assuming that information has  been 
entered in the Company Name text box. 

QuickLink I1 Fax will automatically create and send a cover page 
a t  the front of each fax transmission if the Include Cover Page 
option is checked on the Send Fax Setup dialog box. The Company 
Name is also placed a t  the top of the cover page and the Fax From 
name and Phone # shown on the cover page default to the entries 
in the From and Fax # text boxes. The Voice contact number is 
also included on the cover page. 
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If you wish to include a Cover Page Graphic such as a company 
logo, enter its complete pathname or click the Browse button. Afile 
selection box will appear asking you for the name of the graphic logo 
or image file. This file can be either a black and white TIF or PCX 
file or Monochrome Bitmap file (BMP) with a resolution no greater 
than 200 DPI. Once you select the file, the name will appear next 
to the Cover Page Graphic field. When you press OK, a conversion 
box will appear while the selected file is converted to a form usable 
as your cover page graphic. Once this is done, the graphic will be 
at the top of each cover page you fax out. 

Select the OK button to accept any changes and remove the dialog 
box. The Cancel button will disregard any changes and remove the 
dialog box from the screen. 
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Chapter 5 
DataComm Overview 

Chapter 5 describes how to call another modem or BBS for a Data 
Communications connection and how to upload (send) and 
download (receive) files to and from remote systems. The commands 
used for data communications are in the Connect menu. Topics 
include: 

Calling a BBS (Bulletin Board System) or other modem 
How to use the Data Phone Book 
Uploading a file 
Downloading a file 
How to capture the text of a n  online session to a text file on disk 
How to paste the Clipboard's contents to the host computer 
How to clear the screen 
How to answer a Data call 
How to emulate modem status lights with the ModemMonitor 
How to free the COM port for other Windows programs 
A brief description of the transfer protocols available 

Chapter 6 also explains the configurable settings under the Setup 
menu for data communications. 

Originating a data call (dialing out) 

There are two ways to dial out for a Data Comm connection: a quick 
Dial, or accessing the Data Phone List. 

Quickly dialing a number 
The great majority of data communications sessions will 
begin with you dialing out t o  another modem, BBS, or 
online service. The quickest way to do this is by simply 
dialing the modem with the Dial command from the 
Connect menu or with the Dial button on the button bar, which 
brings up the Dial Modem dialog box. From this box, the telephone 
number can be entered in to the Number to dial field and dialed. 
If you would like the modem to redial if it encounters a BUSY 
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signal, check the Redial on busy  checkbox. Clicking OK starts 
dialing. 

H u d m r  lo &d: 11-61 9-555-1 21 2 

RialRedii: [S. 

Dial Optiona 

DiaIUmeo&: 1901 seconds 

ae-diil Delay: [ p ) I  seconds 

Re-did Attempts: 1 7 1  

The Dial Prefix is used for dialing any digits before the actual 
telephone number is dialed, and may be set for all calls from the 
Modem Setup dialog box, accessible from the Setup menu 
(discussed later this Chapter). The Dial Prefix is commonly used in 
office situations where you need to dial a 9 to get an  outside line or 
dialtone, for example. In such a case, entering a 9, followed by a 
comma (,I would first dial a 9, then pause 2 seconds (a comma is a 
2 second pause) then continue dialing the telephone number. The 
Redial Timeout tells QuickLink I1 Fax how long to  wait for a 
CONNECT before aborting. If the S7 register is set lower than the 
Redial Timeout, the S7 register time will be used. 

Usina the Data Phone List 
Choosing Da ta  Phone List from the Connect menu 
brings up the D a t a  Phone List dialog box, allowing 
access to  a datacom telephone book of all your frequently 
dialed data numbers-clickingData List on the button 
bar accesses the phone book too. You’ll find that it is accessed 
almost exactly like the Fax Phone List, and can be printed the same 
way (choosing Print from the File menu and selecting Data  Phone 
List). 

Choose it now, and you will find that there is already an  entry in 
the list: American E-Mail. American E-Mail is Smith Micro 
Software’s BBS; you are invited to use this system to  test the data 
portion of QuickLink I1 Fax. There is no charge for using our 
system, other than the long distance charges from your telephone 
company for dialing the 714 area code (The 714 area code connects 
to Southern California). To dial any number as it appears in the 
Data Phone List, highlight the entry by clicking on it and click on 
the Dial button. The Add and Delete buttons allow you to  
respectively add and delete Data Phone List entries. 
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Select a phone list entry to dial 

Cunent Data Phons List: PHONE-LST 

I 

To edit an entry in the Data Phone List, highlight the entry and 
click the Edit Button. Highlight the American E-Mail entry and 
click the Edit button now. This brings up the Data Phone List - 
Edit dialog box, where every aspect of an entry can be changed. To 
change the Name or  Number of an entry, just click in the 
appropriate field and type in the new entry. Notice that spaces and 
dashes are acceptable in the telephone number. If you are calling 
from the 714 area code, be sure to delete the 1-714 from the 
Number field. 

The other fields deal with the more technical aspects of the 
connection, such a s  the Baud Rate, Terminal Type, and Line 
settings. The baud rate and terminal type fields are pull down 
menus and the line settings are radio buttons. While there is no set 
standard terminal type and line setting combination for every 
modem connection, there are some guidelines to follow which may 
be helpful. 
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Set the Baud Rate to the highest your modem will support, or 
to 2400 if you are getting bad connections. When you dial the 
other modem, the two modems will establish the highest 
connection speed possible automatically so long as the 
Autobaud feature is turned on (The default setting for Autobaud 
is On. Refer to later this Chapter). 

Small systems (BBS's) tend to use the ANSI terminal type with 
8 data bits, no parity, and one stop bit (8-N-1 for short). 

Large installations (such as mainframes and online services 
like GEnie and ComDuServe) tend to use the V T l O O  terminal 
type with 7 data bits', even parity, and 1 stop bit (summarized 
by 7-E-1). 

Two people connecting their Pc's together via modem should 
try the TTY terminal type with 8-N-1. You may also need to 
turn on Local Echo and both CWLF checkboxes in the Terminal 
Options dialog box, covered later this Chapter. 

Other than the area code in the telephone number, all the settings 
for the American E-Mail entry are correct. Click OK to leave the 
Edit dialog box and click Dial to dial our BBS. 

Once connected to our American E-Mail system, follow the prompts 
to create a new user account. You will be prompted at every step 
and must create a password of your own choosing to enter the 
system for future online sessions. When connected to our system, 
you may upload and download public domain and utility files and 
programs, visit the Online Software Store, or get online technical 
support. All selections are menu driven; when in doubt enter a 
Question Mark (?)for help. To disconnect from our (or any) system, 
pull down the Connect menu and choose Hangup. 

File transfers 

Unlike faxing, file transfers do not happen automatically; there is 
a good deal of preparation to consider. Fortunately, QuickLink I1 
Fax makes the procedure as intuitive as possible. 

The concept of file transfers 
Before getting into the specifics of file transfers, an outline of the 
concept of uploading and downloading should be very helpful to 
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those users who have never transferred files before. The genera1 
process is something like this: 

1. 

2. 

3. 

4. 

5. 

6. 

Connect with the other modem or system (covered in the 
previous sections). Make sure that you can both write to the 
screen so the other end can understand you and vice versa. 

Tell the other side that you are interested in file transfers. 

Tell the other side what file(s) you want or what file(s) they 
should expect from you. 

Tell the other side what transfer protocol to use (for a discussion 
on the differences between the protocols, refer to the next section). 

When the other side says they are ready, pull down the File 
menu and choose Send File or Receive File, and choose the 
protocol you told the other side to expect. 

I capture Text.. AlttT I Super Kermit ... I 

I CtrltP modem ... I Xmodem CRC... 

I Ymodems ... I 
I Zmodem ... I 

If sending, choose the fde(s) you want to send and click OK the 
transfer begins. If receiving using Xmodem (of any type) or 
ASCII protocols, type the name of the file you want to receive 
and Click OK; for all other protocols just click OK and the 
transfer begins. 

With this in mind, QuickLink I1 Fax file transfers will make a lot 
more sense. 

Selecting one file to upload 
The ASCII, Xmodem, Xmodem CRC, and Xmodem 1K protocols let 
you upload only one file per transmission. When you select sending 
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File Name. 

[e I 

conpu.rv.rrp 

I 

by one of these protocols, the Send Single File dialog box appears 
with the selected protocol as  the title. 

To send a file, enter the complete path of the file you want to  upload. 
For example, to  upload the file SALARY.DOC from the WINWORD 
subdirectory on your computer 's  C dr ive,  type:  
C : \WINWORD\SWY.DOC and click OK. 

OR 

Use the Directorieslist  box to scroll through the subdirectories on 
your Pc's hard drive and select the file from the Files list box, 
clicking OK when highlighted. This starts the transfer and callsup 
the Upload Status dialog box. 

~uecloriet: 

d Iql2farr 

Selectina multiole files to uDload 
The KermitlSuperKermit, Ymodem, and Ymodem-G protocols let 
you upload more than one file during the same transmission. In 
addition to sending a batch offiles, one file may also be sent by itself. 
The main advantage of sending one file with one of these protocols 
is that the other end need not type in a file name, as the file name 
is included with the transfer using these protocols. If you select one 
of these protocols, the Send Multiple Files dialog box appears with 
the selected protocol as  the title. This dialog box works similarly t o  
the Send Fax dialog box. 

If you want to upload files from the current path, shown at the top 
of the Directories list box, enter the filename in the File Name 
field and click Add. Otherwise, enter the complete path of the file 
you want t o  upload. For example, to upload the file SALARY.DOC 
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from the WINWORD subdirectory on your computer‘s C cirive, 
type: C:\WINWORD\SALARY.DOC and click OK. 

OR 

Use the Directories list box to scroll through the subdirectories on 
your PC’s hard drive and select the files from the Files Available 
list box, clicking ADD to add the file to the Files Selected list box. 
Repeat this for every file you want to  add to the batch send. If you 
change your mind about sending one of the files, highlight it in the 
Files Selected list box and click Remove. The selected file is 
removed from the list box and will not be sent. When the list offiles 
selected is complete, click the OK button, which begins the transfer 
and calls up the Upload Status dialog box. 

Files Sekcled: 

1 
Udoad status 
The Upload Status dialog box keeps you informed of the status of 
the upload. I t  displays the following information: 

Protocol displays which protocol is being used for the current 
transmission. 
File Name displays the name of the current file being 
transferred. 
File Size displays the size of the current file being transferred. 
Bytes Sent displays the number of bytes sent. 
Status shows the current status of the upload. For example, 
Sending data appears when data is being sent t o  the remote 
system. 

The status percent bar at the bottom of the dialog box displays the 
progress of the upload. The whole transfer can be stopped by 
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clicking the Cancel button. The Minimize button will reduce 
QuickLink I1 Fax to an icon a t  the bottom of the screen while the 
transfer is still taking place, so you can truly send files in the 
background and work with other programs. 

When the transfer is finished, a dialog box will appear to alert you, 
and the computer will beep. Clicking OK removes the dialog box. 
If QuickLink I1 Fax is still minimized, double clicking on its icon 
will return you to the terminal window to resume communications. 

Downloading files 
Receivingfiles works much like sending afile and actually involves 
less steps. The biggest issue is determining what protocol is being 
used and how many files are being sent. 

Receivina one file 
The ASCII, Xmodem, Xmodem CRC, and Xmodem 1Kprotocols let 
you download only one file per transmission. When you select 
receiving by one of these protocols, the Receive Single File dialog 
box appears with the selected protocol as  the title. 

Fla M-: 
im 1 

S n .  F h  .. Irp: 
lup ‘I e 

At this point, QuickLink I1 Fax needs a file name to  save the file 
under. To receive the file, enter the complete path of the file you 
want to download. For example, to download the file PICTURE.BMP 
to the WINDOWS subdirectory on your computer’s C drive, type: 
C:\WINDOWS\PICTUREBMP and click OK. 

OR 

Use theDirectorieslist box to scroll through the subdirectories on 
your PC’s hard drive and type in the file’s name in the Fi le  Name  
field, clicking OK done. This starts the transfer and calls up the 
Download Status dialog box. 

- . .- 
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Receiving a batch of files 
The Kermit/SuperKermit, Ymodem, and Ymodem-G, protocols let 
you download more than one file during the same transmission. In 
addition to receiving a batch of files, one file may also be received 
by itself. The main advantage of receiving one file with one of these 
protocols is that the file name is included with the transfer using 
these protocols, so it is impossible for files to be named incorrectly. 

When you use one of these protocols, the Receive Multiple Files 
dialog box appears with the selected protocol as the title. This 
dialog box works similarly with the Receive Single Files dialog box, 
except that you cannot enter a file name. Another directory can be 
selected with the Directories list box, and clicking OK initiates 
the transfer and calls up the Download Status dialog box. 

Download status 
The Download Status dialog box keeps you informed of the status 
of the download. It displays the following information: 

Protocol displays which protocol is being used for the current 
transmission. 
File Name displays the name of the current file being 
transferred. 
File Size displays the size of the current file being transferred. 
(Batch protocol only) 
Bytes Received displays the number of bytes sent 
Status shows the current status of the upload. For example, 
Receiving data appears when data is being received from the 
remote system. 

The status percent bar at the bottom of the dialog box displays the 
progress of the download (Batch protocol only). The whole transfer 
may be stopped by clicking the Cancel button. The Minimize 
button will reduce QuickLink I1 Fax to an icon at the bottom of the 
screen while the transfer is still taking place, so you can truly 
receive files in the background and work with other programs. 

When the transfer is finished, a dialog box will appear to alert you, 
and the computer will beep. Clicking OK removes the dialog box. 
If QuickLink I1 Fax is still minimized, double clicking on its icon 
will return you to the terminal window to resume communications. 
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Capture text 

if you know in advance that you want to capture the text that 
appears on screen, QuickLink I1 Fax can be set to  make a copy of 
everything you see and save it into a text file on your computer's 
hard disk. 

To capture text, pull down the File menu and choose C a p t u r e  
Text, which calls up the Capture Text dialog box. The Capture 
Text dialog box works just like the Receive Single File dialog box 
Type a name for the fde to save the captured text in the File Name 
field and click OK to begin capturing. You can select another 
directory with the Directories list box. 

You can double-check that QuickLink I1 Fax is indeed capturing 
text by pulling down the File menu; when there is a checkmark 
next to Capture Text, text is being captured. Choosing Capture 
Text again will stop the capture and close the file, making the 
checkmark disappear. Capture Text has nothing to do with 
receiving faxes or faxing. 

Retransmitting what you see 

Choosing Paste to Host will transmit the contents ofthe Windows 
Clipboard out the modem or fadmodem to the remote computer or 
terminal. This function will only operate if the contents of the 
clipboard are in text format. 
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Clearing the screen 

Choosing Clear Screen from the Edit menu will clear the terminal 
window of its text. This command will not affect the connection to 
the remote system. 

Answering a data call 

Answering a call is almost totally automatic and handled by the Fax 
Manager. The Fax Manager’s default settings will let it listen to the 
incoming call to determine what it is: either fax, data, or voice. If 
it is a modeddata  call, the Fax Manager will seamlessly pass the 
call into the QuickLink I1 Fax telecommunications mode, even 
automatically launching the main application and waiting for your 
input in  the terminal window. 

A data call can also be answered when you are in the main 
application QuickLink I1 Fax and the Fax Manager is not running 
if the Answer Mode is set to either Data Only or Auto Detect 
from the Modem Setup dialog box (Refer to later this Chapter). 
Typing ATA and then the Enter key in the terminal window will 
also force the modem to pick up the line and answer the call. 

Strictly speaking, the SO register can be set to the number of rings 
you want the modem to answer the phone, but this will conflict with 
the Fax Manager‘s operation and bypass the Number of Rings to 
Answer Phone field in the Modem Setup dialog box. You are 
strongly urged not to change the SO register in the Init string. If you 
do, be sure to change it back to SO=O to receive faxes. 

Using the ModemMonitor 

The lack of status lights on internal modems or fadmodems can 
sometimes leave you in the dark about what your fadmodem is 
actually doing when online. For example, if a connection accidentally 
terminates when online, someone with a n  external modem can 
simply look at the status lights on the modem itself and determine 
what’s happening - an internal modem owner might be left in the 
dark. 

When activated, the ModemMonitor creates a set of modem status 
lights on screen in their own window. Since the ModemMonitor is 
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actually a part of the Fax Manager, it must be running and 
maximized, and then the ModemMonitor called to the screen. 

Displaying the ModemMonitor 
Follow these steps to display the ModemMonitor: 

1. Load the Fax Manager. This can be done by choos ingbad  Fax 
Manager from the Fax menu or by double-clicking it from the 
Windows Program Manager. 

2. Maximize the Fax Manager, if an icon. Double-clicking on it 
while at the bottom of the desktop will maximize the Fax 
Manager. 

3. If necessary, display the ModemMonitor by choosing Show 
ModemMonitorfrom the FaxManager Control menu, or click 
on the empty percent bar. 

The status liahts 
There are 10 modem status lights visible in the ModemMonitor. 
They indicate the following when on (red): 

Fx: 

HS: 

AA: 

CD: 
OH: 

Rx: 

Tx: 

TR: 

M R :  
cs: 

Fax Connection 

High Speed 

Auto Answer 

Carrier Detect 
Off Hook 

Receive Data 

Transmit Data 

Terminal Ready 

Modem Ready 
Clear t o  Send 

The incoming or outgoing call is a fax. 
This light is blue. 
The established connection is 9600 
baud o r  higher. 
Flashes whenever a RINGis detected 
by the modem 
The modem detects a remote carrier 
The modem has picked up the 
telephone line 
The modem is receiving characters or 
data 
The modem is transmittingcharacters 
or data out 
The modendcomputer is ready to send 
and receive commands 
The modem is powered up 
The modem is ready to receive more 
data 
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Freeing the COM port 

The Data Comm portion of QuickLink I1 Fax has  control 
of the COM port (and your modem or fadmodem) 
whenever the terminal window is On-Line, even if 
behind other windows or minimized. On some systems, 
this can interfere with auto-dialing and other modem programs. 
Therefore, QuickLink I1 Fax can release the COM port temporarily 
for other programs by doing one of the following: 

Clicking the Off-Line button on the button bar. This removes 
the terminal window and releases the COM port. Clicking On- 
Line restores the terminal window. 

Choose Off-Line from the Connect menu. This also removes 
the terminal window and releases the COM port. Choosing On- 
Line from the Connect menu restores the terminal window. 

Close the QuickLink I1 Fax main application by exiting it. 

If the Fax Manager is running, it may also have access to the COM 
port, interfering with other modem programs. Refer to Chapter 4 
for more information. 

Protocols 

This section describes the various protocols that  QuickLink I1 Fax 
provides for uploading and downloading data files. 
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ASCII 

The ASCII protocol (pronounced asky) is a seven-bit protocol that  
consists of the 128 characters that make up the upper- and lower- 
case alphabet, numbers, characters available on a standard 
keyboard, and certain special control characters. 

The ASCII protocol has no error-checking capabilities. ASCII 
protocol uses XONKOFF handshaking and requires XONKOFF 
flow control to be enabled a t  both communicating devices. By 
default, QuickLink I1 Fax has XONKOFF flow control disabled. 
When the computer receiving data needs t o  stop the data 
transmission temporarily t o  process the received data, it sends B 
Ctrl-S ("S) character to  stop the sending computer from sending 
data. When the receivingcomputer has processed the received data 
and is ready to  accept more, it sends the sending computer a Ctrl- 
Q ("Q) character to resume data transmission. 

Since there are no additional error checking characters sent during 
the transmission, ASCII is good for sending a burst transmission of 
raw texvdata uninterrupted. 

COmpUSerVe BIB+ (Available with selected versions) 

The CompuServe B/B+ protocol should be used when communicating 
with CompuServe. 

KermitlSuper Kermit 
QuickLink I1 Fax provides both the standard Kermit as well as the 
powerful Super Kermit (Windowed Kermit) protocol. It was 
developed to  meet the needs for file transfer between a number of 
different types ofcomputers, includingmainframes, mini computers 
and personal computers. Unlike Xmodem and Ymodem, Kermit 
uses variable packet sizes, with a maximum size of 1024 bytes. Like 
Ymodem, Kermit provides for batch file transfers. 

SuperKermit is especially useful when transferring data over data 
networks such a s  Telenet or Tymnet. These networks have long 
communications delays that can significantly degrade the 
performance of file transfers. For each packet transmitted, two 
communications delays will be interjected into the transfer. Super 
Kermit addresses this problem by sending multiple packets at one 
time, also known as  a transmission window. All error correction is 
still performed, however the  receiving computer does not 
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acknowledge the receipt of the data or ask for re-transmission of 
any bad packets until all packets in the window have been received. 
This process results in a dramatic reduction in the delay time. 

Of the public services, only CompuServe supports Kermit. If you 
select Super Kermit and the remote computer only supports Kermit, 
QuickLink I1 Fax will drop back to Kermit. 

Xmodem 
QuickLink 11 Fax provides three different Xmodem protocols: 
Xmodem lK, Xmodem CRC and the original Xmodem (also called 
Modem7 or Xmodem Checksum or Christenson). 

In order for Xmodem to work, the data format must be set t o  8 data 
bits, 1 stop bit, and no parity. Ifyou did not begin the communications 
session with this setting, QuickLink I1 Fax will automatically 
correct this for you. Xmodem Checksum sends the data in packets 
off 128 bytes. Therefore a lKfile (1,024 bytes) would be transmitted 
in 8 data packets. A simple data checksum is added to each packed 
and is checked on the receiving end of the transfer. If the receiving 
Xmodem detects a bad packet, it can request the packet again 
giving a good level of error recovery. 

Xmodem CRC 

In an effort to guard against undetected errors the original Xmodem 
was enhanced by replacing the 8 bit checksum with a 16 bit Cyclic 
Redundancy Check (CRC). This change provides a 99.9984% 
assurance of detecting any transmission errors. With the checksum 
method, it is possible for 1 out of 256 bad packets to have a valid 
checksum, and thus go undetected. With the CRC method only 1 
out of 700 billion bad packets will generate a valid CRC. The CRC 
method also transmits 128 byte blocks or  packets of data. If you 
select Xmodem CRC and the other system does not support it, 
QuickLink I1 Fax will automatically switch over to the standard 
Xmodem; to the user both methods appear to operate identically. 

Xmodem 1 K 
This method ofXmodem replaces the original 128 byte packets with 
packets of 1,024 bytes when possible. Assuming that no transmission 
errors are detected, this method ofXmodem will enlarge the packet 
size to 1K and maintain that packet size for as long as possible. 
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Enlarging the packet size will improve the speed of the file transfer. 
If you attempt to receive a fde using Xmodem 1K and the other side 
only supports Xmodem CRC, QuickLink I1 Fax will fall back to 
Xmodem CRC. 

Ymodem 
The Ymodem protocol (also called Ymodem Batch, Ymodem lK, 
and Ymodem CRC) is very similar to the Xmodem lK, with two 
major differences- with Ymodem you can automatically receive or 
send multiple files in one session, and file names are included with 
the transfer. In general, Ymodem is very fast, very safe and 
preferable to Xmodem, even for single files. 

Y modem-G 
Ymodem-G is a file transfer protocol that provides the same error 
checking as Ymodem, but it will not perform any error recovery. 
Therefore, Ymodem requires an error-correcting modem or fax/ 
modem with either MNP 2-4 andlor V.42. If both ends of the 
transmission meet the requirements, transfers will be exceptionally 
fast. 

Zmodem (Available with selected versions) 

The Zmodem protocol is a new and popular protocol that  lets you 
send multiple files in one transfer. Features include automatic 
downloading and the ability t o  send file names, sizes, and creation 
dates of each file. Also, if a data transmission is interrupted 
midway, Zmodem lets you resume the data transmission from the 
pointwhere it let off. 

The size of the data block varies with Zmodem, depending on the 
condition of the connection of the telephone line between the 
communicating devices. Moveover, both 32-bit and 16-bit CRC 
errror-checking are available with Zmodem. 

Zmodem is a relatively young transfer protocol, not identically 
implemented a t  various sites. If you are having problems with 
Zmodem protocols, try Ymodem or Xmodem. 
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Data communications setup options 

In  addition to permitting QuickLink I1 Fax to communicate with 
the variety of standard data communication configurations, the 
Setup menu contains the options to customize QuickLink I1 Fax to 
your system. 

Line settings 
Choosing Line Settings from the Setup menu causes the Line 
Settings dialog box to appear. This dialog box allows you to select 
the line speed, data format and flow control to be used during 
communications; these settings are independent of the settings in 
the Data Phone List, but the same general guidelines for setting 
them apply (Refer to the Data Phone List section for more 
information). The Cancel button will exit without using any 
changes. The OK button will remove the dialog box and implement 
all option changes. 

Baud rate 
Possible baud rate settings may vary from 110 baud to 115,200 
baud. The default speed is 2400 baud. Refer to your modem manual 
for the maximum baud rate that your modem will handle. 

Data bits 
The allowable options are 4, 5, 6, 7 or 8 data bits - the default 
setting is 8 data bits. 

Parity 
Parity may be Odd, Even, Mark, Space or None. None only applies 
when 8 data bits are selected. The default setting is no parity. 

Stop bits 
The allowable settings are 1,1.5 or 2. The default setting is 1 stop 
bit. 
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Flow control 
Flow Control is the process of telling each computer to stop sending 
data and starting it again. This provides time to process the data 
received. Flow control is usually not needed for 2400 baud data 
connections. 

Xon/Xof€ is a software flow control that involves the sending of 
special control codes as part of the data. I t  is usually necessary for 
ASCII file transfers. Hardware flow control (RTSICTS) is 
implemented in both software and the modem hardware, therefore 
your modem must support the RTSCTS standard for this method 
to be used. The RTS/CTS method is more reliable1 and is necessary 
for use with modems equipped with V.42N.42bis and MNP Level 
5. The default setting is none. 

Modem setup 
The Modem Setup dialog box provides you with the ability to define 
the modem Initialization, Dial, and Hang up strings. This 
dialog box also allows you t o  set the COM port that  the modem will 
use and define key information to be used by the Fax Manager for 
answering incoming calls. 

The Cancel button allows you t o  exit the dialog box without using 
any changes. The Default button resets the settings to factory 
defaults. The OK button acceptsall changes and removes the dialog 
box from the screen. The Hardware button allows you to change 
the class of Fax Manager used by QuickLink 11. I t  is not normally 
necessary to alter this setting. 

Initialization string 
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The modem initialization string is the command set that QuickLink 
IIFax issues to the modem when the application is first started. The 
default string works with most modems and fadmodems. If your 
modem has special features or commands, the AT commands 
needed to enable them are entered here. Check your modem 
manual for a detailed breakdown of the AT command set. An 
abbreviated set is listed in Appendix C. 

Dial string 
The Dial string is the command QuickLink I1 Fax issues to the 
modem when instructed to dial a number. This event occurs when 
dialing from the Data Phone List, using the Dialer, sending a fax, 
or connecting to  either CompuServe, Dow Jones or GEnie. Click 
the Options button to automatically change the Dial string for 
pulse dialing, detecting the dial tone, detecting the BUSY signal, 
and/or disabling call waiting. 

Hangup string 
The hangup string is the command QuickLink I1 Fax issues to the 
modem when the Hangup command is chosen from the Connect 
menu. This string is pre-set to ATH, which is the AT command to 
hangup the modem. 

Dial prefidsuffix 
The dial prefidsufix strings are appended t o  the beginning and 
end of the telephone number when dialing. These strings are handy 
when you need to dial using credit card, or for long distance 
telephone access, or  for dialing a digit to get an outside line. For 
example, if you need to dial a 9 to dial out of an office building, enter 
a 9 and a comma (,I in the Dial prefix (a comma is a 2 second 
pause). 
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Answer mode 
This entry asks under what circumstances you want QuickLink I1 
Fax to answer the telephone. Fax only tells Fax Manager to 
process fax calls only and hangup on all others. With Data only 
selected, QuickLink I1 Fax will handle data calls and hang up on fax 
or voice calls. Auto Detect instructs the Fax Manager to answer 
all calls. With Auto Detect selected the Fax Manager will receive 
fax transmissions, transfer data calls automatically to the QuickLink 
I1 Fax main application, or display a message that a voice call is 
waiting and provide a limited amount of time to respond prior to 
hangup (some modems are not capable of Automatically Detecting 
the line). If you do not want the phone to be answered, select the 
Never Answer option. Selecting the Never Answer option is 
similar to setting the number of rings to answer to 0. 

Number of rings to answer phone 
QuickLink I1 Fax will pick up the line and answer the phone on the 
number of rings specified in the Answer on field. Setting this 
number to 0 will keep the Fax Manager from answering calls. Some 
modems will answer 1 to 2 rings after the number specified due to 
the hardware. The default is 1. 

Terminal options 
The Terminal Options dialog box allows you to set the terminal 
attributes you want QuickLink I1 Fax to  use. A number of check 
boxes are provided to turn options on or off. 

Local echo 
The Local echo option tells QuickLink I1 Fax to display all keyboard 
entries directly to the terminal window rather than letting the 
remote computer echo the keystrokes back as is normal. If you 
cannot see what you type, turn this option on. If characters appear 
double, (lliikkee tthhiiss) turn this option off. Some telecom 
programs call this setting “DuplexkIalf-Duplex”. 

Change CR to CWLF 
These options tells QuickLink I1 Fax t o  translate all outgoing and/ 
or incoming Carriage Returns to Carriage Return + Line Feed. If 
incoming or outgoing lines are overwriting each other, turn the 
option on. 

Line wrap 

w80 QuickLink II  Fax User’s Guide 



Windows DataComm Overview 

This option issues a carriage return + line feed if more than 80 
characters are transmitted on a single line. 

Destructive backspace 
This option instructs QuickLink I1 Fax t o  erase a character when 
the backspace key is pressed. When this option is not selected, 
pressing the backspace key will move the cursor back one character 
but will not erase the character that may be above the cursor. 

Show status bar 
This option tells QuickLink I1 Fax t o  always display the terminal 
Status Bar when the program is started. Choosing Status Bar 
from the Edit menu only affects the StatusBar for a single session. 

Show button bar 
This option tells QuickLink I1 Fax to always display the ButtonBar 
when the program is started. Choosing Button Bar from the Edit 
menu only affects the Button Bar for a single session. 

On-Line at startup 
This option opens the terminal window and COM port when the 
program is started. 

Off-Line on hang up 
This option ensures QuickLink I1 Fax closes the COM port when 
you exit the program. 

Smart mode 
Selecting Redial  on busy tells QuickLink I1 Fax to perform an  
auto-redial when your modem detects a busy signal. Selecting 
Auto baud tells QuickLink I1 Fax t o  automatically reset the baud 
rate if the modem answers a call and makes a connection a t  a rate 
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other than the rate specified at dialing. Smart Mode options apply 
at any time QuickLink I1 Fax dials the modem, such as when using 
the Dialer, Phone List, executing a Script Dial Statement, or 
connecting to CompuServe, Dow Jones or GEnie. You must also 
have an  AT Command set compatible modem that detects and 
displays the connection baud rate. English responses must be set 
on. 

Color setup 
The Color button provides you with the capability to adjust the 
terminal screen foreground and background colors, as well as the 
colors used for blinking text for VTlOONT102. All color choices are 
accessible through the pull down menus. 

Terminal Emulation 
The TerminalEmulatormenu allows you to change the emulation 
by providing you with an emulator list. QuickLink I1 Fax supports 
Teletype U'TY), Dec VT102, Dec VT100, Dec VT52 and ANSI 
terminal emulation. Terminal emulation is the ability of QuickLink 
I1 Fax to  make your PC look like a specific type of terminal to  a 
remote computer. In performing this task QuickLink I1 Fax 
translates the remote computers special instructions for such 
things as screen cursor positioning, display color and textlgraphics 
display. 

V T l O O  / VT102 setup 
The VTlOO button allows for additional settings for the V T l O O /  
VT102 emulation modes. By selecting the V T l O O  Button the 
VT100/102 Terminal Setup dialog box will appear. 

You should take special care in not changing the default settings 
unless you are certain that the host application absolutely requires 
a change. The default settings have been set to the most commonly 
used values. Altering options such as the Tab Stops may cause host 
applications to not operate properly on your terminal. The following 
options are found on the VTlOONT102 Terminal Setup: 

New line mode 
With this option off, a Return generates a carriage return. A 
linefeed (LF) moves the cursor to  the next line maintaining the 
current column position. With this option on, a Return generates a 
carriage return and a linefeed. A linefeed moves the cursor to the 
left margin of the next line. 

Answerback message 
The text box contains a 1 to 20 character message that will be 
transmitted upon computer request or  operator command. 
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Tabs 
Up to 10 tab positions may be entered in the tab text box. Each tab 
position entry must be separated from the next entry by a comma. 

The OK button will remove the dialo: box from the screen and 
implement any option changes. Clicking Cancel removes the 
dialog box from the screen but does not use any changes made. 

Refer to Appendix Afor additional information on the QuickLink I1 
Fax implementation of the VT100/102 keypad and other special 
VT100/102 keys. The appendix lists the PC key equivalents 
established by QuickLink I1 Fax to emulate the VT100/102 keyboard. 
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Chapter 6 
Automating QuickLink II Fax 

QuickLink I1 Fax has several advanced features which can make 
your online communications sessions quicker and easier to manage 
by automatingvariousfunctions. Chapter 7 describes these features: 

Macro Keys 
Logging on to  online services automatically 

Scripts and the scripting language 

Online services quick access 

QuickLink I1 Fax can quickly connect you to your accounts on the 
major online services. Before it can do this, however, you must set 
QuickLink I1 Fax with the proper information. When configured, 
you can connect to  Dow Jones, CompuServe, and GEnie with just 
one mouse click. 

Services setuD 
Services Setup, accessed from the Setup menu, allows you to 
specify account information for the Dow Jones, CompuServe, and 
GEnie online services. Choosing Services Setup from the Setup 
menu calls the Services Setup dialog box, which is where the 
actual account information is keyed into QuickLink I1 Fax. 

Follow the appropriate section(s) for your online service account(s): 

CompuServe: Ifyou will be calling CompuServe, use this section 
to enter your Account number and Password, 
and select the public network (Compunet, 
Telenet, or Tymnet) you want to access by 
keying in its phone number and clicking the 
corresponding radio button. 

If you will be calling Dow Jones, use this section 
to enter your Password and select the public 

Dow Jones: 
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network (Telenet or Tymnet) you want to access 
and its phone number. 

If you will be calling GEnie, use this section to 
enter your User ID and Password. Do not enter 
the separating comma. Enter the telephone 
number needed to connect to GEnie i n  the 
GEnienet field. 

GEnie: 

Clicking OK sets the information. 

Connecting to online services 
Once the account information is keyed in, simply pulling down the 
Connect menu and selecting the appropriate Online Service will 
automatically dial your modem, log you in, and enter your password. 

Macro keys 

The Macro Key function allows you to define a custom meaning or 
sequence ofkeystrokes to the selection offunction keys, F1 through 
F12. These Macro Keys can cause a user defined literal string 
(series of characters) to be transmitted or they can be used to launch 
a script file. 

Choosing Macro Keys from the Setup menu calls the Macro Key 
definition dialog box, which allows you to enter a literal string you 
want transmitted when each of the function keys are depressed, or 
to specify a Script file name if you want a script file launched when 
the function key is pressed. If you wish the edit field t o  contain a 
script file name, check the Script checkbox next to the edit field and 
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a file selection window will appear allowing you t o  automatically 
select the script file. The text box may contain either a literal string 
or  a script file name, but not both. In the example below, note that 
the definition for F1 is defined as aliteral stringwhile the definition 
of F2 is a Script File. Additionally the "\r" in the definition for F1, 
instructs QuickLink I1 Fax t o  send a Carriage Return after typing 
out the characters. Clicking OK saves the macro keys for future 
sessions. For more information on Scripts, refer to  the next section. 

Scripts 

Scripts are miniature programs-within-a-program, and can totally 1 
I 
I 

automate your online sessions (the Online Services module of 
QuickLink I1 Fax is actually a script file, for example). Properly 
programmed, a script can call a BBS, log on to it, and automatically 
readyour mail, and logout, all by pressing a single key. This section 
describes how to run and write scripts. 

Running scripts 
Scriptsare actually files that contain within them a list ofinstructions 
and commands. Scripts, therefore, are on your disk and must be 
opened and ran; there are the main ways to do this: 

1. With a Macro Key, as described previously in this chapter. 
Checking the Script checkbox in the Macro Keys dialog box 
calls another dialog box to select a script file from your hard 
disk. 
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2. Choose Run Script from the Connect menu, which calls the 
same dialog box to open and run a script file on your hard disk. 

3. By dialing a telephone number from the Data Phone List with 
a n  associated script 

QuickLink II Fax Script language elements 

The QuickLink I1 Fax script language is made up of commands that 
may be used to create a script file. A script file may be created using 
the Notepad on the Edit Menu. You may also use any external 
editor to create the script file. 

A script file is used to instruct QuickLink I1 Fax to perform a 
predefined set of operations. Script files can be defined to 
automatically perform the dialing and logon process necessary to 
automatically connect to a remote computer. The script can also be 
programmed t o  perform specific steps once the connection to a 
remote computer is made. 

The commands that comprise the script language may be entered 
in either upper or lower case. Each line of the script may contain 
only one command. The commands may be indented to any point 
you wish in order to enhance readability. Blank lines may also be 
inserted in the script files to show breaks in sections on the script 
statements. 

You may include comments in the script file by placinga semi-colon 
in the first position ofthe line to contain a comment. Any information 
appearing on the line after the semicolon will be considered as 
comments, even if the information includes otherwise valid script 
commands. 

When sending strings to a remote computer, a string may be 
defined to include a literal value, a Return character or a n  ASCII 
character represented by its decimal value. Literal character 
strings must be enclosed by double quotes. A return character is 
defined by includinga‘\r’ in the command line. An ASCII character 
is defined by including a ‘\ddd‘ in the command line, where ddd is 
the decimal value of the ASCII character (see Appendix B for ASCII 
Value Table). For example, you would use this feature to send a 
Control-C to a remote computer. 

When a script is running, a message will be displayed in the status 
area of the Menu Bar. You may abort a script execution by simply 
pressing the Escape key. 

W-68 QuickLink II Fax User’s Guide 



Windows Automating QuickLink II Fax 

Script language commands 
The QuickLink I1 Fax script language is comprised of the following 
commands: 

Baud Statement: 
This Statement allows you to specify the baud rate to be used when 
the script file is executed. 

Format: Baud "rate" 

"Rate" can be set to 110,150,300,600,1200,2400,4800,7200,9600, 
12000,14400,19200,38400, or 57600. 

Clearstring Statement: 
"his command will clear the contents of the special variable called 
InString. This variable is created by the use of the second form of 
the In Statement defined below. 

Format: Clearstring 

CLS Statement: 
This command will clear the QuickLink I1 Fax Terminal Window 
and has  the same effect as selectingclear Screen on the Edit Menu. 

Format: CLS 

The CLS statement will not impact the contents of the Line Buffer. 

Data  Statement: 
This statement is used to specify the number of data bits, either 4, 
5,6, 7 or 8 to be used during the execution of the script. 

Format: Data "#'' 

Where # is either 4, 5,6,7 or 8. 

Dial Statement: 
This command will instruct QuickLink I1 Fax to dial a specified 
telephone number. 

Format: Dial 'kxx-xxxx" 

Where, xxx-xxxx is the telephone number to be dialed. QuickLink 
I1 Fax will use the dialing prefix defined on the Modem Setup 
Dialog Box. You must have an AT command set compatible modem 
and have English Responses set on to use this statement. 
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Example: Dial "1-714-362-5822'a 

The example above would instruct QuickLink I1 Fax to  dial the 
Smith Micro Software support BBS. 

Echo Statement: 
This command will cause a literal string that follows the command 
to be displayed in the local Terminal Window. 

Format: Echo "xxxxxx" 

Where, xxxxxx is a literal string to  be echoed to  the Terminal 
Window. The string must be enclosed by double quotes. 

Echo 'This is a sample string" Example: 

The string, This is a sample string, will be displayed in the local 
Terminal Window. 

End Statement: 
This command is used to mark the logical end of a set of script 
commands. 

Format: End 

Execution of the script instructions is halted upon encounteringan 
END command. 

Goto Statement: 
This command will transfer the execution to a specified procedure 
name. 

Format: Goto Procedure: 

Where Procedure: is the name of a procedure defined in the script 
file. The procedure name must end with a colon. The following 
script code shows the use of the GOT0 statement. 

Example Start: 
Echo "This is an example" 
Goto Step2: 
Stepl: 
End 
Step2: 
Goto Stepl: 
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If you follow the execution of the script above, the last procedure 
executed is Stepl:  that  terminates the script with the END 
Statement. 

I f  Statement: 
The Ifstatement allows you to  test the contents ofa special variable 
called Instring. InString is created by using the second form of the 
In Statement defined below. 

Format: If Instring = 'hxxxxx" Goto Procedure: 

Where xxxxxxx is a literal string not longer than 40 characters. If 
InString equals the specified literal string then execution is 
transferred to  the procedure specified in the Goto. 

Example: If InString = "Password" Goto Step2: 

In Statement: 
There are two forms of the In Statement. The first form of the 
statement will cause QuickLink I1 Fax to wait "n" secondsfor string 
of characters to  be received from a remote computer. 

Format: In "xxxxxx" n 

Where, xxxxxx is a string for which you want QuickLink I1 Fax to 
wait. QuickLink I1 Fax will wait up to "n" seconds for a message to 
be received from a remote computer. If after waiting "n" seconds, 
the string is not received, the remainder of the commands in the 
script file will be bypassed. 

Example: In "Password?" 30 

QuickLink I1 Fax will wait 30 secondsfor the string, Password?, to 
be received from the remote computer, before continuing with the 
execution of the script. 

The second form of the In Statement allows you the capability to 
receive one character at a time from your modem. Each character 
will be added t o  a special buffer called Instring. 

Format: In InString 

InString may contain up to  40 characters ofinput and will generate 
an error if more than 40 characters are received. InString may be 
used in an  If statement for testing and controlling the flow of the 
script execution. 
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Out Statement: 
This command will cause a string to be transmitted to a remote 
computer. 

Format: out ' k x x x d  

Where, xxxxxx is a string to be transmitted to a remote computer. 

Example: Out "DEMOPASS\I' 

QuickLink I1 Fax will transmit the string, DEMOPASS, to the 
remote computer followed by a Return character Or). 

Pause Statement: 
"his statement will cause the execution of a script file to be 
temporarily halted until the user presses a key on the keyboard. 

Format: Pause 

A message will be displayed in the terminal window, instructing 
the user t o  Press a Key to Continue. 

Parity Statement: 
This statement is used to specify the parity t o  be used during the 
execution of the script. 

Format: Parity "x" 

Where, x is "N" for none, "0" for odd, "E" for even, " M  for mark, and 
"S" for space parity. 

RtsCts Statement: 
This statement is used to specify whether the RTSICTS hardware 
flow control is to be used when executing this script. 

Format: RtsCts 'W' 

Where, xx is "ON" for on or "OFF" for off. 

Stop Statement: 
"his statement is used t o  specify the number of stop bits, either 1, 
1.5 or 2 to be used during the execution of the script. 

Format: stop u#" 

Where # is either 1, 1.5 or 2. 
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Until Statement: 
This command will cause QuickLink I1 Fax to wait until a specified 
time before continuing with the execution of the script. 

Format: Until “hhmm” 

The time must be specified in the form of 24 hour military time. 

Wait Statement: 
This command will cause QuickLink I1 Fax to delay for ‘n’ seconds 
before proceeding with the next script command. 

Format: Wait n 

Where ‘n’ is the number of seconds you want QuickLink I1 Fax to 
wait before proceeding to the next script command. 

Example: Wait 15 

QuickLink I1 Fax will wait 15 seconds before executing the next 
step in the script file. 

XonXoff Statement: 
This statement is used to specify whether the Xon/Xoff flow control 
is to be used when executing this script. 

Format: xonxoff UXX” 

Where, xx is “ON” for on or “OFF“ for off. 

In addition to the above script commands, the QuickLink 11 Fax 
script language includesa number ofpredefinedvariables that may 
be used in writing a script. Many of these variables are used by 
QuickLink I1 Fax to provide automatic connection to Compuserve, 
Dow Jones and GEnie. The following list of variables are included 
in the script language: 

Variable Meaning 
Compunet 
Telenet Telephone number for Telenet 
Tymnet Telephone number for Tymnet 
Cacct CompuServe account number 
Cpass CompuServe password 
Dpass Dow Jones password 
Guser GEnie user number 
Gpass Genie password 

Telephone number for CompuSerye’s own network 
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You will find a number of script files (.SRP) in your QuickLink I1 
Fax default directory that use the above script commands and 
variables for accessing CompuServe, Dow Jones and GEnie. These 
files are listed below: 

File Use 
COMPUSRV.SRP Connects to CompuServe 
DOWJONES.SRP Connects to  Dow Jones 
EMAIL.SRP 

GENIE.SRP Connects t o  GEnie 

You can use the above files as examples for creat>ng your awn 
scripts. Also, if you are not in the United States and want 
automatic access to CompuServe, Dow Jones or GEnie simply 
modify the proper script file, from the list above, to operate with 
your country's telephone access system. 

Connects to the American Email BBS a t  
Smith Micro Software, Inc. 

~~ 
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Getting Started - DOS 

Chapter 7 describes how to begin using QuickLink I1 Fax. It 
describes how to start QuickLink I1 Fax, how to send a simple fax 
or note from the QuickLink I1 Fax Main Application, how to send 
afaxfrom most DOS applications that can print to a LaserJet Series 
I1 printer driver, and how to prepare to receive a fax. It also 
describes how QuickLink I1 Fax receives datacodmodem calls and 
determines how an incoming call is a fax, datacom connection, or 
voice call. 

Starting QuickLink II Fax 

QuickLink I1 Fax is a DOS program, which means that you must 
navigate through DOS somewhat in order to  start it up. The 
preferred way to run QuickLink I1 Fax is the following: 

1. Start your computer - after a moment you should see the C:\> 
prompt. If you launch into Windows o r  a menu program, exit to 
DOS until you get a prompt. 

2. Type CD\QLZFAX at your DOS prompt. This switches you 
into the default QuickLink I1 Fax Install directory. If you 
installed QuickLink I1 Fax into another directory, use the CD 
command to switch into it. 

3. Type QLZFAX to run the QuickLink I1 main program. The 
startup screen appears -press the ENTER key or click OK t o  
continue to  the main screen. 

Sending a fax from within a DOS application 

QuickLink I1 Fax has a pop-up module called FastFax IV, which 
allows you to fax out a document from within most DOS applications 
that allow you to print  through a Hewlett Packard LaserJet Series 
I1 printer driver. This does not mean that you have t o  own a 
LaserJet 11; i t  means that your DOS application must have access 
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to a LaserJet Series I1 printer driver. Wordperfect, for example, 
can be configured to print with several printers - if you have a n  
Epson printer, you told WordPerfect to install the Epson printer 
driver from the Wordperfect Install Disks. FastFax needs you to 
install the HP LaserJet Series I1 printer driver in addition to any 
printer drivers you already have configured for the programs you 
want to fax out of. The manual that came with your application will 
show you how. Printing with any otherprint driver will most 
likely not work or result i n  extremely bizarre looking faxes. 

The benefits of using FastFax are numerous. Once set up, you can 
send out a fax from your DOS application without ever leaving it; 
by simply pressing a Hot-Key on your keyboard and printing, your 
document will instantly fax out. In addition, all of your fonts, 
graphics, layout, and formatting will fax out exactly as it would 
print on alaserprinter-trueMTPIWYG(WhatYouPrint1sWhat 
You Get) faxing! Since FastFax faxes out as you “print”, file formats 
and file conversions are completely irrelevant. 

FastFax has  many command line options and can be configured to 
activate from a specific printer port. For more information, refer to 
Chapter 12. 

Settina UD FastFax 
The FastFax module does require a small amount of initial setup 
before you can use it. First, there is a one-time need to install an HP 
LaserJet Series I1 printer driver in the DOS applicatiods) you wish 
to fax out of. Secondly, the FastFax module must be loaded into 
memory each computing session you want to fax out of your DOS 
application. 

Installing the HP LaserJet Series I1 Print Driver 
1. Install a HP LaserJet Series I1 printer driver into your DOS 

program if you don’t normally print to a LaserJet Series 11. I t  
may be configured for LPT1 or L P n  (LPT1 is normal) even if 
you already have another printer set for that  port. Most 
programs can have more than one printer driver installed/ 
listed at the same time, so your normal printer shouldn’t be 
affected. Youmay need to  consult the documentation that came 
with the program if you are unsure how to do this. I f ,  after 
searching your documentation and refering to the authors of 
the program, you cannot find or do not have access to the H P  
LaserJet Series II printer driver, try using DOS TEXT or 
GENERIC PRINTER; satisfactory faxes may result. 
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Loading FastFax IV into memory 
2. 

3. 

4. 

5. 

Loasng FastFax into memory is very simple; in fact, it may 
already be in memory. Ifyou told the QuickLink I1 FaxInstaller 
program to have FastFax load into memory when you turn your 
computer on, you can skip ahead to the next section. Otherwise, 
the first step to loading FastFax into memory is to get to  the 
DOS prompt C:\>. 

Next, change directories to the QuickLink I1 Fax Install 
directory, normally C:\QLBFAX, by typing 

Your DOS prompt should change to C:\QLBFAX>. 

Once in the QuickLink I1 Fax directory, FastFax is loaded into 
memory by simply typing FASTFAX. The process should look 
something like: 

FastFax starts to load, asking if you want to load the actual 
sendingmodule(itasksifyouwantto1oadtheTSR)ifitwasn't 
already loaded at your computer's starting up. Unless you have 
a specific reason to do otherwise, type Y for yes. The hard disk 
will spin, your computer will beep, your screen will tell you that 
the FastFax module and the Send/Receive Fax module (TSR) 
have successfully loaded, and return to the DOS prompt. For 
more information about the SendfReceive Fax module, refer to 
the Receiving A Fax section, later this chapter. 

C:\>CD\QLZFAX 

C : \ QL2FAX> FASTFAX 

Faxina out with FastFax 
Once set up, FastFax is extremely easy to use. 
1. Start your word processor or other DOS application, such as 

Wordperfect for DOS, Word for DOS, Q & A, Professional 
Write, or whatever DOS program you want to fax out of. 

2. RetrieveIOpen your document on screen as if you were going to 
print it on your normal printer. 

3. Press the "ALT" and "\" keys at the same time. This is the 
hotkey which call up FastFax from the background. After a 
moment, the FastFax dialog box appears. 

4. Fill out the cover page information, such as the Fax phone 
number, the company that thefaxisgoingTo, whose Attent ion 
youwant, anda shortNote.Youmaya1soaccessyourQuickLink 

QuickLink I1 Fax User's Guide D-77 



I 
I i Getting Started DOS 

Fax Phone List at this point by clicking the Phone List button. 
When finished, press the ENTER key or click OK. 

5. 

6. 

Print the document t o  the LaserJet Series I1 printer driver. 

After a moment, you will hear a beep and the hard drive will 
spin. The document will be intercepted from the printer driver 
on its way to the parallel printer port and be redirected to the 
fadmodem, which dials out and connects to the remote fax 
machine, and sends the fax. 

What you should see and hear as this happens: As soon as you 
print, there will be a “beeping-up” sound and your hard disk 
will spin. While the application is printing, you will see a dialog 
box saying “Converting PCL file” as the hard disk spins some 
more. Finally, if the sendheceive module was loaded, the right 
side of the top line of your screen starts displaying messages, 
such as: “Creating Headers”, “Creating Cover Page” “Dialing“, 
“Sending Page l”, “Fax Busy”, etc. When the message area on 
the top line disappears, the fax is completed. 

7. One fax will be intercepted by FastFax each time the ALT+\ 
keys are pressed. To send another fax, press the ALT+\ keys 
again and fill out the cover page information again. If you want 
to  print to the printer, simply don’t press the ALT+\ keys and 
print to your printer’s print driver, and your program will 
operate normally. 
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Faxing out from Quicklink II  Fax 

If all you need to do is fax out very simple documents quickly, faxing 
directly out of QuickLink I1 Fax makes sense. Before you fax files 
out, however, you should be aware of some limitations when faxing 
out in this manner. First, only DOS Text (batch files and such), 
ASCII Text (pronounced “Asky”), Wordperfect for DOS version 5.0/ 
5.1 documents, and several graphics formats will convert and fax 
out completely. This means that document files from MicroSoft 
Word for DOS and Windows, PFS Professional Write, Wordperfect 
for DOS version 4.Y4.2 and Windows 5.Y5.2, Q & A, Lotus 123, 
Quatro Pro for DOS, and most other DOS and Windows programs 
must be convertedinto WordPerfectv5.0, or DOS or ASCII text files 
before the QuickLink I1 Fax main application can send them (Look 
in your program’s manual under Export, Save As, or Print to Disk 
to find out how to do this). Second, only a minimum amount of 
formatting carries over to the converted documents - fonts, 
columns, and graphics are stripped away as only the basic text of 
the document is faxed out. If these limits are too restraining, 
consider using the FastFax module, described in the previous 
section. 

Sending out faxes from the main 
application requires almost no prior 
set-up, however, and takes only a 
few steps.  S t a r t  by runn ing  
QuickLink I1 Fax, pulling down the 
Fax menu and choosing Send Fax. 
This calls up the Fax Document  
Conversion dialog box, which is 
where the files to fax out are selected 
and converted. There are two main 
sections to this dialog box, the Files available list box on the left, 
and the Files Selected list box on the right. Your goal is to choose 
the file you want to fax in the Files available list box, highlight the 
file, click the Add button to bring the file over to the Files Selected 
list box, and click OK when finished. If you already know the file 
name and its directory, you could also type it in the File Name text 
box and press the ENTER key to place it in the Files Selected list 
box too. 

The location of the files in the Files available list box is displayed 
at the top of this dialog box as the Cur ren t  Path, and it changes 
as you move from directory to directory when retrieving your files 
for conversion. You can change directories to locate your files by 
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either typing the path in the File Name text box (example: typing 
C\WPBl\WPDATAmoves you to your Wordperfect data directory) 
or by using the Files available list box as a menu. You can back up 
one directory lever by highlighting the ".." line and pressing the 
ENTER key or by double-clicking on it; you can enter a directory or 
subdirectory by highlighting the name of the directory in brackets 
and pressing the ENTER key or by double-clicking it. 

There is already a text file called RJ3ADME.TXTin the QuickLink 
I1 Fax directory to illustrate faxing out in this way, so if you haven't 
already, pull down the Fax menu and choose Send Fax, scroll 
down the Files available list and add the file README.TXT. Since 
this is a text file, select the Text file format in the resulting Fax 
Document Type dialog box and click OK to continue. This finally 
brings the file to the Files Selected list box -up to 255 files can 
be selected to be faxed out in this manner, but for now, just click OK 
to fax this one file. 

When you click OK, your files convert into a faxible format, which 
can take more than a minuteon some systems, depending on the 
length of the original document. Once finished, your computer 
beeps, and calls up the FAX Dialer dialog box. To enter the 
telephone number of the fax recipient, simply type the number in 
the text box, spaces, dashes, and parenthesis can be included.ifyou 
like, and click Dial or press the ENTER key. Clicking the Phone 
List button allows you to access entries in your Fax Phone List if 
you have createeone. Enter a phone number and click Dial to 
continue. 

Since the default configuration includes a Cover Page with each 
sentfax, the SendFaxInformationdialogbox appears, prompting 
you to  include information about the Recipient for the Cover Page 
This information includes the company you are sending to in  the 
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To: text box, the specific recipient’s name in the Attn: text box, the 
recipient’s FaxNumber, and a short Cover Page Note ofup to 250 
characters (about 50 words). Clicking OK completes the process, 
creates the Cover Page, and sends out the fax. 

Receiving a fax 

Receiving a fax is handled by the sendlreceive program module of 
QuickLink I1 Fax, called RECFAX; when loaded into memory 
RECFAX totally automates the process of receiving a fax (Strictly 
speaking RECFAX is a TSR, or Terminate and Stay Resident 
program). Depending of how QuickLink I1 Fax was installed, 
RECFAX may already be loaded into memory when you turn on 
your computer, so you’ll be able to receive faxes whenever your 
computer and fadmodem is powered on. If not, RECFAX can be 
loaded into memory at any time by following one of the following 
procedures. 

If you are in the QuickLink I1 Fax main application: 
1. Pull down the Fax menu and choose the bottom option, Load 

Receive Fax. A dialog box appears to inform you that the 
loading process completes. 

2. If the bottom option of the Fax menu is Unload Receive Fax, 
the RECFAX module is already in memory. Selecting Unload 
Receive Fax will remove RECFAX from memory. 

If you are at a DOS prompt: 
1. Change directories to the QuickLink I1 Fax install directory. 

This is normally done by typing CD\QL2FAX. Your DOS 
prompt will probably change to C:\QLBFAX>. 

2. Type RECFAX and press the ENTER key. This loads the 
module into memory and initializes the modem. If RECFAX is 
already loaded into memory, the screen will say so. 

3. To disable the receivingportion ofRECFAXfrom memory, type 
RECFAX/OUT a t  the DOS prompt from within any directory. 
To totally remove it from memory, type RECFAX /ALL. 

RECFAX normally stays in an invisible, idle state while awaiting 
a call; it pops up a status line over anything else on screen along the 
top right edge while actually answering and processing the fax. 
When a fax gets received, the call is automatically logged in  the 
Receive Fax Log and the fax gets saved on the hard disk in the 
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QuickLink I1 Fax Install directory. The first fax file gets named 
FAXOOO1.REC -the 4 digit number increases with each received 
fax. The received fax file can be viewed, printed, and re-sent at any 
time once saved on disk. 

RECFAX's default settings will let it answer the incoming call t o  
determine what i t  is: either fax, data, or voice. If the call is a fax, 
it gets received in the manner just described. If it is a modemldata 
call, RECFAX displays in the top status line that there is a n  
incoming data call, giving you 30 seconds to quit out of your 
application and enter the QuickLink I1 Fax main application t o  
establish the connection. If the incoming call isn't a fax or a data 
call, the status line will display "VOICE CALL". 

How RECFAX makes a determination: Since not all fax machines 
broadcast CNG tones (a special noise which makes it clear to a f a d  
modem that afax transmission is following) when sending, RECFAX 
makes your fadmodem first broadcast datacom handshake tones, 
then fax handshakdtraining tones, and then repeats the cycle a 
number of times, depending somewhat on the fadmodem, and then 
displays the VOICE CALL message. This means that people calling 
you will be hearing some computer tones before you pick up your 
handset. If you only have one telephone line and rarely receive 
faxes (or people call you ahead of time before faxing), you may want 
to set the number of rings to answer the phone to 3-5 rings and set 
the Answer Mode to Fax Only, which will allow you to pick up the 
phone before the fadmodem does. Refer to  Chapter 10 for more 
information. 

Text editor 

QuickLink I1 Fax includes a built-in, miniature text editor, 
accessable from the Edit menu. The Text Editor is perfect for 
editing Script Files and other small text documents, and creating 
small text files to fax out from the QuickLink I1 Fax main application. 
A file is limited to a maximum of 400 lines of text, or about 5 
typewritten pages. 

You also have the option of loading your own editor instead of the 
QLII Faxeditorifyoudesire. Upon choosingEditorfrom theEdi t  
menu, a hierarchical menu will appear for you to specify if you are 
editing an existingfile, a new file, the contents of the line buffer or 
Editor Setup. If you wish to use your own editor such a s  Word 
Perfect@ choose Editor Setup. In  the first text box enter the drive 
and full path and filename for accessing your editor, such as 
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C:\WPSl\WP.EXE. In the second text box enter any execution 
time parameters (command line arguments) that you may normally 
need to  specify for your editor. If you do not use execution 
parameters leave the second text box blank (this is normal). If you 
would like to select the file to  edit before leaving the QuickLink I1 
Fax environment and entering the desired editor, select the first 
check box. If you wish to have the default path changed to the path 
of the desired editor, select the second check box. This may be 
necessary if the editor relies on program or  setup files in its own 
subdirectory. Save the information you have entered by clicking 
the Save button. Click the OK to continue. Now when you select 
the Editor you will have your editor loaded instead of the built in 
QuickLink I1 Fax editor. To return to QuickLink I1 Fax from your 
editor, select the quit function provided by your editor. 

If jou are using the editor provided with QuickLink I1 Fax, you will 
need to select one the first three options on the Editor hierarchical 
menu. If you are editing an existing file you will be presented with 
the standard QuickLink I1 Fax file selection screen. You will need 
to open the file you wish t o  edit. The New File option will open the 
Editor with a blank file and the Line Buffer menu selection will 
place the contents of the Line Buffer in the Editor. 

When you enter the QuickLink I1 Fax Editor, the menu bar will 
change. I t  will change to a Diamond, File, and Edit menus. The 
Diamond menu will allow you to access a help screen with the 
Editor key commands. The File menu bar lets you create New 
files, Save files, Print files, leap to a DOS shell, and Return to 
QL 11 Fax. The Edit menu gives you functions to  Cut, Copy, 
Paste, Clear, Insert and Delete lines. 

When you first enter the editor you will be placed in Edit Mode for 
editing the text file. You are, by default, in the character insert 
mode. You can toggle between insert and over write mode for 
editing by pressing the Ins key on your keyboard. You have full use 
of the Home, End, Page Up, Page Down, and Del keys for positioning 
tnc cursor in t.he text file or  removing characters. In addition to the 
use cf the above standard keys, the QuickLink I1 Fax Text Editor 
uses jpecial key assignments to cut, copy and paste text and to  
ins?r, and delete lines. The table below defines the special key 
a. signments. 

Keys Meaning 
Alt-S 
Al t-Z DOS Shell 
Alt- 
Alt-X 

Saves your current text file 

Editor, Return to QL I1 Fax 
Copy marked text t o  scrap 
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Alt-c 
Alt-V 
Alt-D Delete current line 
Alt-I Insert line 
Alt-M 
Ins Toggle insertlover write mode 

Cut marked text to scrap 
Paste scrap at cursor position 

Mark text for copyfcut text 

Online help 

At almost every point in QuickLink I1 
Fax, there is a Help button just  
waiting to be clicked if you are 
beginning to get lost or don’t know 
what to do next. The quick key for the 
Help button is always ALT-H. 

Additionally, there is a Help item in 
the Diamond Menu at the left end of 
the menu bar for broader concepts and the Help Index. This online 
help system summarizes most of this manual and can guide you 
through any sticky spots. 

Leaving QuickLink II Fax 

Pulling down the File menu reveals the two commands to leave 
QuickLink I1 Fax: 

Quit 
The Qui t  function allows you to quit QuickLink I1 Fax and return 
to the DOS command line. Quit does not disconnect the line unless 
you instruct it to do so, so you could switch over to another 
communications program while maintaining the connection ifyour 
other application supports this function. Quit totally removes the 
Main Application from memory and is the normal way to leave the 
program. 

DOS Shell 
The DOS Shell function allows you to temporarily exit and 
perform DOS functions (like deleting files, for example), and then 
return to the communications session. When you are ready to 
return to QuickLink I1 Fax from DOS, simply type the word EXIT 
at the command line. 
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There is little point in receiving faxes unless you can easily look at 
them and print them. Chapter 8 explains how to print and view 
faxes, as well as  provides a description of fax files and their usual 
locations. 

QuickLink II fax files 

QuickLink I1 Fax has a standard naming convention for received 
faxes and the files that  they are saved in. All received fax files have 
the three letter file extension .REC. Also, faxes are numbered 
sequentially and have the word FAX as the first three letters in the 
filename. Therefore, your first received fax will have the file name 
FAX0001.REC. Received faxes also get saved in the same directory 
every time, so there is no need t o  search your hard disk for fax files. 
The default location is the QuickLink I1 Fax directory (normally 
C:\QLBFAX), though this can be set differently with the Receive 
Fax Setup dialog box under the Setup menu (refer to Chap 9). 

The files created by you to fax outhave avirtuallyidentical internal 
format as received fax files, but they have a different three letter 
file extension so you can easily keep track what faxes are incoming 
and which are outgoing. These outgoing fax files are .QFXfiles and 
these are the files that  youcreate when you convert your documents 
and graphics files to the faxable format by choosing Conver t  
Document or Send Fax from the Fax menu or select Save or 
Send and Save from FastFax - QFX files normally get stored in 
the QuickLink I1 Fax directory (normally C:\QLBFAX). 

It cannot be stressed enough that REC files and QFX files are 
basically the same type offiles with different three letter extensions. 
They are viewed, printed, faxed out, and in every other way 
handled tlie same way by QuickLink I1 Fax. 
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Viewing faxes 

Faxes don’t just appear on your screen automatically - you must 
first call the REC or QFX fax files into view. The simplest way to do 
this is to pull down the Fax menu 
and choose View Fax Document. 
When chosen, the View Fax File 
dialog box appears, allowing you to 
select a fax file to view. If you know 
the name of the fax file you want to  
view, simply type the file’s name in 
the File Name text box and press 
the ENTER key; otherwise, select 
the file from the list box (press the 
TAB key ifyou’re using the keyboard) 
and click OK or double-click on the file. In  order to test the viewer 
right now, choose the file README.QFX, a fax file that was created 
when you followed the previous chapter’s section on faxing out 
within QuickLink I1 Fax. 

Once a file is selected to view, your screen changes into graphics 
mode and reads in the fax file, finally displaying the first page of the 
upper left corner ofthe fax a t  full size. Whileviewingafax, pressing 
the F1 key or ALT-H calls up the QuickLink I1 Fax View Help 
dialog box, which displays all of your commands and options while 
in the Viewer. They are: 

Key 
F2 
F3 
F4 
F5 
F6 

Arrow Keys 
PageUp 
PageDown 
Home 
End 
Ins 
Del 

Action 
Zoom Out (Fit page to Screen)/Zoom In (Full Size) 
Previous Page (multiple page fax only) 
Next Page (multiple page fax only) 
Invert Image (Toggle) 
Flip Image Vertically (180’) 

Move Up, Down, Left, Right 
Move 1 Screen Up 
Move 1 Screen Down 
Top of Page 
Bottom of Page 
Left Edge of Page 
Right Edge of Page 

When finish viewing a fax, pressing the ESCAPE key returns t o  the 
main application. 
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Printing faxes 

Printing faxes is a very simple process, so you can easily have hard 
copies of your received faxes to photocopy and pass around. 
QuickLink I1 Fax is compatible with most graphics capable dot- 
matrix and Hewlett Packard compatible printers -ifyou can print 
out graphics files or from within Microsoft Windows, chances are 
you printer will work. 

Setting your printer 
Before printing a fax, you must tell QuickLink I1 Fax what printer 
you have from a provided list. This section will walk you through 
quickly setting up your printer; if you have a problem or for more 
information, please refer t o  the Hardware Setup section of Chapter 
9. 

To configure your printer, pull down the Setup menu and choose 
Hardware. Click on the Q p e  button, and scroll through the 
resulting list until your printer is highlighted - when highlighted, 
click the Select button (or press ENTER). Choose the appropriate 
LPT port from the next dialog box, then click Save, then OK. Zfyour 
printer is not listed, not connected to an LPT port, or for more 
information about the Hardware Setup dialog box, refer to Chapter 
9. 

Printing the fax 
Once QuickLink I1 Fax knows what printer to print to, printing 
faxes consists of two quick steps. 

1. 

2. 

Pull down the File menu and 
choose Print Fax. 

Scroll down the list box and select 
the fax file you want to print, or 
type the name of the fax file you 
want to print in the File Name 
text box. In the File Name text 
box, "*.REC" is listed, which means 
that only files with the .REC 
extension (your received faxes) will 
files, type "*.QF" in the File Name 
to see all files in the directory, type 

be listed. To list your .QFX 
1 text box and press ENTER; 
"*.*" and press ENTER. 
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Once selected, a status dialog box appears to tell you what file, what 
printer, and what print quality is being accessed. To print another 
fax file, repeat steps 1 and 2. 

Advanced faxing 

If you have the need t o  manipulate your faxes and fax files further, 
refer to the next chapter for an explanation of advanced functions. 
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Advanced Fax Functions 

You now know everything you need to make QuickLink I1 Fax send 
and receive faxes, print and view them, and all the basic skills to 
keep you happily faxing. But there is so much more QuickLink I1 
Fax can do to meet your special faxing needs. These special 
functions are covered in Chapter 9, and include: 

How to use the Fax Phone List 
Keeping track of your faxes by using the Fax Logs 
How t o  convert faxes into graphic files and vice versa 
How to schedule faxes to  send a t  a later time 
How t o  view the outgoing fax schedule 
How t o  send the same fax t o  up to hundreds of fax machines 
How to manually receive a fax from someone already on the line 
How to change QuickLink I1 Fax’s default fax settings 

The fax phone list 

The Fax Phone list provides access to your personalized fax 
phonebook for frequently dialed fax machines. It can be accessed by 
choosing Fax Phone List from the Fax menu and from the Fax 
Dialer dialog box, as well as directly from the keyboard with the 
ALT-T key combination. 

Buildina and editina the list 
The Fax Phone List dialog box is comprised of the entry list box and 
its function buttons. To add a number to the Fax Phone List, click 
the Add button. The Fax Phone List Entry dialog box will appear, 
providing text boxes for the Name, the Fax phone Number, and 
the Group identifier, if desired. If afax is normally sent to someone 
specifically within a company, a fax can be made to their attention 
by entering their name in the Attention field. 
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The Group identifier allows you to define a collection of fax 
numbers that may be dialed by selecting one member of the group. 
For example, you could easily send the same fax to all your 
customers by giving each person who is on your list who is a 
customer the same Group character, and then simply sending a fax 
to the group. Each person would receive the fax, AGroup identifier 
may be any character on your keyboard - the cases must also 
match (Agroup with a"B"identifieris different than one with a"b"). 
Using a Group identifier is optional. After entering the information 
required, click the OK button to add the entry t o  the directory, or 
Cancel to undo. 

key and change what you 
want. The Sortbutton allowsyou to sortyour FaxPhoneListeither 
alphabetically, by Group, or  by phone number. The Remove 
button will remove the selected entry. 

Choosing fax destinations 
Once the Fax Phone List has the telephone numbers of your 
intended fax recipients, choosing the entries to fax to is done with 
the Mark button. The Mark button is used to select those fax 
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numbers to which you wish t o  send a fax - you may send a fax to 
as many different numbers as  you have entries in the Fax Phone 
List. Highlighting the entry you wish to send the €ax to and clicking 
Mark will mark it. Entries must be marked before faxes can be sent 
to them; a marked entry has  a checkmark placed next t o  it to  show 
its marked status. If you mark an entry that is in a Group, 
QuickLink I1 Fax asks you if you want to select the entire group of 
fax numbers to fax to based on the Group o f  the highlighted entry. 
Clicking Cancel will mark only the selected entry; clicking OK 
marks the whole Group. Marking instructs QuickLink I1 Fax to 
send a fax document or several documents to  the Marked fax 
numbers when the Send button is clicked. The Cancel button will 
remove the Fax Phone List from your screen without dialing a 
remote fax telephone number o r  recording any updates made to  the 
fax phone list. 

If you are choosing Fax Phone List from the main application and 
a fax document has not yet been specified, the Fax Document 
Conversion dialog box appears next to select a document to fax. 
It functions exactly as if choosing Send Fax (Refer to Chapter 2). 

Fax logs 

By choosingview Fax Log from the Fax menu, you can view a log 
of faxes that have been sent and received with the Send Log and 
the Receive Log. Both logs provide the status of the 250 most 
recent fax transmissions. 

Receive fax loa 
The Receive Fax log provides a line of information for each fax 
transmission received. The log displays the Date, Time, Document 
file name, the number of Pages received, and the Status of the 
received fax. A specific entry can be removed with the Remove 
button; the entire log can be cleared by clicking Remove All. 
Clicking OK returns you to the program. 

By clicking the Info button, additional information will be displayed 
for the selected fax, including the Remote ID of the sending fax, 
the Resolution, the Baud rate, and the specific Error of a failed 
fax receive, if any in the Status line (Error Codes for fax 
transmissions are listed in Appendix C). 
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Send fax log 
Each entry in the Send FaxLogrepresents a transmitted fax from 
either the main application or the FastFax. Each entry includes the 
D a t e  and Time of the transmission, the Destination, the Phone 
Number,  and the Status of the sent fax. A specific entry can be 
removed with the Remove button; the entire log can be cleared by 
clicking Remove All. Clicking OK returns you to the program. 

By clicking the Info button, additional information will be displayed 
for the selected fax, including the Document name, the Resolution 
of the sent fax, the Dura t ion  of the call, and the specific Error of 
a failed fax send, if any in the Status line (Error Codes for fax 
transmissions are listed in Appendix C). 

Converting fax files graphically 

All faxes that get received are graphics, as opposed to text files. 
As such, you can modify a received fax by converting it into a 
standard graphic file so that it can be edited with a Paint program, 
such as Windows Paint or PC Paintbrush. Faxes that get sent out 
are graphics too (your text documents are converted into a graphic 
"picturen of the text, so to  speak), so you can convert graphic files 
to fax easily too. Graphics conversions of faxes can be completed 
with the Convert  Documents  command, located under the Fax 
menu, which presents the sub-menu Fax Out  and Export. 

Exporting a fax into a graphic file 
The Export command allcws you to  convert a fax file (QFXor REC 
file formats) into a Paintbrush file (.PCX) or a TIFF (.TIF) file. 
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These formats can be imported into most Graphics and paint 
applications; in  general, simple Paint programs tend to use PCX 
files, while higher end graphics programs work better with TIFF 
files. 

To convert a fax file, choose Export, which calls up the Export 
Fax dialog box. With it, double-click the appropriate file in the file 
List Box or type the file’s name in the File Name text box, clicking 
OK when finished. 

Selecting a file calls up the second Export Fax dialog box, which 
controls the aspects of the graphic file the fax is being converted 
into. The filename of the converted fax can be changed in the File 
text box. The file format (and the three letter file extension for the 
new file) is controlled with the Exporting To radio buttons. 
Converting specific pages of multipage faxes can be controlled by 
entering a specific range of pages in the Page Range area. 

Clicking Export starts the conversion, and a Status bar will inform 
you of the status of the conversion. The resulting graphic file will 
be located in the same directory as the fax file from which i t  was 
created (normally C:\QL2FAX). The Cancel discontinues the 
conversion process. 

Importing a graphic into a fax 
Normally, graphics can be faxed out by simply using FastFax from 
within the application that created the graphic itself, but graphics 
can also be converted directly into a fax file (QFX) from within 
QuickLink I1 Fax by choosing Fax Out from beneath Convert 
Documents. 

Since several graphic files can be converted a t  once, the select 
multiple files dialog box Fax Document Conversion is used. Up 
to 255 files can be converted a t  once with this dialog box; files are 
selected just like sending a fax (Refer to Chapter 2). The graphic 
formats supported include PC Paintbrush (.PCX), multiple page 
Paintbrush (.DCX), TIFF (.TIF), Windows Bitmap (.BMP), or 
MacPaint (.MAC), LaserJet print files (.PCL), Image files (.IMG), 
and CUT (.CUT) files. Graphic files convert into .QFX fax files. 
Files get saved in their original locations on your hard drive. 

After selecting the files t o  send and clicking OK, the document 
conversion window will appear during the conversion process that 
provicies status information on the conversion. 
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Fax scheduIinglBackground fax transmissions 

When faxing out, there may be occasions when you do not want to 
fax the document out immediately, perhaps because you know the 
recipient’s fax machine is only on at a certain time of the day, or 
because you want to fax during the night when telephone rates are 
lowest. If this is the case, you can Schedule your faxes to send 
later. 

Schedulingafaxis very simple. When sendingafaxfrom within the 
QuickLink I1 Fax main application, you can schedule an outgoing 
fax from the Send Fax Information dialog box. Within it, in the 
Send Fax section, you can set whether or not a fax is set to be sent 
Now or  Scheduled. If Scheduled, the time of the fax send is set by 
entering the new time (up to 24 hours in advance) in the time text 
boxes and selecting am or  pm. Clicking OK locks in the Scheduled 
send - the document will immediately convert into a QFX file 
located in the QuickLink I1 Fax install directory, ready to be faxed 
out at the scheduled time. The date and time on the cover page will 
be added as the document is actually sent, reflecting the send time, 
not the convert time. If your computer is not powered on and 
RECFAX is not loaded at the scheduled time, the fax will not send. 
However, if after the appointed time you do load RECFAX into 
memory, the Scheduled fax will start transmitting. (As per Chapter 
12, you could also type SNDFAX/IDLE at the command line and the 
Scheduledfax would send, but you would not activate the receiving 
module. 

Faxes can be Scheduled from FastFax too - simply click the 
Schedule button on the FastFax dialog box and set the time. When 
you print to  the document t o  the LaserJet 11, the document will 
convert immediately, but not be sent until the time you set. All 
Scheduled faxes get sent in the Background,  unlike when you 
send them immediately from within the Main Application (FastFax 
always sends in the background unless set otherwise). Therefore, 
if you want t o  send faxes in the backbound, Schedule them, even 
if you set the time one minute ahead. 
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Viewing the fax schedule 

The View Fax Schedule command, accessed from the Fax menu, 
allows you to see what fax transmissions are scheduled to be sent 
and at what date and time. Provided information includes Date, 
Time, Destination, Phone Number, and the number of 
Locations the document will be sent to. Unless you are broadcasting 
to a group (Refer to the next section), this will read 1. 

To remove a selected scheduled transmission, select the desired 
entry from the list and click the Remove button. To totally clear 
the schedule of faxes, click Remove All. 

Sendina the same fax to several destinations 

The ability to  send out the same fax to several destinations is called 
broadcasting, and is fully supported by QuickLink I1 Fax. The 
easiest way to broadcast a fax is to simply select more than one 
destination from the Fax Phone List by highlighting it and clicking 
the Mark  button, which will put a small icon next to it t o  indicate 
that it is on the broadcast list. You may mark as many destinations 
in the Fax Phone List as you want - clicking OK will lock the 
destinations in. Destinations can be unmarked by highlighting the 
destination and clicking Mark  again. A fax can be sent to  a whole 
Group quickly by selecting a member of a Group and clicking on 
Mark, and confirming the Group send. Clicking Mark  again will 
unmark them all. Group broadcasting is the main reason to use the 
Group field in the phone list. 

When combined with Scheduling, it is easy to send literally 
hundreds of faxes a t  night; just enter the Time in the Send Fax 
Information dialog box. 
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Manual fax receives 

Occasionally, you may want to start receiving a fax from someone 
who is already on the telephone with you, or you are connected to 
a fax-back service which will start sending you faxes after you press 
some touch-tones on your phone. If you were using a regular fax 
machine, you would probably just press the “Receive” button to 
start receiving the fax. 

QuickLink I1 Fax can accommodate you in these situations. When 
RECFAX is loaded into memory, there is a Hotkey with acts like a 
Receive button: ALT-; (that’s the ALT key and the semi-colon key 
pressed together). If you press these keys and you do not hear your 
fadmodem pick up the line and start sending “Receive Fax tones”, 
RECFAX is not loaded into memory. Note: not all farlmodems 
support the manual receive feature. 

Fax setup options 

The commands and options that customize your faxing features 
and abilities that are accessible under the Setup menu are covered 
in this section. 

Send fax setup 
The Send Fax Setup dialog box allows you to define standard 
information t o  be used during fax transmissions. The Send Fax 
Setup dialog box contains two sections; Conversion options and 
Control options. 

File Conversion Options 
The first check box tells QuickLink I1 Fax t o  Center  the Text or 
Graphic  on the fax page horizontally when converting, otherwise 
a 1 inch left marginis used; this option may not be access when 
using FastFax, since the page is sometimes determined by your 
DOS application The second option is to allow you to change 
between Normal resolution and Finernigh resolution fax modes 
when sending from within QuickLink I1 Fax - normal is the 
default resolution when this option is not selected. With normal 
resolution, QuickLink I1 Fax doubles the scaling on the vertical 
axis to allow for the differing resolution between the computer 
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graphics standards and fax standards. This scaling is not needed 
for finehigh resolution. At document conversion time, QuickLink 
I1 Fax will look to see which resolution has been selected and 
perform any scaling necessary. 

The next check box in this section, Full Page TextlGraphics,  
instructs QuickLink I1 Fax to force the page length specified in 
page layout, even if this results in blank space on a page. Otherwise, 
it will be the length ofthe text you are sending. This option may also 
not apply when using FastFax. 

The Page Layout settings allow you to specify the number of Text 
Lines per Page,  the Width of Tabs (in number of characters), 
and the Top and Bottom Margins  (in text lines). These options 
are used a t  fax conversion time. 

Control  Options 
The second section of the Send Fax Setup dialog box provides fax 
transmission control options. The first check box, Include Cover  
Page ,  provides you with the option to include a cover page with 
each fax transmission. Failure to select this option means that you 
cannot send a cover page; therefore, the default is On. 

The Delete QFX Files after send checkbox instructs QuickLink 
I1 Fax to  delete the .QFXfile after successful transmission. This can 
save a good deal of disk space. 

The Dedicate  CPU during send checkbox tells QuickLink I1 
Fax to  force the sending of fax transmissions t o  the foreground and 
in doing so dedicate your computer until the completion of the 
transmission. Any applications running in the foreground a t  the 
time a fax transmission occurs would be temporarily halted until 
the completion of the send. The default for this option is off. You 
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may find that it is necessary to turn this option on if you are 
running disk access intensive applications in the foreground, or 
you have an older or slower PC. 

The Use RTWCTS Flow Control checkbox tells what flow control 
to use when sendingafax. The defaultisRTS/CTS-ifnotchecked, 
XodXoff flow control will be used. This is provided for those 
modams that do not support RTSCTS flow control. 

The NumberofRedial attempts text box allowsyou to specify how 
many times to redial a busy fax machine before logging it as busy 
in the Send Fax Log. The Seconds between busy redial text box 
specifies the number of seconds to wai t  before attempting to  redial 
a busy fax machine. The Dial Timeout in Seconds text box 
specifies the number of seconds to wait before redialing a number 
when the modem has not responded to the dial command in the 
allocated number of seconds. This feature is very useful when 
calling foreign locations. All three of these options affect the 
foreground and background sending of faxes. 

Clicking Save saves these settings for all future sessions; OK 
closes the dialog box and puts the settings into effect immediately. 
Cancel will close the dialog box and ignore the new settings. 

Receive fax setup 
The Receive Fax Setup dialog box allows you to define standard 
information to be used during the receiving of fax transmissions. 

The Fax ID string text box allows you to specify your Fax ID. This 
string is limited to 19 characters in length. The Fax ID is a n  
identifier to the remote fax machine or fadmodem, and often 
appears in the sending fax machine’s status window. Common ID’S 
include telephone numbers, names, and business names. Note that 
some older fax machines must sense a Fax ID in all uppercase 
letters. See the Troubleshooting Appendix for more information. 

The Path for received faxes text box allows you to change where 
your incoming fax files will be saved. This setting defaults to the 
QuickLink I1 Fax install directory, normally C:\QL2FAX. The 
Dedicate CPU while receiving a fax check box tells RECFAX to 
force the receiving of fax transmissions to the foreground and in 
doing so dedicate your computer until the completion of the 
transmission. Any applications running in the foreground at the 
time an incoming fax transmission occurs would be temporarily 
halted until the completion of the receive. The default for this 
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optionisoff. Ifyou tend torunmanydiskintensiveDOSapplications 
or you have an  older or slower PC, you may want to turn this option 
on. 

The bottom half of the Receive Fax Setup dialog box provides 
special control over the loading and unloading of RECFAX, the 
Receive Fax background application. The first option None is the 
default and assumes you have loaded RECFAX prior to running 
QuickLink I1 Fax or  that  you don’t want to. The second option 
instructs QuickLink I1 Fax to  load RECFAX before loading itself. 
The final option instructs QuickLink I1 Fax to unload RECFAX 
prior to loading itself and reload RECFAXupon quitting QuickLink 
I1 Fax. Remember, if RECFAXis not loaded, you cannot receive a n  
incoming fax or send a fax in the background. 

Clicking Save saves these settings for all future sessions; OK 
closes the dialog box and puts the settings into effect immediately. 
Cancel will close the dialog box and ignore the new settings. 

Cover page setup 
The Cover Page Setup dialog box provides you with text boxes to 
be used for entering information about you and your company for 
the fax page headers and fax cover page. 

Each fax page sent with QuickLink I1 Fax (excluding the cover 
page) will include a page header with the Company name, date, 
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time and page # of the fax, assuming that information has  been 
entered in the Company Name text box. 

QuickLink I1 Fax will automatically create and send a cover page 
a t  the front of each fax transmission if the Include Cover Page 
option is checked on the Send Fax Setup dialog box. The 
Company Name is also placed a t  the top of the cover page and the 
Fax From name and phone number shown on the cover page default 
to the entries in the Fax From and Fax Number text boxes. The 
Voice contact number is also included on the cover page. 

If you wish to include a Cover Page Graphic such as  a company 
logo, enter its complete pathname or click the Select button. A file 
selection box will appear asking you for the name of the graphic logo 
or image file. This file can be either a black and white TIF or PCX 
file or Monochrome Bitmap file (BMP) with a resolution no greater 
than 200 DPI. Once you select the file, the name will appear next 
to the Cover Page Graphic field. When you press OK, a conversion 
box will appear while the selected file is converted to a form usable 
as  your cover page graphic. Once this is done, the graphic will be 
a t  the top of each cover page you fax out. 

Clicking Save saves these settings for all future sessions; OK 
closes the dialog box and puts the settings into effect immediately. 
Cancel will close the dialog box and ignore the new settings. 

PCL font setup 
The PCL Font Setup dialog box allows you to specify the default 
font to  be used for PCL file conversion by QuickLink I1 Fax and 
FastFax (in some cases, depending on the printing DOS application). 
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This is the font that will be used if the application that created the 
PCL 4 file does not specify a font. 

You can also define two custom fonts that  can control what the 
output will look like. If you highlight one of the user defined fonts, 
you can click Edit to enter your own printer commands. Consult 
your HP LaserJet I1 manual for the desired results. 

The first check box, Use selected defaul t  font,  allows you to turn 
on and off the default font. If no font is specified, a Courier 12 point 
font will be used for text. This font will only be used ifthe document 
you are printing has not specified a font and has not issued a printer 
reset command. The second check box, Treat TEXT files as PCL 
files, allows you to convert any ASCII text document and have 
LaserJet results. When selecting a text document to fax or view, 
instead of the file type of TEXT, PCL is used. 
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Chapter 10 
DataComm Overview 

Chapter 10 describes how to call another modem or BBS for a Data 
Communications connection and how to upload (send) and 
download (receive) files to and from remote systems. The commands 
used for data communications are in the Connect menu. Topics 
include: 

Calling a BBS (Bulletin Board System) or other modem 
How to use the Data Phone Book 
Uploading a file 
Downloading a file 
How to capture the text of an online session to a text file on disk 
How to clear the screen 
How t o  review what has  scrolled up past the screen 
How to print every line a s  it transmits to your screen 
How to print a text file 
How to answer a Data call 
A brief description of the transfer protocols available 

Chapter 10 also explains the configurable settings under the Setup 
menu for data communications. 

Originating a data call (dialing out) 

There are two ways to dial out for a Data Comm connection: a quick 
Dial, or accessing the Connect Phone List. 

Quicklv dialina a number 
The great majority of data communications sessions will begin with 
you dialing out to another modem, BBS, or online service. The 
quickest way to do this is by simply dialing the modem with the 
Dial command from the Connect menu, which brings up the 
Dialer dialog box. From this box, the telephone number can be 
entered in to the Number to dial field and dialed. Clicking Dial 
starts dialing, calling up a dialog box which displays the status of 
the dial. 
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Usina the Data Phone List 
Choosing Data Phone List from the Connect menu brings up the 
Data Phone List dialog box, allowing access to a datacom telephone 
book of all your frequently dialed data numbers -its quick key is 
ALT-P. You’ll find that it is accessed almost exactly like the Fax 
Phone List. 

Choose it now, and you will find that there is already an entry in 
the list: American E-Mail. American E-Mail is Smith Micro 
Software’s BBS; you are invited to use this system to test the data 
portion of QuickLink I1 Fax. There is no charge for using our 
system, other than the long distance charges from your telephone 
company for dialing the 714 area code (The 714 area code connects 
to Southern California). To dial any number as it appears in the 
Data Phone List, highlight the entry by clicking on i t  and click on 
the Dial button. The Add and Remove buttons allow you to 
respectively add and delete Data Phone List entries - Sort allows 
you to soft the list by number or alphabetically. 

To edit an  entry in the Data Phone List, highlight the entry and 
click the Edit button. Highlight the American E-Mail entry and 
click the Edit button now. This brings up the Phone List Entry 
dialog box, where every aspect of an  entry can be changed. To 
change the Name or Number of an entry, just click in the 
appropriate text box and type in the new entry. Notice that 
parentheses, spaces and dashes are acceptable in the telephone 
number -a  comma will create a 2 second pause in dialing. If you 
are calling from the 714 area code, be sure to  delete the 1-714 from 
the Number field. 
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The other fields deal with the more technical aspects of the 
connection, such as the Baud rate, Tenninal type, and line 
settings. While there is no set standard terminal type and line 
setting combination for every modem connection, there are some 
guidelines to follow which may be helpful. 

Set the Baud Rate to the highest your modem will support, or 
to 2400 if you are getting bad connections. When you dial the 
other modem, the two modems will establish the highest 
connection speed possible automatically so long a s  the Autobaud 
feature is turned on (The default setting for Autobaud is On. 
Refer to later this Chapter), otherwise, the baud rate is 
determined by the caller. 

Small systems (BBS’s) tend to  use the ANSI terminal type with 
8 data bits, no parity, and one stop bit (8-N-1 for short). 

Large installations (such a s  mainframes and online services 
like GEnie and CompuServe) tend to use the VTlOO terminal 
type with 7 data bits, even parity, and 1 stop bit (summarized 
by 7-E-1). 

Two people connecting their PC’s together via modem should 
try the TTY terminal type with 8-N-1. You may also need to 
turn on Local Echo and both CR/LF checkboxes in the Terminal 
Options dialog box, covered later this Chapter. 

Other than the area code in the telephone number, all the settings 
for the American E-Mail entry are correct. Click OK to leave the 
Edit dialog box and click Dial to dial our BBS. 

Once connected t o  our American E-Mail system, follow the prompts 
to create a new user account. You will be prompted a t  every step 
and must create a password of your own choosing to enter the 
system for future online sessions. When connected t o  our system, 
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you may upload and download public domain and utility files and 
programs, visit the Online Software Store, or get online technical 
support. All selections are menu driven; when in doubt enter a 
Question Mark (?)for help. To disconnect from our (or any) system, 
pull down the Connect menu and choose Hangup. 

File transfers 

Unlike faxing, file transfers do not happen automatically; there is 
a good deal of preparation to consider. Fortunately, QuickLink I1 
Fax makes the procedure as intuitive as possible. 

The concept of file transfers 
Before getting into the specifics of file transfers, an outline of the 
concept of uploading and downloading should be very helpful to 
those users who have never transferred files before. The general 
process is something like this: 

1. 

2. 

3. 

4. 

5. 

6. 

Connect with the other modem or system (covered in the 
previous sections). Make sure that you can both type to the 
screen so the other end can understand you and vice versa. 

Tell the other side that you are interested in file transfers. 

Tell the other side what file(s) you want or what file(s) they 
should expect from you. 

Tell the other side what transfer protocol to use (for a discussion 
on the differences between the protocols, refer to the next 
section). 

When the other side says they are ready, pull down the File 
menu and choose Send File or Receive File, and choose the 
protocol you told the other side to expect. 

If sending, choose the file(s1 you want to send and click OK the 
transfer begins. If receiving using Xmodem (of any type) o r  
ASCII protocols, type the name of the file you want to receive 
and click OK; for all other protocols just click OK and the 
transfer begins. 

With this in mind, QuickLink I1 Fax file transfers will make a lot 
more sense. 
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Selecting one file to upload 
The ASCII, Xmodem, Xmodem CRC, and Xmodem 1K protocols let 
you upload only one file per transmission. When you select sending 
by one of these protocols, the Send Single File dialog box appears 
with the selected protocol as the title. 

To send a file, enter the complete path of the file you want to upload. 
For example, to upload the file SALARY.DOC from the WP51 
subdirectory on your computer's C:\ drive,  type: 
C:\WP51\SALARY.DOC and click OK. 

OR 

Use the list box to scroll through the subdirectories on your Pc's 
hard drive and select the file from the list box by double-clicking on 
it, clicking OK when selected. This starts the transfer and calls up 
the Send File dialog box. 

Selecting multiple files to upload 
The KermitISuperKermit, Ymodem, Ymodem-G and Zmodem 
protocols let you upload more than one file during the same 
transmission. In addition t o  sending a batch of files, one file may 
also be sent by itself. The main advantage of sending one file with 
one of these protocols is that the other end need not type in a file 
name, as the file name is included with the transfer using these 
protocols. If you select one of these protocols, the Send Multiple 
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Files dialog box appears with the selected protocol as the title. This 
dialog box works similarly to the Send Fax dialog box. 

If you want to upload files from the current path, shown at the top 
of the list box, enter the file name in the File Name text box and click 
Add. Otherwise, enter the complete path of the file you want to 
upload. For example, to  upload the file SALAFtY.DOC from the 
WP51 subdirectory on your computer’s C drive,  type: 
C:\WP5l\SALARY..DOC and click OK. 

OR 

Use the list box to scroll through the subdirectories on your PC’s 
hard drive and select the files from the Files Available list box, 
clicking ADD to add the file to the Files Selected list box. Repeat 
this for every file you want to add to the batch send. If you change 
your mind about sending one of the files, highlight it in the Files 
Selected list box and click Remove, The selected file is removed 
from the list box and will not be sent. When the list offiles selected 
is complete, click the OK button, which begins the transfer and 
calls up the Send File dialog box. 

The Send File status box 
The Send File dialog box keeps you informed of the status of the 
upload. I t  displays the following information: 

Protocol displays which protocol is being used for the current 
transmission. 
File Name displays the name of the current file being 
transferred. 
File Size displays the size of the current file being transferred. 
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Bytes Sent displays the number of bytes sent. 
Status shows the current status of the upload. For example, 
Sending data appears when data is being sent to the remote 
system. 

The whole transfer can be stopped by clicking the Cancel button. 
When the transfer is finished, a dialog box will appear to alert you, 
and the computer will beep. Clicking OK removes the dialog box. 

Downloading files 
Receivingfiles works much like sending a file and actually involves 
less steps. The biggest issue is determining what protocol is being 
used and how many files are being sent to you. 

Receiving one file 
The ASCII, Xmodem, Xmodem CRC, and Xmodem 1K protocols let 
you download only one file per transmission. When you select 
receiving by one of these protocols, the Receive Single File dialog 
box appears with the selected protocol as the title. 

At this point, QuickLink I1 Fax needs a file name to save the file 
under. To receive the file, enter the complete path of the file you 
want to download. For example, to download the file PIC!I’URE.BMP 
to the WINDOWS subdirectory on your computer’s C:\ drive, type: 
C:\WINDOWS\PICTURE.BMP and click OK. 

OR 
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Use the list box to scroll through the subdirectories on your Pc's 
hard drive and type in the file's name in the File Name text box, 
clicking OK done. This starts the transfer and calls up the Receive 
File dialog box. 

Receiving a batch of files 
The KermitJSuperKermit, Ymodem, Ymodem-G, and Zmodem 
protocols let you download more than one file during the same 
transmission. In addition to receiving a batch of files, one file may 
also be received by itself. The main advantage of receiving one file 
with one of these protocols is that the file name is included with the 
transfer using these protocols, so it is impossible for files to be 
named incorrectly. 

When you use one of these protocols, the path selection dialog box 
appears with the selected protocol as the title. This dialog box works 
similarly with the files selection dialog box, except that  there is no 
need to type a file name, and is used to specify the directoru where 
you want the files to be copied to. Another directory can be selected 
with the list box or typed in directly, and clicking OK initiates the 
transfer and calls up the Receive File dialog box. 

The Receive File status box 
The Receive File dialog box keeps you informed of the status of the 
download. It displays the following information: 

Protocol displays which protocol is being used for the current 
transmission. 
File Name displays the name of the current file being 
transferred. 
File Size displays the size of the current file being transferred. 
(Batch protocol only) 
Bytes Received displays the number of bytes sent 
Status shows the current status of the upload. For example, 
Receiving data appears when data is being received from the 
remote system. 

The whole transfer may be stopped by clicking the Cancel button. 
When the transfer is finished, a dialog box will appear to alert you, 
and the computer will beep. Clicking OK removes the dialog box. 
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CaDture text 

If you know in advance that you want to capture the text that 
appears on screen, QuickLink I1 Fax can be set to make a copy of 
everything you see and save it into a text file on your computer’s 
hard disk. 

To capture text, pull down the File menu and choose Capture 
Text, which callsup the CaptureText dialog box. The Capture Text 
dialog box works just like the Receive Single File dialog box; type 
a name for the file to save the captured text in the File Name field 
and click OK to begin capturing. You can select another directory 
with the list box. 

You can double-check that QuickLink I1 Fax is indeed capturing 
text by pulling down the File menu; when there is a checkmark 
next to Capture Text, text is being captured. Choosing Capture 
Text again will stop the capture and close the file, making the 
checkmark disappear. Capture Text has nothing to do with 
receiving faxes or fcrxing. 

~~ ~~ 

Clearing the screen ~ 

Choosing Clear Screen from the Edit menu will clear the terminal 
window of its text. This command will not affect the connection to 
the remote system. 
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Line Buffer 

The Line Buffer command from the Edit menu is used to view 
data that has scrolled out ofview on the Terminal Window. The line 
buffer will hold up to 200 lines of information which includes those 
lines presently in view. If you need to capture more than 200 lines 
of text, use the Capture Text function on the File menu. 

Choosing Line Buffer will cause the menu bar to change, and the 
Diamond, File, and Edit menus of the QuickLink I1 Fax Text 
Editor will appear. The menu bar will show that you are currently 
viewing the line buffer. Use the up and down arrow keys on you 
keyboard to scroll the Line Buffer. When you are finished looking 
at the Line Buffer, press the ESCAPE key or type Alt-R to exit the 
Line Buffer and return to  the QuickLink I1 Fax main application. 

Toggle Printer 

The Toggle Printer function, located in the File menu, allows 
you to print information directly to your printer as it is received 
from your modem and displayed on the screen. You can verify that 
this option is turned on pulling down the File menu again - a 
check mark next to the menu listing indicates the printer is 
currently toggled on. You should only use this option with a 
buffered printer. Printing directly to  your printer may also 
degrade the speed of displaying information on your monitor. 
Choosing Toggle Printer a second time will turn the function off. 

Printing Text Files 

Choosing Print File from the File menu calls up a dialog box 
which permits you to print ASCII text files directly to your selected 
printer. This is useful to print files created within the QuickLink 
I1 Fax text editor or files created with the Capture Text option. This 
command will not print faxes - only text files. 

~~ 

Answering a data call 

Answering a call is almost totally automatic and handled by 
RECFAX if loaded - if RECFAX isn’t loaded, the call gets 
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automatically answered on the number of rings set in the Modem 
Setup dialog box (Refer t o  later this Chapter). RECFAX's default 
settings will let it listen to the incoming call t o  determine what it 
is: either fax, data, or voice. Ifi t  is a modeddata  call, RECFAX will 
seamlessly pas s  t h e  call into t h e  QuickLink I1 Fax  
telecommunications mode. You must always be within the QuickLink 
ZZ main application to receive a datacomm call. Typing ATA and 
then the ENTER key in the terminal window will also force the 
modem to pick up the line and answer the call. 

Strictly speaking, the SO register can be set to the number of rings 
you want the modem to answer the phone, but this will conflict with 
RECFAX's operation and bypass the Number of Rings to Answer 
Phone field in the Modem Se tup  dialog box. You are strongly 
urged not to  change the SO register in the Init string. If you do, be 
sure to  change it back to  SO=O t o  receive faxes. 

Protocols 

This section describes the various protocols that QuickLink I1 Fax 
provides for uploading and downloading data files. 

ASCII 
The ASCII protocol (pronounced asky) is a seven-bit protocol that 
consists of the 128 characters that make up the upper- and lower- 
case alphabet, numbers, characters available on a standard 
keyboard, and certain special control characters. 

The ASCII protocol has  no error-checking capabilities. ASCII 
protocol uses XONKOFF handshaking and required XONKOFF 
flow control to be enabled a t  both communicating devices. By 
default, QuickLink I1 Fax has  XONiXOFF flow control disabled. 
When the computer receiving data needs to  stop the data 
transmission temporarily to process the received data, it sends a 
Ctrl-S ("SI character to stop the sending computer from sending 
data. When the receiving computer has processed the received data 
and is ready to accept more, it sends the sending computer a Ctrl- 
Q ("Q) character to  resume data transmission. 

Since there are no additional error checking characters sent during 
the transmission, ASCII is good for sending a burst transmission of 
raw textJdata uninterrupted. 

- 
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COmplJSetVe BIB+ (Available with selected versions) 

The CompuServe B/B+ protocol should be used when communicating 
with CompuServe. 

KermitlSuper Kermit 
QuickLink I1 Fax provides both the standard Kermit as well as the 
powerful Super Kermit (Windowed Kermit) protocol. It was 
developed to meet the needs for file transfer between a number of 
different types of computers, including mainframes, mini computers 
and personal computers. Unlike Xmodem and Ymodem, Kermit 
uses variable packet sizes, with a maximum size of 1024 bytes. Like 
Ymodem, Kermit provides for batch file transfers. 

SuperKermit is especially useful when transferring data over data 
networks such a s  Telenet or Tymnet. These networks have long 
communications delays tha t  can significantly degrade the 
performance of file transfers. For each packet transmitted, two 
communications delays will be interjected into the transfer. Super 
Kermit addresses this problem by sending multiple packets at one 
time, also known as a transmission window. All error correction is 
still performed, however the  receiving computer does not 
acknowledge the receipt of the data or asks for re-transmission of 
any bad packetsuntil all packets in the window have been received. 
This process results in a dramatic reduction in the delay time. 

Of the public services, only CompuServe supports Kermit. If you 
select Super Kermit and the remote computer only supports Kermit, 
QuickLink I1 Fax will drop back to Kermit. 

Xmodem 
QuickLink I1 Fax provides three different Xmodem protocols: 
Xmodem lK, Xmodem CRC and the original Xmodem (also called 
Modem7 or Xmodem Checksum or Christenson). 

I n  order for Xmodem to work, the data format must be set to  8 data 
bits, 1 stop bit, and no parity. Ifyou did not begin the communications 
session with this setting, QuickLink I1 Fax will automatically 
correct this for you. Xmodem Checksum sends the data in packets 
off 128 bytes. Thereforea lKfile (1,024 bytes) would be transmitted 
in 8 data packets. A simple data checksum is added to each packed 
and is checked on the receiving end of the transfer. If the receiving 
Xmodem detects a bad packet, it can request the packet again 
giving a good level of error recovery. 
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Xmodem CRC 
In an effort to guard against undetected errors the original Xmodem 
was enhanced by replacing the 8 bit checksum with a 16 bit Cyclic 
Redundancy Check (CRC). This change provides a 99.9984% 
assurance ofdetecting any transmission errors. With the checksum 
method, it is possible for 1 out of 256 bad packets to  have a valid 
checksum, and thus go undetected. With the CRC method only 1 
out of 700 billion bad packets will generate a valid CRC. The CRC 
method also transmits 128 byte blocks or packets of data. If you 
select Xmodem CRC and the other system does not support it, 
QuickLink I1 Fax will automatically switch over t o  the standard 
Xmodem; t o  the user both methods appear to operate identically. 

Xmodem 1 K 
This method ofXmodem replaces the original 128 byte packets with 
packets of 1,024 bytes when possible. Assuming that no transmission 
errors are detected, this method ofXmodem will enlarge the packet 
size to 1K and maintain that packet size for as long a s  possible. 
Enlarging the packet size will improve the speed ofthe file transfer. 
Ifyou attempt to receive a file usingxmodem 1K and the other side 
only supports Xmodem CRC, QuickLink I1 Fax will fall back to  
Xmodem CRC. 

Ymodem 
The Ymodem protocol (also called Ymodem Batch, Ymodem lK, 
and Ymodem CRC elsewhere) is very similar to the Xmodem lK, 
with two major differences - with Ymodem you can automatically 
receive or send multiple files in one session, and file names are  
included with the transfer. In general, Ymodem is very fast and 
very safe and preferable to Xmodem, even for single files. 

Y modem-(; 
Ymodem-G is a file transfer protocol that provides the same error 
checking as Ymodem, but it will not perform any error checking. 
Therefore, Ymodem requires an error-correcting modem or fax/ 
modem with either MNP 2-4 andfor V.42. If both ends of the 
transmission meet the requirements, transfers will be exceptionally 
fast. 
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Zrnodem [Available with selected versions) 

The Zmodem protocol is a new and popular protocol that lets you 
send multiple files in one transfer. Features include automatic 
downloading and the ability to send file names, sizes, and creation 
dates of each file. Also, if a data transmission is interrupted 
midway, Zmodem lets you resume the data transmission from the 
point where it let off. 

The s u e  of the data block varies with Zmodem, depending on the 
condition of the connection of the telephone line between the 
communicating devices. Moveover, both 32-bit and 16-bit CRC 
errror-checking are available with Zmodem. 

Zmodem is a relatively young transfer protocol, not identically 
implemented a t  various sites. If you are having problems with 
Zmodem protocols, try Ymodem or Xmodem. 

Data communications setup options 

In addition to  permitting QuickLink I1 Fax to communicate with 
the myriad of standard data communication configurations, the 
Setup menu contains the options to customize QuickLink I1 Fax to 
your system. 

Line settings 
Choosing Line Settings from the Setup menu causes the Line 
Settings dialog box to appear. This dialog box allows you to select 
the line speed and data format; these settings are independent of 
the settingsin the Dataphone List, but the same general guidelines 
for setting them apply (Refer to the Data Phone List section for 
more information). Clicking Save saves these settingsfor all future 
sessions; OK closes the dialog box and puts the settings into effect 
immediately. Cancel will close the dialog box and ignore the new 
settings. 
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Baud Rate 
Possible baud rate settings may vary from 300 baud to 115,200 
baud. The default speed is 2400 baud for most modems. Refer to 
your modem manual for the maximum baud rate that  your modem 
will handle. 

Data bits 
The allowable options are 7 or 8 data bits - the default setting is 
8 data bits. 

Parity 
Parity may be Odd, Even, or None. None only applies only when 
8 data bits are selected. The default setting is no panty. 

Stop bits 
The allowable settings are 1 or 2. The default setting is 1 stop bit. 

Modem setup 
The Modem Setup dialog box provides you with the ability to 
define the modem Initialization, Dial, and Hang up strings. 
This dialog box also allows you to  set the COM port that the modem 
will use and define key information t o  be used by RECFAX for 
answering incoming calls. 

Clicking Save saves these settings for all future sessions; OK 
closes the dialog box and puts the settings into effect immediately. 
Cancel will close the dialog box and ignore the new settings. 

Initialization String 
The modem initialization string is the command set that QuickLink 
I1 Fax issues t o  the modem when the application is first started. The 
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default string works with most modems and fadmodems. If your 
modem has special features or commands, the AT commands 
needed to enable them are entered here. Check your modem 
manual for a detailed breakdown of the AT command set. An 
abbreviated set is listed in Appendix C. 

Dial String 
The Dial string is the command QuickLink I1 Fax issues to the 
modem when instructed to dial a number. This event occurs when 
dialing from the Data Phone List, using the Dialer, sending a fax, 
or connecting to either CompuServe, Dow Jones or GEnie. 

Hangup String 
The h a n y p  string is the command QuickLink I1 Fax issues t o  the 
modem when the H a n y p  command is chosen from the Connect 
menu. This string is pre-set to  ATH, which is the AT command to 
h a n y p  the modem. 

Dial Pref idSufEx 
The dial Prefix/Suffix strings are appended to the beginning and 
end of the telephone number when dialing. These strings are handy 
when you need to  dial using credit card, or for long distance 
telephone access, o r  for dialing a digit to get an outside line. For 
example, ifyou need to  dial a 9 to  dial out of an office building, enter 
a 9 and a comma (,I in the Dial prefix (a comma is a 2 second pause). 

Number  of rings to answer phone 
QuickLink I1 Fax will pick up the line and answer the phone on the 
number of rings specified in the Answer on field. Setting this 
number t o  0 will keep RECFAX and QuickLink I1 Fax from 
answering calls. Some modems will answer 1 to 2 rings after the 
number specified due t o  the hardware. The default is 1. 

, 

Answer Mode 
This entry asks under what circumstances you want QuickLink I1 
Fax to answer the telephone. Fax only tells RECFAX to process fax 
calls only and hangup on all others-if RECFAXis not loaded, your 
fadmodem will pick up the phone only when the main application 
is running. With Data only selected, QuickLink I1 Fax will handle 
data calls and hang up on fax or voice calls. Auto Detect instructs 
RECFMQuickLink I1 Fax to answer all calls; with Auto Detect 
selected RECFAX will receive fax transmissions, transfer data calls 
automatically to  the QuickLink I1 Fax main application, o r  display 
a message that a voice call is waiting and provide a limited amount 
of time to respond prior t o  h a n y p  (some modems are not capable 
of Automatically Detecting the line). 
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Modem PodOption 
These radio buttons allow you to manually set your COM port for 
your fadmodem. It is normally configured when you run QuickLink 
I1 Fax for the first time. 

Clicking the Option button allows you to set a custom configuration 
for your fadmodem’s IRQ and COM port Address. The IRQ 
setting must always match what you have set on your hardware; 
simply setting the IRQ here will not change the IRQ. For a more 
complete of IRQ‘s refer to Appendix C. 

Look for modem “RING” 
Most modems, when they sense an incoming call, send both a word 
RING to the screen, as well as send a special ring signal through 
one of the leads in the cable or to the COM port. Some modems, 
however, don’t do both of these, and as such, wont be able to let 
RECFAX or QuickLink I1 Fax know that a call is, in fact, ringing 
through. This check box tells the program what indicator to look 
for. 

Redial on “NO CARRIER” 
Some modems are incapable of detecting a BUSY signal when the 
person you are calling has  a busy line, and instead report NO 
CARRIER. Also, some overseas locations simply don’t have a busy 
signal that  sounds anything like that of North American locations. 
This check box tells the program to assume that a NO CARRIER 
message is resulting from a busy signal. 
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Terminal options 
The Terminal Options dialog box allows you to set the terminal 
attributes you want QuickLink I1 Fax to use. A number of check 
boxes are provided to turn options on or off. 

Local echo 
The Local echo option tells QuickLink I1 Fax to display all keyboard 
entries directly to the terminal window rather than letting the 
remote computer echo the keystrokes back as is normal. If you 
cannot see what you type, turn this option on. If characters appear 
double, (Iliikkee tthhiiss) turn this option off. Some telecom 
programs call this setting “Duplex/Half-Duplex”. 
Change CR to CR/LF 
These options tells QuickLink I1 Fax to translate all outgoing and/ 
or incoming Carriage Returns to Carriage Return + Line Feed. If 
incoming or outgoing lines are overwriting each other, turn the 
option on. 

Line wrap 
This option issues a carriage return + line feed if more than 80 
characters are transmitted on a single line. 

Destructive backspace 
This option instructs QuickLink I1 Fax to erase a character when 
the backspace key is pressed. When this option is ~ ? f .  selected, 
pressing the backspace key will move the cursor back one character 
but will not erase the character that may be above the cursor. 
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Flow control 
Flow Control is the process of telling each computer to stop sending 
data and starting it again. This provides time to process the data 
received. Flow control is usually not needed for 2400 baud data 
connections. 

Xon/Xoff is a software flow control that  involves the sending of 
special control codes as part  of the data. It is usually necessary for 
ASCII file transfers. Hardware flow control (RTS/CTS) is 
implemented in both software and the modem hardware, therefore 
your modem must support the RTSCTS standard for this method 
to be used. The RTSCTS method is more reliable and is necessary 
for use with modems equipped with V.42N.42bis and MNP Level 5.  
The default setting is none. 

Smart mode 
Selecting Redial on busy tells QuickLink I1 Fax to perform a n  
auto-redial when your modem detects a busy signal. Selecting 
Autobaud tells QuickLink I1 Fax to automatically reset the baud 
rate if the modem answers a call and makes a connection at a rate 
other than the rate specified a t  dialing. Smart Mode options apply 
at any time QuickLink I1 Fax dials the modem, such as when using 
the Dialer, Phone List, executing a Script Dial Statement, or 
connecting to CompuServe, Dow Jones or GEnie. You must also 
have an AT Command set compatible modem that detects and 
displays the connection baud rate. English responses must be set 
on. 

Terminal Emulation 
The Current Emulator list box allows you to change the emulation 
by providing you with an emulator list. QuickLink I1 Fax supports 
Teletype Ct"lY), Dec VT102, Dec VT100, Dec VT52 and ANSI 
terminal emulation. Terminal emulation is the ability of QuickLink 
I1 Fax to make your PC look like a specific type of terminal to a 
remote computer. In performing this task QuickLink I1 Fax 
translates the remote computers special instructions for such 
things as screen cursor positioning, display color and texvgraphics 
display. 

V T l O O  / VT102 setup 
The Edit button allowsfor additional settingsfor theVT100NT102 
emulation modes. By selecting the Edit button the VT100/102 
Setup dialog box will appear. 
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You should take special care in not changing the default settings 
unless you are certain that the host application absolutely requires 
a change. The default settings have been set to the most commonly 
used values. Altering options such as the Tab Stops may cause host 
applications to  not operate properly on your terminal. The following 
options are found on the VT100NT102 Terminal Setup: 

New line mode 
With this option off, a Return generates a carriage return. A 
linefeed (LF) moves the cursor t o  the next line maintaining the 
current column position. With this option on, a Return generates a 
carriage return and a linefeed. A linefeed moves the cursor to the 
left margin of the next line. 

Wraparound mode 
When this option is not checked, characters transmitted beyond the 
79th character get printed on top of each other at the 80th column. 
When checked, these additional characters will get printed on the 
next line. 

Underline color 
This list box allows you to  select the current color that  QuickLink 
I1 Fax will display text in when the remote system underlines it 
locally. 

Tabs Stops 
Up to 10 tab positions may be entered in the tab text box. Each tab 
position entry must be separated from the next entry by a space. 

Answerback message 
The text box contains a 1 to 20 character message that will be 
transmitted upon computer request or operator command. 

Clicking Save saves these settings for all future sessions; OK 
closes the dialog box and puts the settings into effect immediately. 
Cancel will close the dialog box and ignore the new settings. 

Refer to Appendix Afor additional information on the QuickLink I1 
Fax implementation of the VT100/102 keypad and other special 
VT100/102 keys. The appendix lists the PC key equivalents 
established by QuickLink I1 Fax to  emulate the VT100/102 keyboard. 

Connection Setup 
The Connection Setup dialog is only present when using a Class 
1 fax/modem. Furthermore i t  is only accessible for selected Class 
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1 fadmodems that require the software to assist in implementing 
V.42N.42bidMNP error correction. To allow you to change the 
modem connection settings, QuickLink I1 Fax include's the 
Connection Setup dialog box. This dialog box lets the user set 
various connection parameters. 

Protocol type 
This option group enables you to select the protocol at which the 
software will attempt connection. V.42 Auto-reliable means that 
the software will first attempt a V.42 connection, then try a MNP 
connection, then attempt speed matching if the others fail to 
connect. V.42 Reliable means that the software will attempt to 
make a V.42 connection. If noV.42 connection is made the software 
will h a n y p .  MNP only is a similar option, but will attempt to 
make only a MNP connection. The None selection will make a 
normal modem connection without error correction. 

V.42bis Type 
This option group only affects connections made with V.42. This 
option tells QuickLink I1 Fax how to use V.42bis. The default data 
compression is in both directions. 

M N p  5 compression 
This check box affetts only MNP data connections. When this 
option is checked MNP class 5 data compression will be enabled. 

Inactivity time 
The last option is a connection inactivity time limit. If you wish a 
connection to be automatically terminated after a set number of 
seconds of inactivity, type in the number of seconds in this edit box. 
The default is 0, which turns this feature off. This feature, if 
enabled, will only affect V.42 and MNP connections. 

The Connection Setup dialog box only affects incoming and 
outgoing data call connection, and outgoing connections dialed 
with the Dialer. For entries in the Phone List, there is a separate 
setup for each Phone List entry. When you add a Phone List entry, 
there will be a Connection Type button in the Entry Screen. 
Clicking this button gives you a setup box similar to that displayed 
above, but the options you select here will only take affect when the 
selected number from the Phone List is dialed. 

Clicking Save saves these settings for all future sessions; OK 
closes the dialog box and puts the settings into effect immediately. 
Cancel will close the dialog box and ignore the new settings. 
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Color Setup 
The Color Setup function provides you with the capability to 
adjust the foreground, background and high light colors used if you 
have a CGA, EGA or VGA graphics adapter and a color monitor. If 
you have a monochrome adapter and monitor this function will not 
be operational. 

Upon selecting the Color Setup function you will have the Color 
Setup dialog box displayed. The three scroll bars a t  the top of the 
dialog box are used to select the Foreground, Background and 
Hi-Lighted colors. The Sample Window in the lower right 
portion of the dialog box will display the colors a s  selected. The 
Save button will record the new colors selected. The OK button 
will accept any color changes and remove the dialog box from the 
screen. The Default button will cause the default colors to be 
restored. The Cancel button will disregard any color changes and 
remove the dialog box. The Help button will cause the Help 
Window to be displayed. 

Hardware Setm 
The Hardware Setup function allows you to set the printer port 
to be used by QuickLink I1 Fax and to change the monitor type from 
Color (CGA, EGA or VGA) to Black and White (Monochrome) o r  
Liquid Crystal Display (LCD). Additionally, you can select graphic 
printer driver used for printing incoming fax transmissions. It is 
important to note that your printer must have graphic printing 
capabilities. You must select the correct printer driver in order to 
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ensure that your printed fax transmissions can be easily read and 
are printed with the correct proportions. 

The first set of Hardware Setup selections allows you to select the 
Printer Port to which your printer is selected. The default setting 
is LPT1:. The second set of options allows you to change the 
Monitor Type. This setting is initially set the first time you run 
QuickLink I1 Fax after installation. If you cannot easily see all of 
the colors on your computer screen, first try to change the color mix 
by selecting the Color Setup function on the Setup menu. If this 
does not correct your problem change the Monitor Type from Color 
to B&W (monochrome). If you are using a monochrome screen with 
a standard monochrome adapter, QuickLink I1 Fax will not allow 
you to change the monitor type to Color. The LCD Uiquid crystal 
display) option is provided primarily for laptop computer users. 

The next part of Hardware Setup allows you to specify the type of 
printer you have by picking the appropriate graphic printer driver. 
This driver is used for printing fax transmissions. To select the 
printer driver select the Type button and a scroll box will appear 
listing all the drivers provided. If you do not find a driver for your 
printer, you may find that you can use the generic 9 pin or 24 pin 
drivers. You may need t o  experiment with this selection, or call 
your printer manufacturer to see ifyour printer emulates a printer 
on the list. This dialog box also allows you to specify at which 
resolution you will print fax documents. Normal quality is the 
default selection and will give good results on most printers. Ifyou 
wish to print at a higher resolution on you printer, select High 
quality. If you wish to print your fax documents more quickly and 
quality is not as important, select the Draft option. When printing 
faxes, a fax page is normally compressed vertically to fit on a 
standard sheet ofletter size paper. Checking Actual size printing 
of faxes will force the printing of faxes a t  their actual size, 
regardless of the length. When you are satisfied with these settings, 
click the Select button to accept these changes. 
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Chapter 11 
Automating QuickLink II Fax 

QuickLink I1 Fax has  several advanced features which can make 
your online communications sessions quicker and easier to manage 
by automating various functions. Chapter 11 describes these 
features: 

Macro Keys 
Logging on t o  online services automatically 

Scripts and the scripting language 

~~~~~ ~~ ~ ~ ~ 

Online services quick access 

QuickLink I1 Fax can quickly connect you to your accounts on the 
major online services. Before it can do this, however, you must set 
QuickLink I1 Fax with the proper information. When configured, 
you can connect to Dow Jones, CompuServe, and GEnie with just 
one mouse click. 

Services setup 
Services Setup, accessed from the Setup menu, allows you to 
specify account information for the Dow Jones, CompuServe, and 
GEnie online services. Choosing Services from the Setup menu 
calls the a sub-menu, allowing you to set the Network Numbers 
and Account Information. This is where the actual account 
information is keyed into QuickLink I1 Fax. 

Network numbers 
Enter the local telephone numbers in  the appropriate text boxesfor 
accessing the Telenet, Tymnet and CompuServe’s or GE’s own 
networks. Use a comma to cause a 2 second delay in dialing when 
needed, as when switching to an outside line when using an 
internal phone system. Click the Save button to permanently store 
the updated telephone numbers to disk. 
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Account information 
Enter the applicable account and password information to be used 
for connecting to each service. Leave blank the information for 
unused services. Select the network to be used for accessing each 
of the services. 

The Save button accepts all changes, and saves the new services 
information. The OK button accepts the changes and removes the 
dialog box from the screen. The Cancel button removes the dialog 
box but does not apply any changes. 

Connecting to online services 
Once the account information is keyed in, simply pulling down the 
Connect menu and selecting the appropriate Online Service will 
automatically dial your modem, log you in, and enter your password. 

Macro kevs 

The Macro Keys function allows you t o  define a custom meaning 
or sequence of keystrokes t o  the selection of function keys, F1 
through F10. These Macro Keys can cause a user defined literal 
string (series of characters) to be transmitted or they can be used 
to launch a script file. 

Choosing Macro Keys from the Setup menu brings up a sub- 
menu: Set 1 and Set 2. The first 5 function keys are set from Set 
1, the last 5 from Set 2; choosing one calls the matching Macro Key 
definition dialog box, which allows you to enter a literal string you 
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want transmitted when each of the function keys are depressed, or 
to specify a Script file name if you want a script file launched when 
the function key is pressed. If you wish the edit field to contain a 
script file name, check the Script checkbox next to the edit field and 
a type the filename of the script file. The text box may contain either 
a literal string or a script file name, but not both. In  the example 
below, note that the definition for F1 is defined as a literal string 
while the definition of F2 is a Script File. Additionally the "\r" in  
the definition for F1, instructs QuickLink I1 Fax to send a Carriage 
Return after typing out the characters. Clicking Save saves the 
macro keys for future sessions. For more information on Scripts, 
refer to the next section. 

ScriDts 

Scripts are miniature programs-within-a-program, and can totally 
automate your online sessions (the Online Services module of 
QuickLink I1 Fax is actually a script file, for example). Properly 
programmed, a script can call a BBS, logon to it, and automatically 
readyour mail, and logout, all by pressinga singlekey. This section 
describes how t o  run and write scripts. 

Running scripts 
Scripts are actually files that contain within them a list ofinstructions 
and commands. Scripts, therefore, are on your disk and must be 
opened and ran; there are three main ways to do this: 
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1. With a Macro Key, as described previously in this chapter. 
Checking the Script checkbox in the Macro Keys dialog box 
calls another dialog box to select a script file from your hard 
disk. 

2. Choose Run Script from the Connect menu, which calls the 
same dialog box to open and run a script file on your hard disk. 

3. By dialing a telephone number from the Data Phone List with 
an associated script. 

QuickLink II Fax script language elements 
The QuickLink I1 Fax script language is made up of commands that 
may be used to create a script file. A script file may be created using 
the Notepad on the Edit Menu. You may also use any external 
editor to create the script file. 

A script file is used to instruct QuickLink I1 Fax to perform a 
predefined set of operations. Script files can be defined to 
automatically perform the dialing and logon process necessary to 
automatically connect to a remote computer. The script can also be 
programmed to perform specific steps once the connection to  a 
remote computer is made. 

The commands that comprise the script language may be entered 
in either upper or lower case. Each line of the script may contain 
only one command. The commands may be indented to any point 
you wish in order to enhance readability. Blank lines may also be 
inserted in the script files to show breaks in sections on the script 
statements. 

You may include comments in the script file by placing a semi-colon 
in the first position of the line that contains a comment. Any 
information appearing on the line after the semicolon will be 
considered a s  comments, even if the information includes otherwise 
valid script commands. 

When sending strings to a remote computer, a string may be 
defined to  include a literal value, a Return character or an ASCII 
character represented by its decimal value. Literal character 
strings must be enclosed by double quotes. A return character is 
defined by including a ‘\r’in the command line. An ASCII character 
is defined by including a ‘\ddd‘ in the command line, where ddd is 
the decimal value of the ASCII character (see Appendix B for ASCII 
Value Table). For example, you would use this feature to send a 
Control-C to a remote computer. 
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When a script is running, a message will be displayed in the status 
area of the Menu Bar. You may abort a script execution by simply 
pressing the Escape key. 

Script language commands 
The QuickLink I1 Fax script language is comprised of the following 
commands: 

Baud Statement: 
This Statement allows you to specify the baud rate to be used when 
the script file is executed. 

Format: Baud '%ate" 

"Rate" can be set to 110,150,300,600,1200,2400,4800,7200,9600, 
12000,14400,19200,38400, or 57600. 

Clearstring Statement: 
This command will clear the contents of the special variable called 
InString. This variable is created by the use of the second form of 
the In Statement defined below. 

Format: Clears t r ing 

CLS Statement: 
This command will clear the QuickLink I1 Fax Terminal Window 
and has  the same effect a s  selecting Clear Screen on the Edit Menu. 

Format: CLS 

The CLS statement will not impact the contents of the Line Buffer. 

Data Statement: 
This statement is used to specify the number of data bits, either 4, 
5,5, 7 o r  8 to be used during the execution of the script. 

Format: D a t a  "#" 

Where # is either 4,5,6, 7 o r  8. 

Dial Statement: 
This command will instruct QuickLink I1 Fax to dial a specified 
telephone number. 

Format: Dial 'kxx-xxd' 
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Where, xxx-xxxx is the telephone number to be dialed. QuickLink 
I1 Fax will use the dialingpretix defined on the Modem Setup dialog 
box. You must have an AT command set compatible modem and 
have English Responses set on to use this statement. 

Example: Dial “1-714-362-5822“ 

The example above would instruct QuickLink I1 Fax to dial the 
Smith Micro Software support BBS. 

Echo Statement: 
This command will cause a literal string that follows the command 
to be displayed in the local Terminal Window. 

Format: Echo “xxxxxx“ 

Where, xxxxxx is a literal string to be echoed to the Terminal 
Window. The string must be enclosed by double quotes. 

Echo ‘This is a sample string“ Example: 

The string, This is a sample string, will be displayed in  the local 
Terminal Window. 

End Statement: 
This command is used to mark the logical end of a set of script 
commands. 

Format: End 

Execution of the script instructions is halted upon encountering a n  
END command. 

Goto Statement: 
This command will transfer the execution to a specified procedure 
name. 

Format: Goto Procedure: 

Where Procedure: is the name of a procedure defined in the script 
file. The procedure name must end with a colon. The following 
script code shows the use of the GOT0 statement. 
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Example Start: 
Echo "This is a n  example" 
Goto step2: 
Stepl: 
End 
StepP: 
Goto Stepl: 

If you follow the execution of the script above, the last procedure 
executed is Stepl: that terminates the script with the END 
Statement. 

I f  Statement: 
The If Statement allows you to test the contents of a special variable 
called Instring. InString is created by using the second form of the 
In Statement defined below. 

Format: IfInString='hxxxxd'Goto Procedure: 

Where xxxxxxx is a literal string not longer than 40 characters. If 
InString equals the specified literal string then execution is 
transferred to the procedure specified in the Goto. 

Example: If InString = "Password" Goto Step2 

In Statement: 
There are two forms of the In Statement. The first form of the 
statement will cause QuickLink I1 Fax to  wait "n" secondsfor string 
of characters to be received from a remote computer. 

Format: In 'kxxxxx'' n 

Where, xxxxxx is a string for which you want QuickLink I1 Fax to 
wait. QuickLink I1 Fax will wait up to "n" seconds for a message to 
be received from a remote computer. If after waiting "n" seconds, 
the string is not received, the remainder of the commands in the 
script file will be bypassed. 

Example: In ''Password?' 30 

QuickLink I1 Fax will wait 30 secondsfor the string, Password?, to 
be received from the remote computer, before continuing with the 
execution of the script. 

The second form of the In Statement allows you the capability to 
receive one character at a time from your modem. Each character 
will be added to a special buffer called Instring. 
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Format: In InString 

InString may contain up to 40 characters of input and will generate 
an error if more than 40 characters are received. InString may be 
used in an  If statement for testing and controlling the flow of the 
script execution. 

Out Statement: 
This command will cause a string to be transmitted to a remote 
computer. 

Format: out ' k x x x d '  

Where, xxxxxx is a string to  be transmitted to a remote computer. 

Example: Out '!DEMOPASS\I" 

QuickLink I1 Fax will transmit the string, DEMOPASS, to the 
remote computer followed by a Return character (\r). 

Pause Statement: 
This statement will cause the execution of a script file to be 
temporarily halted until the user presses a key on the keyboard. 

Format: Pause 

A message will be displayed in the terminal window, instructing 
the user to Press a Key to  Continue. 

Parity Statement: 
This statement is used to specify the parity to be used during the 
execution of the script. 

Format: Parity "d' 

Where, xis "N" for none, "0" for odd, "E" for even, "M" for mark, and 
"S" for space parity. 

RtsCts Statement: 
This statement is used to specify whether the RTSKTS hardware 
flow control is to  be used when executing this script. 

Format: RtsCts "xx" 

Where, xx is "ON" for on or "OFF" for off. 
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Stop Statement: 
This statement is used to specify the number of stop bits, either 1, 
1.5 or 2 to be used during the execution of the script. 

Format: stop ((I” 

Where # is either 1, 1.5 or 2. 

Until Statement: 
This command will cause QuickLink 11 Fax to wait until a specified 
time before continuing with the execution of the script. 

Format: Until %h:mm” 

The time must be specified in the form of 24 hour military time. 

Wait Statement: 
This command will cause QuickLink I1 Fax to delay for ‘n’ seconds 
before proceeding with the next script command. 

Format: Wait n 

Where ‘n’ is the number of seconds you want QuickLink I1 Fax to 
wait before proceeding to the next script command. 

Example: Wait 16 

QuickLink I1 Fax will wait 15 seconds before executing the next 
step in the script file. 

XonXoff Statement: 
This statement is used to specify whether the Xon/Xoff flow control 
is to be used when executing this script. 

Format: XonXoff Umr” 

Where, xx is “ON” for on or “OFF” for off. 

In addition to  the above script commands, the QuickLink I1 Fax 
script language includes a number ofpredefined variables that may 
be used in writing a script. Many of these variables are used by 
QuickLink I1 Fax to provide automatic connection to Compuserve, 
Dow Jones and GEnie. The following list of variables are included 
in the script language: 

Variable Meaning 
Compunet Telephone number for CompuServe’s own network 
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Telenet Telephone number for Telenet 
Tymnet Telephone number for Tymnet 
Cacct CompuServe account number 
Cpass CompuServe password 
Dpass Dow Jones password 
Guser GEnie user number 
Gpass Genie password 

You will find a number of script files (SRP) in your QuickLink I1 
Fax default directory that use the above script commands and 
variables for accessing CompuServe, Dow Jones and GEnie. These 
files are listed below: 

File Use 
COMPUSRVSRP Connects to CompuServe 
DOWJONESSRP Connects to Dow Jones 
EMAILSRP 

GENIESRP Connects to GEnie 

Connects to the American Email BBS a t  
Smith Micro Software, Inc. 

You can use the above files as examples for creating your own 
scripts. Also, if you are not in the United States and want 
automatic access to CompuServe, Dow Jones or GEnie simply 
modify the proper script file, from the list above, to operate with 
your country’s telephone access system. 
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Command Line Options 

Most of the fax functions of QuickLink I1 Fax are actually modules 
and TSRs that can be driven and run directly from the DOS 
command line. In fact, with some industrious batch file writing, you 
could create your own customizable front end for faxing. While it is 
not within the scope of this manual to do that, this Chapter covers 
all the command line options for QuickLink I1 Fax and its modules. 
Note that all modules are configured through the Main Application, 
so it will still need to be used to set your system up. Note also that 
all commands can be listed on screen by typing the name of the 
module followed by a /? (Example: RECFAX /?I. Finally, note that 
none of the TSRs can be loaded into High, Extended, or Expanded 
memory. 

FastFax IV 
FastFax IVis amemory resident utility which captures HPLasejet  
I1 (PCL 4) printer commands from within any application and faxes 
the resultingdocument. Thismeans that  what you fax will look the 
same as ifyou had printed it out on a HP Laserjet printer. FastFax 
IV can be activated by a hotkey, printing to a specific printer port, 
or a combination of the two. This will allow you to print to a printer 
port for sending a fax and another printer port for generating a 
hard-copy printout. The ALT-= key combination removes FastFax 
from memory. 

FastFax IV Command Line ODtions 
While at the DOS prompt, type FASTFAX followed by the optional 
parameters to load FastFax IV into memory. Once loaded into 
memory, FastFax IV can be used to send a fax or create a file to fax 
a t  a later time with QuickLink I1 Fax. The command line and 
options are as follows: 

FASTFAX [options1 
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/C Use the CONTROL.PCLfile in the FONTS subdirectory (located 
off of the directory where QuickLink I1 Fax was installed) to 
control what the fax document will look like when faxed. This 
file can contain information about font attributes in respect to: 
orientation, symbol set, spacing, pitch, point size, style, stroke, 
and typeface. This file can contain only legal PCL 4 commands. 

/F Automatically load SNDFAX in memory if not already loaded. 
If this option is not used and SNDFAX is not loaded, FastFax 
IV will ask you if you want it loaded. Without SNDFAX or 
RECFAXin memory, FastFax IV will not be able to send faxes. 

/L# Specify a printer port you wish to have automatically activated 
by FastFax IV. The # represents the printer port U" Port) 
number which will activate FastFax IV (ie. /L2 = LPT2). If no 
/Lis specified then FastFax IVcan only be activated by pressing 
the ALT and '\' keys simultaneously. 

/N Turn off FastFax IV activatioddeactivation sounds. 

/Rd Use a RAM disk for the PCL conversion. The 'd' represents the 
drive letter of the RAM disk. If you have a DOS variable TEMP, 
the path represented by TEMP will be used as the RAM disk 
location. TheTEMPvariable will be used automatically whether 
/Rd is specified or not. 

/S Suppress all messages to the screen. 

IT# Specify the printer timeout period in seconds. me # represents 
the number of seconds after printing has ended before FastFax 
IV is activated (default is 15 seconds). 

N Unload FastFax IVfmm memory from the DOS command line. 

Fonts 
Fonts that are supported by FastFax IV are as follows: 

Portrait 
Courier 12 point Medium, Bold and Italic. 
Courier 12 point in the extended PC symbols set. 
LinePrinter 8.5 point in the extended PC symbols set. 

Helvetica 8 point Medium. 
Helvetica 10 point Medium, Bold and Italic. 
Helvetica 12 point Medium, Bold and Italic. 
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Helvetica 14 point Bold. 

TimesRoman 8 point Medium. 
TimesRoman 10 point Medium, Bold and Italic. 
TimesRoman 12 point Medium, Bold and Italic. 
TimesRoman 14 point Bold. 

Landscape 
Courier 12 point Medium, Bold and Italic. 
Courier 12 point in the extended PC symbols set. 
Lineprinter 8.5 point in the extended PC symbols set. 

If you use a font that is not supported, FastFax IV will use the font 
most similar to the one you specified. 

NiteFax is a powerful utility that allows you to emulate a fax 
machine when you are not using your computer for other 
applications. Such a time may be after hours when you leave your 
ofice for the day. Running NiteFax before you leave by entering 
the following command from the DOS Command line: 

NITEFAX 
will start the NiteFax process. If the Receive Fax background 
program (RECFAX) is not resident in memory, NiteFax will load it. 
As an incoming fax is received it will automatically be printed on 
your graphic printer using the printer driver you specified in  
Hardware Setup on the Setup Menu in the QuickLink I1 Fax 
environment. Be sure to leave your printer turned on! All entries 
will also be made in the Receive Fax log and all .REC fax files will 
be saved. The best part is that your received fax transmissions will 
be printed and waiting for you when you arrive in the morning. 

If a printer error occurs such as paper out, NiteFax will be 
terminated. Fax transmissions will continue to be automatically 
received and logged by the Receive fax program. 

To turn off NiteFax, simply press the ESC key. The Receive Fax 
program will remain active after you turn off NiteFax until you 
issue the RECFAX /OUT DOS Command to remove it from 
memory. 
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Convert 

CONVERT allows you to prepare afile for outgoing fax transmission. 
It operates as aforeground application and occupies approximately 
90K bytes of main memory. CONVERT will create a .QFX file. The 
format of the DOS Command line function is as follows: 

CONVERT <source file, [file type] [conversion flags] 

where the source file is the name of the file to be converted. The 
output file will have the same name as the source but will have a 
.QFX file extension. The other parameters are as follows: 

File Types 
/I3 BMP 
/D DCX 
/I IMG 
/M MacPaint 
/P PCX 
/PCL PCL4 

/T TIFF 

/U CUT 
/X Text 
/WP Word Perfect 

Conversion Flags 
/C Center on page 
/F Turn Full page on 
M High Resolution 
/L# Linedpage (default 66) 
/N Long merged file to next page 
/R Remove merged file of different 

resolution 
/S Suppress messages and DOS error 

setting 
N# Vertical Margin (def 1) 
/W# Width of tab (def 8 )  
/K Use compressed 200 characterlline 

font 

You must specify the source file type and may at your option specify 
the desired conversion flags. Each entry on the command line must 
be separated by a space. A DOS error code of other than zero 
indicates a failed conversion of the source file. Each parameter 
entry must be separated by a blank space. 

SNDFAXprovides you with a method of sending fax transmissions 
from the DOS prompt. 

The command line method of sending a fax requires that the file be 
converted prior to executing the SNDFAX DOS command. This 
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method will send the fax in the background using the following 
command: 

SNDFAX /F:<FileName> /FN:<FaxNumber> /GPcGroup> 

Where FileName is from one to ten .QFX file names. The ‘/FN’ 
telephone # is the fax number to which the fax will be sent or you 
can use the ‘/GP’ to fax to a group ID defined on the Fax Phone List. 
The ‘time’ parameter is optional. When specified, it allows you to 
schedule a fax transmission. If the ‘/TM’ parameter is not included 
the fax is sent ‘Now’. The ‘f” parameter has  the format of 
HH:MMx, where x is A for AM or P for PM. 

This method of sending a fax loads the RECFAX program 
background program which requires approximately 90K of main 
memory. RECFAX performs all background operations. 

To remove all scheduled background fax transmissions issue the 
following DOS command: 

SNDFAX/OUT 

This command will cancel all scheduled fax transmissions. To 
remove the RECFAX background program from memory in  
addition to removing all scheduled transmissions enter SNDFAX/ 
A. Other comands include: 

/CPInclude a cover page when a fax is sent 
/IDLE Load SNDFAX without sending a fax 
/RSCH Remove all scheduled faxes 

Export 

The Export function allows you to export a .QFX or .REC file to a 
PCX or TIFF format from the DOS Command line. 

EXPORT csource file> [/P or /TI /I /&# mx-y /S 

where source file is the name of the file to be exported. The ‘P 
option specifies a PCX export and ‘I” specifies TIFF. If the ‘/I’ 
option is specified, the fax will be exported with inverse colors, 
white on black rather than black on white. The optional ‘/Q‘ 
parameter specifies to which resolution you wish to export. YQl’ 
means export to 1OOdpi (dots per inch), and ‘/Q2’ means export to 
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200dpi. The default is ‘IQl’ for normal resolution documents and ‘/ 
Q2’ for high resolution documents. This option may be useful to 
force a particular resolution if the application you are using 
requites it. The ‘IR’ parameter is optional and allows you to specify 
the page range to export within a document. For example, /R2-3 
would instruct EXPORT to export pages 2 and 3. If you do not 
specify a range of pages, all pages will be exported. The ‘IS’ 
parameter is also optional and will suppress all error messages. 

View Fax 

The ViewFax function allows you to view a .QFX or .REC file from 
the DOS Command line. This option provides all the interactive 
functionality ofviewinga send or receive fax document from within 
the QuickLink I1 environment. The form of the command is as 
follows: 

VIEWFAX <source file> lR.x /M# 

Where source file is the name of the file to be viewed. The /R 
parameter is optional and allows you to specify the starting page 
number within the document, ie. /R2 would instruct ViewFax to 
begin the view with page 2. If the /Rx parameter is not used, 
viewing will begin with page 1. The N# parameter is also optional. 
It specifies the graphic adaptor type. The default if not specified is 
for QuickLink I1 Fax to auto detect. Other values are CGA = M6, 
Hercules = M8, EGA = M15, VGA = M17. These values may vary 
depending on the manufacturer of your adaptor card. 

PrintFax 

The PrintFax command line function allows you t o  print a fax tile 
(either .QFX or .REO to your graphics printer. The form to the 
command is as follows: 

PRINTFAX <source file> <printer> /Rx-y 

Where, source file is the name of the file to be printed. The printer 
parameter must be the name of an existing .QLP file. For example, 
9PIN.QI.2 is the printer file that prints on most 9 pin dot matrix 
printers. To print the README.QFX file on a 9 pin, type: 

PRINTFAX README.QFX 9PIN.QLP 
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The /R optional parameter provides you with the capability of 
specifying a page range within the document to  print. The starting 
page number is x and the ending page number is y. Omitting the 
/R parameter will result in the entire document being printed. 

RECFAX 

RECFAX was discussedin detail in Chapter 7. Acomplete command 
line parameter listing is provided here: 

/ALL 
/OUT Remove RECFAX from memory 
/NOMSG No messages will be displayed on the screen 

Remove both SNDFAX and RECFAX from memory 
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Appendix A 
Terminal emulation keys 

The special VT5W100/102 keypad and other special VT52/100/102 
unique keys have been translated into the PC keyboard. Use the 
following keypresses for special VT terminal keys: 
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Appendix B 
ASCII character table 

The following table lists the ASCII character set and each character's 
corresponding decimal and hexadecimal code equivalent. This 
chart is often useful for creating scripts and as a reference. 
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Appendix C 
Advanced Considerations 

If you have a specialized need, a fairly unusual system setup, are 
a Windows user that knows every line of your WIN.IN1 file, or you 
just want to know a little more about how your system operates, this 
appendix is filled with the QuickLink I1 Fax arcane knowledge you 
are looking for. Topics include: 

The files used to launch QuickLink I1 Fax for Windows 
How to set your PC for different IRQ and COM ports 
How to set Windows to use different IRQs for your modem 
What QuickLink I1 Fax adds to your WIN.IN1 file and your 
system 
The SMSSETUP.DAT file 
The QLSETUP.DAT file 
How the Fax Manager launches 
Using your scanner to scan documents 
Using softfonts with FastFax 
The Error Code table, should fax transmissions be unsuccessful 
Common Hayes compatible AT commands. 

Program filenames 

For users who will be launching QuickLink I1 Fax for Windows in  
manners other than the Windows Program Manager, the following 
is a list of applicable filenames and the programs they run: 

QL2FAXW.EXE: 
QLFVIEW.EXE: Fax Viewer 
FMLAUNCH.EXE: I.aunchestheappmpriateclassFaxManager 
FAXMGRCIJXE: 
FAXMGRC2.EXE: 

QuickLink I1 Fax main application 

Fax Manager for Class 1 modems 
Fax Manager for Class 2 modems 

The icons are imbedded in the EXE files. 

QuickLink II Fax User's Guide A-1 49 



Advanced Considerations 

IRQ settings and common usage 

Since various add in cards like scanners, bus mice, network cards, 
and sound boards use IRQs (interrupts), it is possible that the 
default IRQ settings for your modem will not work. If you suspect 
there is an IRQ conflict, QuickLink I1 Fax can work around the 
problem if you do the following: 

1. Change the IRQ jumper or DIP switch on the modem itself 
(your modem manual will show you how, if possible). 

2. If using the DOS version of QuickLink I1 Fax, go into Modem 
Setup, click Option, and manually reset the IRQ of QuickLink 
I1 Fax t o  what you set i t  for on your fadmodem. If using 
Windows, refer to the next page covering Windows and IRQs. 

As an example, suppose that your modem on COM2 (which normally 
uses IRQ3) cannot function because IRQ3 is used by your scanner 
card, and that IRQ 5 is available. Open your PC and set the 
appropriate jumpers to COM2, IRQ 5. Run QuickLink I1 Fax, get 
into the Modem Setup dialog box, and set the on screen COM port 
setting to COM 2, IRQ 5.  

Standard COM port settings 

Port IRQ Address 
COMl 4 3F8 
COM2 3 2F8 
COM3 4 3E8 
COM4 3 2E8 

Common IRQ Usaae 
The following IRQ table holds true for most PC ATl386-486 
computers: 

IRQ USE 
0 Timer Interrupt 
1 Keyboard Interrupt 
2 
3 COM2 and COM4 
4 COMl and COM3 

Programmable Interrupt Controller Cascade (to IRQ 9) 
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5 
6 
7 
8 
9 
10 
11 
12 

13 
14 
15 

LP"2 (Parallel Printer Port 2 - Probably Open) 
Floppy Disk 
LPTl (Parallel Printer Port 1) 
Real Time Clock 
Cascade to IRQ 2 
Reserved for future expansion (Open) 
Reserved for future expansion (Open) 
Reserved for future expansion (Open) 
Mouse Port on PW2 - PS/2 mouse interface 
80x87 Math Coprocessor (486DX chip) 
Hard Disk 
Reserved for future expansion (Open) 

Window's IRQ settings 

Since various add in cards like scanners, bus mice, network cards, 
and sound boards use IRQs (interrupts), it is possible that the 
default IRQ settings for your modem will not work. If you suspect 
there is an IRQ conflict, QuickLink I1 Fax can work around the 
problem if you do the following: 

1. Change the IRQ jumper or DIP switch on the modem itself 
(your modem manual will show you how, if possible). 

2. Go into the Windows Control Panel and set the IRQ to the 
settingthat matches the modem. (This only applies to Windows 
version 3.1) 

1 .  

As an example, suppose that your modem in COM2 (which normally 
uses IRQ3) cannot function because IRQ3 is used by your scanner 
card, and that IRQ 5 is available. Open your PC and set the 
appropriate jumpers to COM2, IRQ 5. Launch Windows and open 
the Control Panel. Double-click on Ports, which opens the Ports 
dialog box. Select COM2 and click Settings. From the Settings 
dialog box, click Advanced and choose IRQ5 from the IRQ pull 
down menu. Click OK to close the dialog boxes down and set the 
change. 
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1 - Settings ~ e l p  I 

Base 110 Port Address: 

I interrupt Requett Line [IRQ): I 
The WINJNI file and your system 

When QuickLink I1 Fax installs on your system, it makes changes 
to your WIN.IN1 file, located in your \WINDOWS directory. The 
following lines are added: 

[QuickLink I1 Fax1 
InstallDirectory=C:\QL2FAXW 
LanguageResource=QLFENGL.DLL 
ModemMonitor=O 
FaxManagerX=566 
FaxManagerY =4 54 
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(some additional lines may appear also) 

These lines are normally changed when configuring QuickLink I1 
Fax as describedin previous chapters. However, ifyou want to alter 
the settings directly, they will take affect the next time QuickLink 
I1 Fax is run. 

There are also lines added to the WIN.INI file by QuickLink I1 Fax 
in the [F’rinterPortsl section and the [devices] section for the 
QuickLink I1 Fax Printer Driver. These lines can be manually 
deleted, or automatically deleted by removing the printer driver 
with the Windows Control Panel. 

QuickLink I1 Fax installs all of its files into the QuickLink I1 Fax 
install directory (normally \QLPFAXW) except for 1, located in the 
\WINDOWS\SYSTEM directory. If for some reason you wish to 
completely uninstall QuickLink I1 Fax, delete the QuickLink I1 Fax 
install directory, the afore mentioned lines in the WIN.INI file, the 
p r in t e r  driver,  and  t h e  following file from t h e  
\WINDOWS\SYSTEM directory: 

C:\WINDOWS\SYSTEM\QLFXDRVR.DRV 

The SMSSETUP.DAT file 

When QuickLink I1 Fax for Windows is run for the first time, a file 
called SMSSETUP.DAT is automatically created. When settings 
are modified, the changesget written into this file. Therefore, ifthis 
file gets corrupted, the settings will change in unpredictable ways, 
and QuickLink I1 Fax might not act properly. 

If QuickLink I1 Fax suddenly starts acting mysteriously, consider 
deleting this file and running QuickLink I1 Fax again. This will 
recreate the file and reset the program to the factory defaults. This 
is also a good way to reset the program if you purchase a new 
modem or fadmodem and want to renew the program. 

The QLSETUP.DAT file 

When QuickLink I1 Fax for DOS is run for the first time, a file called 
QLSETUP.DAT is automatically created. When settings are 
modified, the changes get written into this file. Therefore, ifthis file 
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gets corrupted, the settings will change in unpredictable ways, and 
QuickLink I1 Fax might not act properly or the fax modules may not 
find the fdmodem.  

If QuickLink I1 Fax suddenly starts acting mysteriously, consider 
deleting this file and running QuickLink I1 Fax again. This will 
recreate the file and reset the program to the factory defaults. This 
is also a good way to reset the program if you purchase a new 
modem or fadmodem and want to renew the program. 

Fax Manager launching 

The Icon labeled "Fax Manager" in the QuickLink I1 Fax Windows 
Program Group actually runs the program FMLAUNCH.EXE. 
This program in turn determines what Class of fadmodem you 
have by reading the SMSSETUP.DATfile and loads the appropriate 
Fax Manager into memory. If you will be launching the Fax 
Manager in a special way, you can launch the correct Fax Manager 
file by loading it directly, bypassing FMLAUNCH.EXE. You can 
double-check which class fadmodem you have by clicking the 
Hardware button in the Modem Setup dialog box. 

If you own a scanner, it may be used to read in various printed 
documents, the image of which can be faxed out with QuickLink I1 
Fax. Most scanners and scanner software are extremely flexible 
concerning the type offiles that the scanned document can be saved 
to. QuickLink I1 Fax is compatible with most of the files that the 
popular scanners create, so long as you follow the following 
guidelines: 

Grayscale scans cannot be faxed out, so set your scanner 
accordingly. Set the image type to Black and White, Line 
Art, or One Bit Grayscale, depending on which mode your 
scanner offers. 
Scan Documents in at 100 DPI if you will be setting QuickLink 
I1 Fax to  Normal Resolution fax sends; 200 DPI if you have 
QuickLink I1 Fax set to High Resolution. 
Save the scans as either TIF files or PCX files. 

If you follow these guidelines, you can send your scans with the 
Send Fax command from the Fax menu. 
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If you are using the Windows version of QuickLink I1 Fax and you 
have Windows scanner software, you can use the print driver to fax 
out the scan. 

FastFax and softfonts 

There are two ways to print a document with soft fonts. One way 
assumes that you have down loaded the soft font to your printer's 
memory prior to printing your document. The other way is to give 
the printer the soft font information while actually printing your 
document (the font gets downloaded with the print job). For 
FastFax to use soft fonts properly, you must use the second method 
described above. Note that you will only have to do this once per soft 
font, since FastFax will remember the font information the next 
time you print your document. The soft font information that was 
given to FastFax will be stored on disk soit can be accessed any time 
after. Once FastFax stores the soft font, you can use the first 
method of printing your documents. 

Some applications may only give the printer the soft font characters 
that  are used in the document. This will cause later probIems with 
FastFax when you try to print a soft font character that  was not 
originally printed to FastFax. If you are unsure of how your 
application handles soft fonts, you will want to print the provided 
ASCII text file SOFTFONT.TXT before any document that uses 
soft fonts. This file is located in  the QuickLink I1 Fax directory. If 
there are characters that  are not in SOFTFONT.TXT, you can add 
them yourself using a text editor. 

Error codes 

In the unlikely event of a fax not successfully transmitting, the Fax 
Logs will display a n  error code. You may get a detailed explanation 
of the error by clicking the Errors button when displaying the Info 
on the Fax Log entry, or from the Help system. The following is a 
summary of the Error codes: 

Error Codes: 
100 - 199 Modem Errors 
200 - 299 File Errors 
300 - 399 
400 - 499 

Send Fax Errors 
Receive Fax Errors 
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500 - 599 

Modem Errors: 
Error: 101 
Error: 102 
Error: 103 

File Errors: 
Error: 201 
Error: 202 
Error: 203 
Error: 204 
Error: 205 
Error: 206 
Error: 207 
Error: 208 
Error: 209 
Error: 210 
Error: 211 
Error: 212 
Error: 213 

Send Fax Errors: 
Error: 301 
Error: 302 
Error: 303 
Error: 304 
Error: 305 
Error: 306 
Error: 307 
Error: 300 
Error: 309 
Error: 310 
Error: 399 

Receive Fax Errors: 
Error: 401 
Error: 402 
Error: 403 
Error: 404 
Error: 405 
Error: 406 

Error: 407 
Error: 408 

Error: 499 

Miscellaneous Errors 

Unable to  open COM port. 
Unable to  detect modem. 
Modem not a fax modem. 

Unable to create necessary file. 
Out of disk space. 
Error reading file. 
Error writing file. 
Unable to  close file. 
Unable to  access file. 
Unable to open fax file. 
Unable to open exchange file. 
Unable to open setup file. 
Unable to  createlsend cover page. 
Unable to createlsend headers. 
Unable to open file. 
Error reading exchange file. 

No dial tone detected from modem. 
Number dialed was not a fax machine. 
Number dialed was busy. 
No carrier detected after dial. 
Error occurred during fax training. 
No CONNECT message from remote. 
No End Of Page acknowledgment received. 
No phase D page response received. 
Unknown phase D error. 
No End Of Page response received. 
Unknown send error. 

Remote fax failed to train. 
Remote fax failed to train. 
Error during End Of Fax handshake. 
Error occurred during End Of Page. 
Unknown phase D error. 
Received no acknowledgment during End 
Of Page. 
Time-out on end of reception. 
No end of transmission acknowledgment 
received. 
Unknown fax receiving error. 
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Miscellaneous Errors: 
Error: 501 
Error: 502 

Unable to allocate memory. 
The selected document contains 0 pages. 

AT command set 

Most modems used with Pc's implement the AT Command Set as 
a method of issuing commands to the modem. The actual 
implementation by your modem's manufacturer is documented in 
the hardware manual included with your modem. The chart below 
is a summary of many of the more commonly used AT commands. 
Many users may never find a need to use this command set, as 
QuickLink I1 Fax does much of the work for you. 

Command 
AT 
A/ 
A 
DT 
DP 
E 
El 
H 
H1 
I 
L 
MO 
M1 
M2 
M3 
0 
01 
Q 
61 
Sr? 
Sr=n 

V 
v1 
X 
Y 
Z 
+++ 

Description 
Attention command and precedes command line 
Repeat preceding Command 
Answer call immediately 
Dial Touch Tone Mode 
Dial Pulse Mode 
Command Echo Disabled 
Command Echo Enabled 
Hangup (on-hook) 
Off Hook 
Output Product Code to PC 
Speaker Volume (LO, L1, L2, L3) 
Speaker off 
Speaker on until Carrier Detect 
Speaker always on 
Speaker on from dial to Carrier Detect. 
Return to On-line Communications 
Return to On-line Communications & Retrain 
Send Result Code Messages 
Do not Send Result Code Messages 
Read & Display Contents of Register (r) 
Set Register (r) to Value (n), ATSO=l, answer phone 
on first ring 
Result Code Messages sent in Numeric format 
Result Code Messages Sent in English WordFormat 
Extended Status Mode 
Long Space Disconnect 
Reset and Initialize Modem 
Escape Code from On-line to Command State 
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Appendix D 
Troubleshooting 

The subject of telecommunications is filled with many variables 
and potential pitfalls. This Appendix addresses some of the problems 
you might encounter with QuickLink I1 Fax, and how to solve them. 

GenerallData Comm troubles hooting 

You cannot communicate with your modem or fadmodem, 
or you receive unintelligible garbage characters in the 
terminal window. 

The COM port and/or IRQ used by your modem or fadmodem 
is also being used by another serial device installed in your 
computer. Refer to Chapter 1 and Appendix C for more 
information. 

When you type a character in the terminal window, it 
appears twice or not at all. 

QuickLink I1 Fax has i tsbcal Echo feature turned on and the 
modem's echo feature is also turned on. If the system you are 
calling echoes your typed characters, turn off Local Echo in 
the Terminal Options dialog box. 

You cannot hear the modem dial or connect. 

Add M1L3 to the end of your Init String in the Modem Setup 
dialog box. 

Your modem or  faxlmodem disconnects while 
communicating remotely. 

"he other side has hung up. 

Your telephone line may have call waiting and a call has come 
in. I t  can be disabled in the Modem Setup dialog box. If this 
does not work, contact your local telephone company. 
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Someone may be picking up a n  extension connected to the line 
your modem or fadmodem is using. 

You are using a n  MNP 5 or v.42bis modem and the other modem 
does not support MNP 5 or v.42bis. Refer to your modem 
manual and disable them. 

Your Line Settings do not match those of the other 
communicating device. 

Characters are dropped at high baud rates (9600 or higher). 

Ensure you are using Windows 3.1 and the Windows 3.1 comm 
driver, along with a 16550 UART serial chip. 

Faxing troubleshooting 

QuickLink I1 Fax is not able to connect or receive faxesfrom 
remote fax sources. 

Ensure the Fax Manager is loaded and Fax Receiving is 
enabled if in  Windows; ensure the RECFAX module (TSR) has 
been loaded into memory if in DOS. 

Your faxfmodem may not be compatible with the specific brand 
offax connecting. Contact the modem manufacturer to determine 
if there is a known problem. 

Some fax machines cannot handle certain Fax ID’S. For example, 
some fax machines require only numbers as the Fax ID, while 
others require only upper case or no spaces. Your Fax ID can be 
changed in the Receive Fax Setup dialog box. 

QuickLink I1 Fax connects to the remote fax machine, but 
none of the document pages are sent or are blank. 

If you have scheduled the fax to be sent, you may have deleted 
the fax document before it was sent. 

You may be trying t o  send a fax from the floppy disk. This is not 
recommended, since disk access times are longer when files are 
on the floppy drive. Copy the file to your hard disk and try 
again. 

You are trying to send afile other than an ASCII text, DOS text, 
or Wordperfect DOS v5.Oh.1 (Wordperfect in DOS only) file 

A-1 60 QulckLlnk II Fax User’s Guide 



Troubleshooting 

format from the Fax menu from the QuickLink I1 Fax main 
application. Convert your document file into one of these 
formats or use the FastF'ax pop-up utility/QuickLink I1 Fax 
print driver. Review Chapter 2 and 7 for more information. 

Faxes are being sent at  a lower baud rate than the rated 
speed of the fdmodem or the specified Maximum Baud 
Rate in the Send Fax Dialog box. 

Your fadmodem can't connect a t  the faster baud rate. This can 
be caused by poor line quality, speed limitations of the receiving 
fax machine, or a hardware incompatibility. This is not 
necessarily indicative of any problem with your fadmodem. 

When you view a received fax, there appear to be missing 
lines, garbage, or "bar code". 

Your fadmodem may be incompatible with the sending 
hardware. 

There may have been a bad telephone connection for the call. 

Your fadmodem may be improperly installed or damaged. 

The Fax Viewer or Fax Manager will not read a .QFX or 
.REC file. 

Re-create the .QFXfile from the original graphic or  document. 

Export the .REC file to  a .PCX and back into a .QFX and t ry  
again. 

QuickLink I1 Fax says that there are faxes scheduled to be 
sent, though Viewing the Schedule reveals nothing. 

Delete the file SCHEDULE.QL2 from the QuickLink I1 Fax 
install directory. This file contains the schedule information 
and is likely written to the disk incorrectly. It will be re-created 
the next time you schedule a fax. 
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When loading the Fax Manager from the Program Manager, 
loading FWCFAX, or sending QuickLink I1 Fax fax commands 
to your fadmodem, there is an error to the effect that the 
fadmodem cannot be found, or initialized, or opened. 

QuickLink I1 fax is assuming you have the wrong class Fax 
Manager. Use the Hardware button under Modem Setup to 
switch classes in the Windows version - delete the file 
QLSETUP.DAT for the DOS version. 

You have the wrong COM port or IRQ set for your Fax Modem. 
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16~550  UART xiv 

A 
American E-Mail W-42, D- 

Answer Mode W-51, D- 

Answering a Data Call D-112 

105 

82, D-118 

ASCII W-45, W-48, W- 
54. D-107. D-109. D-113 

AT Command Set 
Auto Detect 4 
Autobaud W-61, 
AUTQEXEC.BAT 

B 

A-i57 

D- 12 1 
8, 14 

Background Faxing D-94 
Baud W-43, D-105, D-117 

Broadcasting W-34, D-95 
ButtonBar xii, 5 

C 
Capture Text W-50, D-111 
Clear Screen W-51, D-111 
Color Setup D-124 
Color, Text W-62 

BMP W-32, D-93 

COMPort D-119 
Conflicts 8 
Initial Selection 7 
Settings A-150 

CompuServe W-65 
CONFIGSYS 8 
Connection Setup D-122-D- 

Convert D-140 
Convert Fax Document D- 

Exporting D-92-D-93 

123 

85, D-92-D-93 

Importing D-93 

Graphic W-40, D-100 
Setup W-39 

Cover Page W-18, D-97, D- 
99-D-100 

CUT D-93 

D 
Data Phone List W-42-W- 

44, D-104 

Sort D-104 
Edit D-104 

DCX W-30, W-32, D-93 
Dedicate CPU D-97, D-98 
Default Configuration 12 
Default Data Settings 7 
Default Fax Settings 6 
Default Printer 3 
Dial W-41, D-103 

Credit Card Usage W- 

Dialing Out D-103 
Prefm W-42 
Prefix/Suffi D- 118 
Redial on Busy W-42 
RedialTimeout W-42, D- 

Document Type Selection W- 

DOS 15 
DOSShell D-84 
Dow Jones W-65 
Downloads D-109 

59, D-118 

98 

19 

Download Status W-49 
Multiple File Protocols W- 

Single File Protocols W-48- 
49 

w-49 
Duplex. See Local Echo 
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Index ~ 

E 

Error Codes A-155-A-157 
Export D-141 
Export From Fax W-30 

F 
FastFax D-75-D-78. D-137- 

D-139 
Command Line Options D- 

137-D-138 
Fax Phone List D-78 
Faxing out with D-77 
Load Options 14 
Setting Up D-76 
Softfonts A-155 

Format of D-85 
Location of D-85 

Fax Files 

Fax ID String W-37, D-98 
Fax Logs. See Send, Receive 

Fax Manager W-17, W- 

Always on Top W-35 
Enable Fax Receiving W- 

Loading W-34, W-38 
Manual Fax Receive W-35 
ModemMonitor W-35 
Percent Bar W-35 

Fax Phone List W-18, W- 

Fax Logs 

18, W-20, W-34-W- 
40, W-51 

34 

27, D-78, D-80, D-89-D- 
91 

Editing D-89-D-90 
Group W-28 
Mark D-90 
Mark Group W-28 
Sorting D-90 

Fax Receiving D-81-D-82 
Fax Schedule W-18 
Fax Scheduling W-32, D-94 

and RECFAX D-94 
View Schedule W-33 
Viewing the Schedule D-95 

Fax Viewer W-24-W-25, W- 
25, D-86 

First Page W-25 
Fit Horizontal W-25 
Fit Vertical W-25 
Flip Horizontal W-25 
Flip Vertical W-25 
Full Size W-25 
Grabber Hand W-25 
Last Page W-25 
Next Page W-25 
Open File W-25 
Previous Page W-25 
Print W-25 
Reverse W-25 
Zoom In W-25 
ZoomOut W-25 

Faxing out from Quick Link I1 
Fax D-79-D-81 

File Transfers W-44-W- 

Flow Control 

Freeing the COM Port W- 
35, w-53 

G 
GEnie W-65 
Graphics, Received Faxes are 

Export From Fax W-30 
Graphics, Received Faxes 

as W-30 
Group W-28 

H 

Hangup W-44, D-106 
Hardware Setup D-87 
Help 12, W-21, D-84 
High Resolution D-96. See 

49, D-106-D-110 

Xon/Xoff D-121 

Resolution; Send Fax 
Setup 

I 

IMG D-93 
Import to  Fax W-30, W-31 
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INBOX W-20, W-23, W-39 
Initialization String 5, 8, W- 

58, D-117 
IRQ D-119, A-150, A-151 

K 
Kermit W-46, W-49, W- 

KermitlSuperKermit W- 
54, D-114 

46, W-49, W-54, D- 
107, D-110, D-114 

L 
Line Buffer D-112 
Line Settings W-43, W- 

57, W-57-W-63, D-116-D- 
117 

Baud D-117 
Baud Rate W-57 
Data Bits W-57, D-117 
Flow Control W-58 
Local Echo D-120 
Parity W-57, D-117 
Stop Bits W-57, D-117 

Local Echo D-120 
Low Resolution. See 

Resolution 

M 
MAC W-32, D-93 
Macro Keys W-66-W-67, D- 

128-D-129 
Mainframes D-105 
Manual Fax Receive W- 

Manual Fax Send W-18, W- 

Margins D-97 
Mark D-95. See Fax Phone 

Mark Group. See Fax Phone 

MenuBar 5, 8 

Modem Setup W-58 

35, D-96 

33 

List 

List 

MNP W-58, D-123 

Answer Mode W-51, W- 

Dial PrefdSuffix W-59, D- 

Dial String W-59 
Hangup String W-59 
Hardware W-58, A-162 
Initialization String W- 

Number of Rings to Answer 
Phone W-51 

ModemMonitor W-35, W-51- 
w-53 

Monitor'I'ype 7 
Mouse 8 

N 
NiteFax D-139 
NO CARRIER D-119 
Number of Rings to Answer 

60, D-82, D-118 

118 

58, D-117 

Phone W-51, D-113, D- 
118 

0 

Off-Line W-53, W-61 
On-Line W-53, W-61 
Online Services. See Services 
OUTBOX W-23, W-37 

P 

Parity D-117 
Paste to Host W-50 

PCL Font Setup D-100-D- 
PCL D-93 

101 

93 
PCX W-30, W-32, D-92, D- 

Print Faxes W-26 
Scale to Fit W-26 

Print Setup W-17 
Printer Port D-125 
PrintFax D- 142 
Printing Faxes D-87-D-88 

Printing Faxes Actual 
Setting your Printer D-87 
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Size D-125 
Printing Text Files D-112 
Program Filenames A-149 
PrOtoCOlS W-53-W-56, D- 

113-D-116 
ASCII w-54 
CompuServe B/B+ W-54 
KermWSuper Kermit W-54 
Xmodem W-55 
Xmodem 1K W-55 
Xmodem CRC W-55 
Ymodem W-56 
Ymodem-G W-56 
Zmodem W-56, D-116 

Q 
QFX W-23, W-30, W-32, D- 

85, D-92, D-93 
QLSETUP.DAT A-153 
Quick Link II Fax Print 

Quit D-84 

R 
README 3 
README.TXT D-80 
REC W-23, W-30, D-85, D- 

Driver W-17 

92 
Receive Fax Log W-20, W- 

Receive Fax Setup W-37, D- 

Dedicate CPU D-98 
Fax ID String W-37, D-98 
Path for Received Faxes D- 

98 
Receive Options W-38 

Auto Fax-Print on 
Receive W-39 

29, D-81, D-91 
Errors W-30 

984-99 

INBOX W-39 

99 
RECFAX Load Options D- 

Receive File W-45, D-106 
Receive File Status D-110 

Receiving a Fax D-81-D-82 
RECFAX D-81, D-82, D- 

94, D-96, D-99, D- 
112, D-118, D-143 

Load Options 14 
Redial W-61, D-98 
Redial on Busy D-121 
RTS/CTS Flow Control D-98 
Runcommand 2 

S 
Save Documents to QFX 

Scanners A-154 
Schedule A-161. See also Fax 

Schedule 
Scripts W-67-W-74, D-12% 

Running Scripts W-67-W- 

Send Fax W-19, D-79, D-85 
Send Fax Information W- 

Send Fax Log W-30, D-92 

Send Fax Setup W-35, D-96- 

File W-23 

D-136 

68, D-129-D-130 

18, D-80 

Errors W-30 

D-98 
Center the Text or 

Graphic D-96 
Control Options W-36 

Dedicate CPU W-37 
RTS/CTS Flow 
Control W-37 

Dedicate CPU D-97 
File Conversion 

Options W-35 
Center Text/Graphics W- 
36 
Full Page Text/ 
Graphics W-36 
High Resolution W-36 

Full Page Text/Graphics D- 
97 

High Resolution D-96 
Include Cover Page D-97 
Lines per Page D-97 
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Margins D-97 
OUtBOX w-37 
Redial W-37 
RTS/CTS Flow Control D- 

98 
Send File W-45, D- 106 
Send File Status D-108 
Services 

Connecting to D-128 
Services Setup W-65-W- 

SMSSET".DAT A-153 

Softfonts A-155 
Starting Quick Link I1 

Fax D-75 
StatusBar 5 
System Requirements 1 

66, D-127 

SNDFAX D-140 

T 
Terminal D-105 
Terminal Emulation D-121 
Terminal Options W-60, W- 

60-W-63, D-120-D-122 
Autobaud D-121 
Button Bar W-61 
Color W-62 

Destructive Backspace W- 

Line Wrap W-60 
Local Echo W-60 
Off-Line W-61 
On-Line W-61 

Redial on Busy D-121 
Status Bar W-61 
Terminal Emulation W- 

62, D-121 
VTlOO / VT102 Setup D- 

121 
VTlOOl102 Setup W-62 

Answerback Message W- 
62 
New Line Mode W-62 

CR to CR/LF W-60 

61 

fiotocol D-123 

Terminal Type W-43 

Terminal Window 5, 8 
Text Editor D-82-D-84 

Setup D-82 
TIF W-30, W-32, D-92, D-93 
Timer 6 
Title Bar 5 
Toggle Printer D-112 

U 
Uploading a File D-107 
Uploading Multiple Files D- 

Uploads 
107-D-108 

Multiple File Protocols W- 

Single File Protocols W-45- 

Upload Status W-47 

46, W-46-W-47, W-56 

W-46 

V 
V.42bis W-58, D-123 
Version Number 8 
View Fax. See Fax Viewer 
View Fax Schedule W-33 
ViewFax D-142 
V T l O O  / VT102 Setup D-121 

W 
WIN.IN1 A-152 
WIN/DOS Considerations 15 
Windows 13 
WYSIWYG faxing W-17 

X 

Xmodem W-45, W-48, W- 

Xmodem 1K W-45, W- 

Xmodem CRC W-45, W- 

55, D-107, D-109, D-114 

48, W-55 

48, w-55 
Xmodem 1K D-107, D- 

XmodemCRC D-107, D- 
109, D-115 

109, D-115 
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XONKOFF Flow Control D- 

v 
Ymodem W-46, W-49, W- 

Ymodem-G W-46, W- 

113 

56, D-107, D-110, D-115 

49, W-56, D-107, D- 
110, D-115 

z 
Zmodem W-56, D-116 
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If you think QuickLink I1 Fax" is flexible, powerful, and easy to use, you'll love 
the enhanced version - QuickLink GOLD. This full-featured, integrated data 
and fax communication product goes far beyond the many great features found 
in QuickLink II. QuickLink GOLD adds a feature that will convert a received fax 
into text which can then be edited and returned to the sender. A floating toolbar 
eliminates steps required to gain access to commonly use functions. Data 
communication enhanced features include additional file transfer protocols. on- 
line editing functions, and an enhanced scripting language. All this can be 
accomplished with a personal computer running MicrosofP Windowsm 3.0 or 
later with a send-receive faxlmodem. Here is a partial list of QuickLink GOLDS 
enhanced features: 

0 Flexible Optical Character Recognition (OCR), contigurable for foreign 
languages, different font sets, and dot matrix printouts. It can automatically 
convert faxes into text files upon fax reception, specify regions and data 
types, and verify suspect characters. 

0 Full DataComm feature set, including Z-modem file transfer protocol, scroll 
back buffer, a robust scripting language, full data host mode, 5 terminal 
emulations, and the ability to copy and paste while on-line. 

0 In addition, the program supports unlimited number of data and fax phone 
lists and records. 

0 ModemMonitorn" emulates the LED modem status lights on screen. 

0 ToolBar makes it easy to access commonly used functions. 

0 Look and feel setup lets you dynamically modify the Graphical User 
Interface. 

0 Background fax sending, receiving and printing. 

0 QuickLink GOLD is upwardly compatible with QuickLink I1 Fax and gives you 
everything in that program, plus much, much more! 

CompuServe. 
Type "GO SMITHMICRO" 

You can order by calling 

on-line from 
1 -71 4-362-2345 or 

American E-Mail at 

S O F T W A R E  
1-714-362-5822 



I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
I 
1 
I 
I 
I 
I 
I 

QuickLink II Fax - S/R for Win/DOS 
USER REGISTRATION FORM 

I have read and understand the SMITH MICRO SOFTWARE, 
INC. License Agreement and agree to abide by its terms. 

Customer Signature Date: 

Name: 

Address: 

CityIStatelZi p: 

Fax/Modem make-model: 

Mail today to ensure notification of updates and new products to: 
Smith Micro Software 51 Columbia Aliso Viejo, CA 92656 
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BACKUP DISK ORDER FORM 

Please send a backup copy of QuickLink I1 Fax - SIR for Win/ 
DOS. My check for $15.00 (US) plus $3.00 shipping and 
handling is enclosed. California residents add $1.16 sales tax. 

Name: 

Address: 

CityIStatelZip: 

Fax/Modem make-model: 

Disk Size: (please check one) 0 3% Q5?4 
Please allow 2 weeks for processing 
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